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Introduction

Thank you for purchasing a Panasonic product. Before you use the product, please carefully
read through the user’s manual, and understand it in detail to use the product properly.

Types of Manual

● This manual describes the "positioning function (table setting mode) / PWM output and high-
speed counter function" implemented in FP0H Control Unit.

● There are different types of user’s manual for the FP0H series. Please refer to a relevant
manual for the unit and purpose of your use.

● The manuals can be downloaded on our download center: https://
industrial.panasonic.com/ac/e/dl_center/.

Unit name or purpose of
use Manual name Manual code

FP0H Control Unit

FP0H User‘s Manual (Basic) WUME-FP0HBAS

FP0H Programming Manual WUME-FP0HPGR

FP0H Programming Manual (SD Card Access
Instructions) WUME-FP0HSD

Positioning Function/PWM
Output/High-speed
Counter Function

FP0H User‘s Manual
(Positioning/PWM Output/High-speed Counter)

WUME-FP0HPOS

Serial Communication
Function FP0H User‘s Manual (COM Communication) WUME-FP0HCOM

Ethernet Communication
Function FP0H User‘s Manual (Ethernet Communication) WUME-FP0HET

EtherNet/IP
Communication Function FP0H User‘s Manual (EtherNet/IP) WUME-FP0HEIP

Logging trace function FP0H User‘s Manual (Logging/Trace Function) WUME-FP0HLOG

FP0H Extension
(Communication) Cassette FP0H User‘s Manual (COM Communication) WUME-FP0HCOM

FP0H Positioning Unit FPsigma Positioning Unit User’s Manual ARCT1F365E

FP0H Positioning Unit RTEX FP0H Positioning Unit RTEX User’s Manual
(FPWIN GR7) WUME-FP0HRTEXGR7
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SAFETY PRECAUTIONS

● To prevent accidents or personal injuries, please be sure to comply with the following items.
● Prior to installation, operation, maintenance and check, please read this manual carefully for proper use.
● Before using, please fully understand the knowledge related to the equipment, safety precautions and all

other precautions.
● Safety precautions are divided into two levels in this manual: Warning and Caution.

Incorrect operation may lead to death or serious injury.

● Take appropriate safety measures to the external circuit of the product to ensure the security of the whole
system in case of abnormalities caused by product failure or external.

● Do not use this product in areas with inflammable gases.
Otherwise it may lead to an explosion.

● Do not put this product into a fire.
Otherwise it could cause damage to the battery or other electronic parts.

Incorrect operation may lead to injury or material loss.

● To prevent the excessive exothermic heat or smoke generation of the product, a certain margin is required
for guaranteed characteristics and performance ratings of relative products.

● Do not decompose or transform it.
Otherwise it will lead to the excessive exothermic heat or smoke generation of the product.

● Do not touch terminal blocks during power-on.
Otherwise it may result in an electric shock.

● Set an emergency stop and interlock circuit in the external devices.
● Connect wires and connectors reliably.

Otherwise it may lead to the excessive exothermic heat or smoke generation of the product.
● Do not undertake construction (such as connection and disconnection) while the power supply is on.

It could lead to an electric shock.
● If the equipment is used in a manner not specified by the Panasonic, the protection provided by the

equipment may be impaired.
● This product has been developed/produced for industrial use only.

Description on Copyright and Trademarks

● The copyright of this manual is owned by Panasonic Industrial Devices SUNX Co., Ltd
● Unauthorized reproduction of this manual is strictly prohibited.
● Windows is a registered trademark of Microsoft Corporation in the U.S. and other countries.
● Ethernet is a registered trademark of Fuji Xerox Co., Ltd. and Xerox Corporation.
● EtherNet/IP is a registered trademark of ODVA (Open DeviceNet Vendor Association).
● SDHC and SD logos are trademarks of LLC.
● Other company and product names are trademarks or registered trademarks of their respective companies.
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1.1 Functions of Unit

1.1.1 Overview of FP0H Positioning Function

■ Up to 4-axis position control is available by combining with a driver of pulse
string input type.

● The pulse output can be performed up to 100 kHz, and servo motors can be controller.
● It is also available for a stepping motor connected by open collector output.

■ Programs can be simplified by adopting the table setting mode.
● The dedicated software "Configurator PMX" is available, which allows ease of setting a

variety of parameters and positioning tables required for positioning control. "Configurator
PMX" is started from the "Options" menu of tool software "FPWIN GR7".

● In user programs, positioning control is executed only by specifying axis numbers (channel
numbers) and table numbers, and executing instructions.

■ Four kinds of position control patterns (Table setting mode)
● Four patterns, which are E-point control (first speed automatic trapezoidal acceleration/

deceleration), P-point control (second speed automatic trapezoidal acceleration/
deceleration), C-point control (continuance point control) and J-point control (from speed
control to position control), can be selected. They are created as tables on "Configurator
PMX".

■ Five kinds of home return operations are supported. (Table setting mode)
● Five kinds of home return methods including home search are available. The most

appropriate home return method can be selected in accordance with the system such as
home input, near home input and the type of driver.

1.1 Functions of Unit
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1.1.2 Compatibility Function with FPsigma

"FP0H mode" or "FPsigma mode" can be selected to retain compatibility with FPsigma. Usable
functions and performances vary according to each mode.
Each mode is selected in the system register no. 3 by the tool software.

■ Comparison of functions and performances

Item Specifications

FP0H mode (Default) FPsigma mode

High-speed
counter

Single-
phase

Max. 4 channels (CH0-3)
Max. 100 kHz×4

Max. 4 channels (CH0-3)
Max. 100 kHz×4

2-phase Max. 2 channels (CH0, CH2)
Max. 50kHz×2

Max. 2 channels (CH0, CH2)
Max. 50kHz×2

I/O
allocation Independent from pulse/PWM output. Shared with pulse/PWM output.

Pulse output Independ
ent

Max. 4 channels (CH0-3) Max. 100 kHz Max. 2 channels (CH0, CH2), Max. 100
kHz

Interpolat
ion

Max. 2 channels (CH0, CH2)
Max. 100 kHz (Composite speed)

Max. 1 channel (CH0)
Max. 100 kHz (Composite speed)

I/O
allocation

Independent from high-speed counter
input.

Shared with high-speed counter input.

PWM output Max. 4 points (CH0-3) Max. 2 points (CH0, CH2)

I/O
allocation

Independent from high-speed counter
input. Shared with high-speed counter input.

Pulse output function Table setting mode
FPsigma compatible instruction mode

FPsigma compatible instruction mode

Explanation of each
mode

Default setting for FP0H project.
There is no restriction on each function.

Automatically selected when executing
"Convert PLC Type" from FP sigma
program.
The above functions and I/O allocation
are same as those of FPsigma.

 

(Note 1) Functions, channel numbers and I/O numbers used are set in the tool software.
(Note 2) I/O numbers used for each function should be allocated so that they do not overlap.
 

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

1.1 Functions of Unit
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1.2 Restrictions on Combinations and Functions

1.2.1 Applicable Versions of Unit and Software

For using FP0H, the software of the following versions is necessary.

Item Applicable versions

Programming Software
Control FPWIN GR7

FPWIN GR7 Ver.2.19 or later

Configurator PMX It is used for using the pulse output function in the table setting mode. It is
implemented in FPWIN GR7/Pro7 and activated from the option menu.

Programming Software
Control FPWIN Pro7

FPWIN PRO7 Ver.7.2.0 or later

 

(Note 1) The latest version is provided free of charge at our download center https://
industrial.panasonic.com/ac/j/dl_center/software/. Use the latest version.

 

1.2.2 Restrictions on I/O Allocation

● I/O signals used for each function are set in the tool software. They are allocated
automatically when set by Configurator PMX.

● Allocate the I/O numbers used for the pulse output function, high-speed counter function and
PWM function so that they do not overlap.

■ Examples of unusable combinations

Examp
le When using the output Y0 as CH0 for the pulse output function, the PWM output CH0 cannot be used.

■ Input signals of Control Unit

I/O
no.

Pulse output function

High-speed counter function

Count input
Reset input

Single-phase 2-phase

X0: CH0 J-point positioning start
input CH0 Count input

CH0 Count input
-

X1 CH1 J-point positioning start
input CH1 Count input -

X2 CH0 Home input - - CH0, CH1 Reset input

X3 CH2 J-point positioning start
input CH2 Count input

CH2 Count input
-

X4 CH3 J-point positioning start
input CH3 Count input -

X5 CH1 Home input - - CH2, CH3 Reset input

X6 CH2 Home input - - -

X7 CH3 Home input - - -

1.2 Restrictions on Combinations and Functions
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(Note 1) When the reset input settings of reset input for the single-phase input overlap at CH0 and CH1 or CH2
and CH3, the setting of CH1 or CH3 has priority.

 

■ Output signals of Control Unit

I/O
no.

Pulse output function
PWM output

Pulse output Deviation counter clear

Y0 CH0 CW or pulse output - CH0

Y1 CH0 CCW or sign output - (Note 1)

Y2 - CH0 -

Y3 CH1 CW or pulse output - CH1

Y4 CH1 CCW or sign output - (Note 1)

Y5 - CH1 -

Y6 - - -

Y7 - - -

Y8 CH2 CW or pulse output - CH2

Y9 CH2 CCW or sign output - (Note 1)

YA - CH2 -

YB CH3 CW or pulse output - CH3

YC CH3 CCW or sign output - (Note 1)

YD - CH3 -

YE - - -

YF - - -
 

(Note 1) When using the PWM output, the output numbers to be paired are normal output.
(Note 2) When using the target value match ON instruction (F166) or target value match OFF instruction (F167)

in the high-speed counter function, arbitrary output is specified in the range of Y0 to Y1F in a user
program so that it does not overlap the above functions.

 

1.2 Restrictions on Combinations and Functions
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1.3 Comparison of Pulse Output Function

1.3.1 Types of Positioning Control Modes

For using the FP0H pulse output function, the following two control modes are available.

■ Table setting mode
● Positioning parameters such as position command and speed command are created as data

tables by tool software Configurator PMX in advance.
● As parameters are set in advance, programs can be simplified.
● Four patterns of position control modes and five patterns of home return modes are

available.
● Dedicated instructions F380 to F385 are used for the control.
● Set positioning parameters and information on positioning tables can be exported as a setup

file of Configurator PMX and reused between multiple units and projects.
● This function can be selected only in the FP0H mode.

■ FPsigma compatible instruction mode
● Positioning parameters such as position command and speed command are set as operands

of instructions.
● Dedicated instructions F171 to F175 and instructions F0 to F1 are used for the control.
● This method is similar to the pulse output function of the existing model FPsigma.
● This function can be selected in both the FP0H mode and FPsigma mode.

1.3.2 Selection of Positioning Control Mode

● The positioning control mode is selected in the system register no. 407 by the tool software.

1.3 Comparison of Pulse Output Function
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1.3.3 Comparison of Two Control Modes

There are following differences between the table setting mode and FPsigma compatible
instruction mode.

■ Comparison of Two Control modes

Item Table setting mode FPsigma compatible instruction mode

Stop control

Type Four patterns (System stop, Emergency
stop, Limit stop, and Deceleration stop) Emergency stop only

Start Turns on the output contact allocated to
each axis for each stop method.

Turns on the bit 3 of the special data
register DT90052 using F0 instruction in a
user program.

JOG
operation

Set Set in the positioning parameters of
Configurator PMX. Set using the operands of instructions.

Start F381 instruction F172 instruction

Home return

Type Five patterns (DOG methods x 3, Home
position method x 1, Data set method x 1)

Two patterns (DOG methods x 1, Home
position method x 1)

Set Set in the positioning parameters of
Configurator PMX. Set using the operands of instructions.

Start F382 instruction F171 instruction

Positioning
operation

Type
Four patterns (E-point control, P-point
control, C-point control and J-point
control)

E-point control (First speed acceleration/
deceleration), Multistep acceleration/
deceleration control

Set Set in the positioning data table of
Configurator PMX. Set using the operands of instructions.

Start F380 instruction F171 instruction

Positioning
operation
interpolation

Type Three patterns (E-point control, P-point
control, C-point control)

E-point control (First speed acceleration/
deceleration)

Set Set in the positioning data table of
Configurator PMX. Set using the operands of instructions.

Start F380 instruction F175 instruction

Others

Dwell time setting, Repeat control
(Positioning parameter setting)
Multiple table simultaneous start (F383
instruction)

Data table control (F174 instruction)

■ Comparison in programming

Item Table setting mode FPsigma compatible instruction mode

Read/Write
of elapsed
value

Area Positioning memory

Special data registers

FP0H
mode

CH0 DT90348 to
DT90349

CH1 DT90352 to
DT90353

CH2 DT90356 to
DT90357

1.3 Comparison of Pulse Output Function
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Item Table setting mode FPsigma compatible instruction mode

CH3 DT90360 to
DT90361

FPsigma
mode

CH0 DT90044 to
DT90045

CH2 DT90200 to
DT90201

Execut
e

F384 instruction (Read), F385 instruction
(Write) F1 instruction (Both Read and Write)

Confirmation of BUSY
state Input contacts X808 to X80B

Special relays

FP0H mode R911C to R911F

FPsigma mode R903A, R903C

Confirmation of
positioning completion Input contacts X810 to X813

Instead detects the fall of the above BUSY
signal by a user program.Confirmation of home

return completion Input contacts X828 to X82B

Near home input
Allocate arbitrary input contacts and turn
on the outputs Y850 to Y853 by user
programs.

Allocate arbitrary input contacts and turn on
the bit 4 of the special data register
DT90052 by user programs.

1.3 Comparison of Pulse Output Function
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2.1 Connections with Servo Motor Amplifier

2.1.1 Connection Example

Y0

Y1

X2

COM

+

Y2

−

COM

X8

X9

XA

50

3

4

5

6

19

13

25

7

30

29

27

31

9

8

35

34

37

36

39

38

41

FG

PULS1

PULS2

SIGN1

SIGN2

CZ

GND

GND

COM＋

CL

SRV-ON

GAIN

A-CLR

POT

NOT

S-RDY＋

S-RDY−

ALM＋

ALM−

INP＋

INP−

COM−

GND ＋24V

2kΩ

2kΩ

3kΩ

6.8kΩ

6.8kΩ

6.8kΩ

220Ω

220Ω

4.7Ω

4.7Ω

4.7Ω

4.7Ω

4.7Ω

4.7Ω

Z

FP0H C32T/C32ET

PLC

Command pulse 
input 2

Command sign 
input 2

Z phase output

Counter clear input

Servo on input

Gain switch input

Alarm clear input

CW over-travel 
inhibit input
CCW over-travel 
inhibit input

Servo ready output

Servo alarm output

Positioning done 
output

A6 series / A5 series

Amplifier

* The processing of shielded wires varies 
depending on each device.

DC 24V power supply

From PLC 
I/O output

To PLC 
I/O input

CW pulse command 
output

CCW pulse command 
output

Home input

Deviation counter 
reset output

Near home input

CCW over limit input

CW over limit input

CCW limit sensor

Near home sensor

CW limit sensor

 

(Note 1) The allocation of I/O numbers on the controller side depends on channel numbers.
 

2.1 Connections with Servo Motor Amplifier
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2.1.2 Precautions on Connection

■ Connections of various signals

Signal type Point

Pulse command output

● Connect the output allocated to each channel and the command pulse input of
servo amplifier.

● Connect a resistor (2 kΩ) for limiting currents.
● Use twisted-pair cables for the connection.

Home input
● Connect the input allocated to each channel and the Z phase input of servo

amplifier.
● Use twisted-pair cables for the connection.

Near home input
● Connect the near home sensor to an arbitrary input.
● It will be valid when the outputs (Y850 to Y853) allocated to each channel in user

programs turn ON.

CCW over limit input ● Connect the over limit switches to arbitrary inputs.
● It will be valid when the outputs (Y860 to Y867) allocated to each channel in user

programs turn ON.CW over limit input

Deviation counter clear
output

● Connect the output allocated to each channel and the counter clear input of servo
amplifier.

● The length of a deviation counter clear signal is specified in the range of 1 to 100
ms in the “Parameter setting” dialog box of Configurator PMX.

Servo on output ● Connect an arbitrary output of PLC to the servo on input of servo amplifier.

● Use twisted-pair cables for the connection between the unit and servo amplifiers.

2.1 Connections with Servo Motor Amplifier
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2.2 Connection with Stepping Motor Driver

2.2.1 Precautions on Connection

■ Connections of various signals

Signal type Point

Pulse command output

● Connect the output allocated to each channel and the command pulse input of
motor driver.

● Use twisted-pair cables for the connection.
● Use a 24 V DC input for the input on the driver side. When the input interface of

the driver is 5 V DC input, insert a resistor for limiting currents externally.

Home input
● Connect the input allocated to each channel and the home sensor.
● Use twisted-pair cables for the connection.

Near home input
● Connect the near home sensor to an arbitrary input.
● It will be valid when the outputs (Y850 to Y853) allocated to each channel in user

programs turn ON.

CCW over limit input ● Connect the over limit switches to arbitrary inputs.
● It will be valid when the outputs (Y860 to Y867) allocated to each channel in user

programs turn ON.CW over limit input

● Use twisted-pair cables for the connection between the unit and motor driver.

2.2 Connection with Stepping Motor Driver
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3.1 Safety Circuit Design

■ System configuration example
Installation of the over limit switch

■ Confirmation of safety circuit

Numb
er

Item Description

(1) Safety circuit based on
external circuit

Install the safety circuit recommended by the manufacturer of the motor
being used.

(2) Safety circuit based on the
unit

Install over limit switches as shown above.
Connect the over limit switches on the (+) and (-) sides to the input
circuit of PLC.

3.1 Safety Circuit Design
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3.2 Before Turning On the Power

■ System configuration example

■ Items to check before turning on the power

Numb
er

Item Description

(1) Checking connections to the
various devices

Check to make sure the various devices have been connected as
indicated by the design.

(2) Checking the installation of
the external safety circuit

Check to make sure the safety circuit (wiring and installation of over
limit switch) based on an external circuit has been installed securely.

(3)
Checking the installation of
the safety circuit based on
the unit

Check the connection between the unit and over limit switches. Check
the installation condition of the over limit switches.

(4)
Checking the procedure
settings for turning ON the
power supplies

Make sure settings have been entered so that power supplies will be
turned on according to the procedure outlined in section “Procedure for
Turning On the Power”.

(5) Checking the CPU mode
selection switch

Set the CPU unit to PROG. mode. Setting it in the RUN mode can
cause inadvertent operation.

3.2 Before Turning On the Power
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3.3 Procedure for Turning On the Power

3.3.1 Procedure for Turning On the Power

When turning on the power to the system incorporating the unit, consider the nature and states
of any external devices connected to the system, and take sufficient care so that turning on the
power will not initiate unexpected movements.

1. Turn on the power supplies for the input and output devices connected to the PLC.

2. Turn ON the power supply for the PLC.

3. Turn ON the power supply for the motor driver.

3.3.2 Procedure for Turning Off the Power

1. Check to make sure the rotation of the motor has stopped, and then turn OFF the power
supply for the motor driver.

2. Turn off the power supply for the PLC.

3. Turn off the power supplies for the input and output devices connected to the PLC.

3.3 Procedure for Turning On the Power
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3.4 Confirming while the Power is ON

3.4.1 Items to check after turning on the power

■ System configuration example
Check each item in the following four major steps.

■ Items to check before turning on the power

Numb
er

Item Description

(1) Checking the installation of
the external safety circuit

Check to make sure the safety circuit (wiring and installation of over
limit switch) based on an external circuit has been installed securely.

(2) Checking the safety circuit
by the PLC unit

Check the connection between the unit and over limit switches. Check
the installation condition of the over limit switches.

(3) Checking the near home
input and home input

Check if the near home input and home are loaded as the inputs of the
PLC and activated properly by performing JOG operation or home
return operation.

(4)
Checking the rotation,
moving direction, and
moving distance.

Check the rotation, moving direction and moving distance by
performing JOG operation or positioning operation.

3.4 Confirming while the Power is ON
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3.4.2 Checking the Installation of the External Safety Circuit

Make a check on the safety circuit recommended by the motor manufacturer, which includes a
check on the disconnection of the power supply to the motor driver with CW and CCW drive
inhibition switch input from an external circuit.

3.4.3 Checking the Safety Circuit Based on the Unit

1. Using forced operation of the over limit switch, check to see if the over limit input is being
properly taken into the PLC side.

2. If necessary, input a program to start the JOG operation. Then operate the over limit input
to check whether the motor will stop. The limit stop will be effective when output signals
(Y860 to Y867) allocated to each axis turn ON in user programs. The valid logic of limit
input can be changed in the parameter setting menu of "Configurator PMX".

3. Using the JOG operation, check to see if the over limit switch is functioning properly.

Operation at limit input

Conditions Direction Limit status Operation

When JOG operation is
started

Forward
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Executable

Reverse
Over limit input (+): ON Executable

Over limit input (-): ON Not executable, Error occurs.

During JOG operation

Forward
Over limit input (+): ON Limit stops, Error occurs.

Over limit input (-): ON Limit stops, Error occurs.

Reverse
Over limit input (+): ON Limit stops, Error occurs.

Over limit input (-): ON Limit stops, Error occurs.

3.4.4 Checking the Operation of the Near Home Switch and Home Switch

1. Check if the near home input is loaded as input signals on the PLC properly by operating
the home input and near home input forcibly.

2. Start the home return by inputting the home return program, and check if the operation
transits to the deceleration operation by the near home input.
Points to check
Set the valid logic which enables the home input and near home input in the parameter
setting menu of "Configurator PMX".

3.4 Confirming while the Power is ON
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3. Check if the home stop position shifts by repeating the JOG and home return operations.
Points to check
A shift may result depending on the position of near home input or home input and the
return speed.

4. If the home stopping position is shifted, change the position of near home input or reduce
the home return speed.

3.4.5 Checking Rotating and Moving Directions and Moving Distance

1. Execute the JOG operation to confirm the rotating direction and moving direction of the
motor.
Points to check
The rotating direction is determined according to the installation of the ball screw or the
“CW/CCW direction setting” of the parameter.

2. Check if the moving distance is that as designed by performing the JOG operation or
positioning operation.
Points to check
The moving distance is determined according to the pitch of the ball screw, deceleration
gear ratio or setting movement amount of the positioning data.

3.4 Confirming while the Power is ON
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4.1 Confirming I/O Allocation

4.1.1 When Using Pulse Output Table Setting Mode

● The home input signal and positioning completion signal is allocated to I/O signals.
● The pulse output table setting mode can be used only in the FP0H mode.

■ Allocation of I/O signals (Input)

Signal name

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

J-point control
positioning start input

X0 X1 X3 X4

Home input (Note 1) X2 X5 X6 X7

Near home input (Note 1)(Note 2) (Y850) (Y851) (Y852) (Y853)

Over limit input (+) (Note 2) (Y860) (Y862) (Y864) (Y866)

Over limit input (-) (Note 2) (Y861) (Y863) (Y865) (Y867)

BUSY X808 X809 X80A X80B

Operation done X810 X811 X812 X813

Home return done X828 X829 X82A X82B
 

(Note 1) Even when setting the linear interpolation, the interpolation operation is not performed for the home
return. Execute the operation for X axes and Y axes separately.

(Note 2) The near home input, over limit input (+) and over limit input (-) will be valid when an arbitrary input is
allocated and the output relay indicated in the above table turns ON.

 

■ Sample program
The following sample shows the program when the near home input, over limit input (+) and
over limit input (-) are allocated to XA to XC.

● When selecting the table setting mode, the control active flags (R911C to R911F) are not
activated. Confirm that other instructions for the table setting mode (F380 to F383) are not
activated using the above BUSY flags (X808 to X80B), and execute each instruction.

4.1 Confirming I/O Allocation
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■ Allocation of I/O signals (Output)

Signal name

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

CW output or Pulse output Y0 Y3 Y8 YB

CCW output or Sign output Y1 Y4 Y9 YC

Deviation counter clear output Y2 Y5 YA YD

System stop Y800

Error clear request Y801

Warning clear request Y802

Emergency stop Y830 Y831 Y832 Y833

Deceleration stop Y838 Y839 Y83A Y83B

J-point control speed change Y840 Y841 Y842 Y843

Near home input (Note 1) (Y850) (Y851) (Y852) (Y853)

Over limit input (+) (Note 1) (Y860) (Y862) (Y864) (Y866)

Over limit input (-) (Note 1) (Y861) (Y863) (Y865) (Y867)
 

(Note 1) The near home input, over limit input (+) and over limit input (-) will be valid when an arbitrary input is
allocated and the output relay indicated in the above table turns ON.

 

4.1.2 When Using Pulse Output Function (FPsigma Compatible Instruction
Mode)

● The following reserved areas are allocated to the home input and control active flag.
● Arbitrary inputs are allocated to the near home input and pulse output stop signal

(emergency stop).

■ Allocation of I/O signals (Input)

FP0H mode

Signal name

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

Home input (Note 1) X2 X5 X6 X7

Near home input (Note 2)

Control active flag (BUSY) R911C R911D R911E R911F

Operation done
(Note 3)

Home return done

4.1 Confirming I/O Allocation
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FPsigma mode

Signal name

I/O number

Axis 1 Axis 2

CH0 CH2

Home input (Note 1) X2 X5

Near home input (Note 2)

Control active flag (BUSY) 903A 903C

Operation done
(Note 3)

Home return done
 

(Note 1) Even when setting the linear interpolation, the interpolation operation is not performed for the home
return. Execute the operation for X axes and Y axes separately.

(Note 2) The near home input will be enabled by allocating an arbitrary input and turning on the bit 4 of the
special data register DT90052 by the pulse output control instruction (F0).

(Note 3) The falling edge (on to off) of the control flag (BUSY) after the execution of the pulse output instruction
(F171) is used in place of the operation done flag or home return done flag.

 

■ Allocation of I/O signals (Output)

FP0H mode

Signal name

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

CW output or Pulse output Y0 Y3 Y8 YB

CCW output or Sign output Y1 Y4 Y9 YC

Deviation counter clear output (Note 1) Y2 Y5 YA YD

Emergency stop (Pulse output stop) (Note 2)

FPsigma mode

Signal name

I/O number

Axis 1 Axis 2

CH0 CH2

CW output or Pulse output Y0 Y3

CCW output or Sign output Y1 Y4

Deviation counter clear output (Note 1) Y2 Y5

Emergency stop (Pulse output stop) (Note 2)

 

(Note 1) Even when setting the linear interpolation, the interpolation operation is not performed for the home
return. Execute the operation for X axes and Y axes separately.

(Note 2) The emergency stop will be enabled by specifying channel numbers and turning on the bit 3 of the
special data register DT90052 by the pulse output control instruction (F0). In case of the emergency
stop in the FPsigma compatible instruction mode, pulses stop immediately.

 

4.1 Confirming I/O Allocation

4-4 WUME-FP0HPOS-04



■ Allocation of I/O relating to pulse output control (Only in FPsigma compatible
instruction mode)

● By using the special data register DT90052 by the pulse output control instruction
(F0),operations such as loading the near home input and stopping the pulse output forcibly
can be performed.

FP0H mode FPsigma mode

● When controlling the above functions using external inputs, arbitrary inputs can be allocated.
The following program is for loading the near home input of CH1 using the input X10.

● In the FPsigma compatible instruction mode, the allocations of J-point control and limit inputs
are not available.

● In the FPsigma compatible instruction mode, the allocations of system stop, error clear request,
deceleration stop and J-point speed change are not available.

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

4.1.3 When Using PWM Output Function

● The following reserved areas are allocated to the PWM output and control active flag.
● Allocate them so that they do not overlap the I/O used for the pulse output function.

4.1 Confirming I/O Allocation
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■ Allocation of I/O signals

FP0H mode

Signal name
I/O number

CH0 CH1 CH2 CH3

PWM output Y0 Y3 Y8 YB

Control active flag (BUSY) R911C R911D R911E R911F

FPsigma mode

Signal name
I/O number

CH0 CH2

PWM output Y0 Y3

Control active flag (BUSY) R903A R903C

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

4.1.4 When Using High-speed Counter Function

● The following reserved areas are allocated to the hardware reset input and control active
flag.

■ Allocation of I/O signals (When using internal input)

FP0H mode

Signal name
I/O number

CH0 CH1 CH2 CH3

Count input
Single-phase
input X0 X1 X3 X4

2-phase input X0/X1 - X3/X4 -

Hardware reset
input

Single-phase
input X2 X2 X5 X5

2-phase input X2 - X5 -

Control active flag
(BUSY)

Single-phase
input R9110 R9111 R9112 R9113

2-phase input R9110 - R9112 -

FPsigma mode

Signal name
I/O number

CH0 CH1 CH2 CH3

Count input
Single-phase
input X0 X1 X3 X4

4.1 Confirming I/O Allocation
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Signal name
I/O number

CH0 CH1 CH2 CH3

2-phase input X0/X1 - X3/X4 -

Hardware reset
input

Single-phase
input X2 X2 X5 X5

2-phase input X2 - X5 -

Control active flag
(BUSY)

Single-phase
input R903A R903B R903C R903D

2-phase input R903A - R903C -
 

(Note 1) When the reset input settings of reset input for the single-phase input overlap at CH0 and CH1 or CH2
and CH3, the setting of CH0 or CH2 has priority.

 

■ Allocation of I/O relating to High-speed counter control
● By using the special data register DT90052 by the high-speed counter control instruction

(F0), operations such as the software reset of the high-speed counter and disabling/enabling
the count can be performed.

FP0H mode FPsigma mode

● When controlling the above functions using external inputs, arbitrary inputs can be allocated.
The following program is for performing the software reset of CH0 using the input X7.

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

4.1 Confirming I/O Allocation
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4.2 Settings in Configurator PMX

4.2.1 Allocating Channels to be Used

Use the Configurator PMX to allocate used channels and applications. The following procedure
is explained on the condition that the FPWIN GR7 has already started.

1. Select Options>Positioning Table Settings from the menu bar.
”Configurator PMX” will be activated.

2. Select Channel setting>Used channel setting from the menu bar.
The “Used channel setting” dialog box appears.

3. Select the axes to be used and the usage, and press the [Yes] button.
When the setting is changed, a confirmation message box appears.

4.2 Settings in Configurator PMX
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4. Confirm the change and press the [OK] button.
A data table tab each is created for the groups set.

● When interpolation control is selected, the data table of the channel numbers of X and Y
axes will be added, and [Interpolation] will be displayed on the tab.

● When changing "Used channel setting" in Configurator PMX, the system registers no. 400
to 402 and 407 corresponding to the I/O used for the positioning control will be
automatically updated. For details, refer to "4.3 System Register Settings".

4.2.2 Setting Parameters

Use the Configurator PMX to allocate the most fundamental parameters for positioning control,
such as the motor rotation direction, pulse output method (CW/CCW and Pulse/Sign), home
input, limit input logic, and positioning control. The following procedure is explained on the
condition that the Configurator PMX has already started.

1. Select Channel setting>Parameter settings from the menu bar.
The “Parameter settings” dialog box appears.

4.2 Settings in Configurator PMX
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2. Make necessary parameter settings according to the application and press the [OK] button.
The settings will be stored as part of positioning parameter data.

Parameters

Parameter name
Default
(unit)

Settings

Ba
si

c

Pulse output method Pulse/Sign Pulse/Sign, CW/CCW

Pulse output rotation
direction CW direction +

When selecting Pulse/Sign mode:
CW direction +: Select this setting for the case that the
elapsed value is increased when Sign output turns off.
CCW direction +: Select this setting for the case that the
elapsed value is increased when Sign output turns on.

When selecting CW/CCW mode:
CW direction +: Select this setting for the case that the
elapsed value is increased at the time of CW output.
CCW direction +: Select this setting for the case that the
elapsed value is increased at the time of CCW output.

Startup speed 100 (pps)

Set the startup speed common to each operation. This
setting is common to JOG operation, home return, E-point
control, P-point control, C-point control and J-point
control.
Setting range: 1 to 100,000

Positioning repeat count 0 Specify this setting for performing repetitive controls when
using E-point/P-point/C-point control.

4.2 Settings in Configurator PMX
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Parameter name
Default
(unit)

Settings

0, 1: Not repeat
2 to 254: Repeat for the specified number of times.
255: Repeat infinitely until the execution of stop control.

In
pu

t

Home position logic Normal Open

Select the input logic for each switch.
Normal Open, Normal Close

Home position proximity
logic Normal Open

Limit + switch logic Normal Open

Limit - switch logic Normal Open

H
om

e 
re

tu
rn

Home return method Not use DOG method 1, DOG method 2, DOG method 3, Home
position method, Data set method, Not use

Home return direction Limit (-)
direction Limit (-) direction, Limit (+) direction

Home return
acceleration time 100 (ms) Setting range: 1 to 10,000

Home return
deceleration time 100 (ms) Setting range: 1 to 10,000

Home return target
speed 1000 (pps) Setting range: 1 to 100,000

Home return creep
speed 100 (pps) Setting range: 1 to 100,000

Deviation counter clear
time 1 (ms) Setting range: 1 to 100

Coordinate origin 0 (pulse)

When the home return method is Data set method,
specify a coordinate origin.
Setting range: -1,073,741,824 to 1,073,741,823
For the interpolation control, the range is as follows.
Setting range: -8,388,608 to 8,388,607

JO
G

 o
pe

ra
tio

n

JOG acceleration time 0 (ms) Setting range: 0 to 10,000

JOG deceleration time 0 (ms) Setting range: 0 to 10,000

JOG target speed 1000 (pps) Setting range: 1 to 100,000

J point change target
speed 1000 (pps)

Set this setting for changing the speed during J-point
control.
Setting range: 1 to 100,000

St
op

Emergency stop
deceleration time 100 (ms) Setting range: 1 to 10,000

Limit stop deceleration
time 100 (ms) Setting range: 1 to 10,000

4.2.3 Creating Positioning Data Table

● The positioning data tables are divided into sheets for each axis, and 20 tables ranging no. 1
to no. 20 can be set.

4.2 Settings in Configurator PMX
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■ For independent axis control

Parameter
name

Default (unit) Description

Operation
pattern E: End point

Select one from the following operation patterns.
E: End point, P: Pass point, C: Continuance point, J: Speed point

Control
method I: Increment Select either. I: Increment or A: Absolute.

X-axis
movement
amount

0 (pulse) Input a movement amount. Setting range: -1,073,741,824 to
+1,073,741,823

Acceleration/
deceleration
method

L: Linear For FP0H, only L: Linear can be selected.

Acceleration
time 100 (ms) Set an acceleration time. Setting range: 1 to 10,000

Deceleration
time 100 (ms) Set a deceleration time. Setting range: 1 to 10,000

Target speed 1000 (pps) Set a target speed. Setting range: 1 to 100,000

Dwell time 0 (ms)
Set the time from the completion of the positioning instruction in the E-point
control until the positioning done flag turns ON. For the C-point control, it is
the wait time between each table. Also, the dwell time setting is invalid for
the P-point control.

■ For interpolation control

Parameter
name

Default (unit) Description

Operation
pattern E: End point

Select one from the following operation patterns.
E: End point, P: Pass point, C: Continuance point

Interpolation
operation

Linear
(composite
speed)

Select a specification method of speed.
Linear (composite speed): Specify the speed combining the speed of X and
Y axes.
Linear (major axis speed): Specify the speed on the long axis side whose
movement amount is large.

Control
method I: Increment Select either. I: Increment or A: Absolute.

X-axis
movement
amount

0 (pulse) Input a movement amount. Setting range: -8,388,608 to +8,388,607

Y-axis
movement
amount

0 (pulse) Input a movement amount. Setting range: -8,388,608 to +8,388,607

Acceleration/
deceleration
method

L: Linear For FP0H, only L: Linear can be selected.

Acceleration
time 100 (ms) Set an acceleration time. Setting range: 1 to 10,000

Deceleration
time 100 (ms) Set a deceleration time. Setting range: 1 to 10,000

4.2 Settings in Configurator PMX
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Parameter
name

Default (unit) Description

Interpolation
speed 1000 (pps)

Set either composite speed or major axis speed in accordance with the
selection of interpolation operation.
Setting range: 1 to 100,000

Dwell time 0 (ms)
Set the time from the completion of the positioning instruction in the E-point
control until the positioning done flag turns ON. For the C-point control, it is
the wait time between each table. Also, the dwell time setting is invalid for
the P-point control.

■ Selection of positioning operation patterns
● For the E-point control, enter settings in one row.
● For P-point control (speed change control), C-point control (continuance point control) and J-

point control (JOG positioning control), they should be combined with E-point control of the
next step as a pair and the settings should be input in two rows.

■ Table numbers and activation of positioning
● Execute the positioning start instruction (F380) in the user program to specify table numbers

in the Configurator PMX.
● The unit executes the control under the conditions set in the table by turning on the

positioning start contact corresponding to a desired channel number (axis number) and table
number. Specify the first data table number for each control in the program.

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

● For details, refer to "5 Operation Patterns". For details of instructions, refer to "7 Instruction
References".

4.2.4 Saving Positioning Parameters

Information on positioning parameters and positioning data tables set on Configurator PMX is
saved as part of program files.

4.2 Settings in Configurator PMX
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1. Select File>Save changes and exit from the menu bar.
A confirmation message box appears.

2. Press [Yes].
The set information will be saved as part of project files.

4.2.5 Export and Import

● Basic parameters and positioning parameters set can be exported to and imported from the
Configurator PMX.

● Information on positioning parameters and positioning tables saved by using the export
function can be reused between projects.

1. Select File>Export from the menu bar.
The saving destination and file names appear.

2. Enter a saving destination and file name, and press [Save] button.
Information on the parameters and positioning data tables will be saved in a file with a
“.pmx” extension.

● When export is executed, information on the positioning data tables will be saved along
with parameters set in the parameter setting menu.

4.2.6 Check on Parameter Data

● The following procedure is explained on the condition that the Configurator PMX has already
started.

4.2 Settings in Configurator PMX
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1. Select Debug>Check Parameter and Data Values from the menu bar.
A message box appears to show the check result. If there is an error in the settings for the
positioning data tables, an error message will appear and the cursor will move to the
corresponding error position.

4.2.7 Writing Parameters to Unit (1)

● Information on parameters that have been set is transferred to the unit along with information
on programs, comments and system registers.

● The following procedure is explained on the condition that the Configurator PMX has already
started.

1. Select File>Save changes and exit from the menu bar of the Configurator PMX.

2. When "Do you save the setting?" appears, press [Yes (Y)].

3. Select Online>Download To PLC (Entire project) from the FPWIN GR7 menu bar.
Positioning data will also be downloaded to the control unit along with information on
programs, comments and system registers.

4.2.8 Writing Parameters to Unit (2)

● Information on parameters that have been set can also be downloaded to the unit in the
Configurator PMX.

● The following procedure is explained on the condition that the Configurator PMX has already
started.

1. Select File>Download positioning data from the menu bar of the Configurator PMX.
A message box for confirming the saving appears.

4.2 Settings in Configurator PMX
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2. Press the [Yes] button.
A message confirming the download to the PLC appears. In the RUN mode, a message
confirming that the mode is switched to the PROG. mode also appears.

3. Press the [Yes] button.
A message confirming the switching of the operation mode appears.

4. Press the [Yes] button to switch the operation mode.

4.2 Settings in Configurator PMX
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4.3 System Register Settings

4.3.1 Confirming and Selecting Functions to be Used

The set condition can be confirmed by the following procedure. The following procedure is
explained on the condition that the FPWIN GR7 has already started.

1. Select Option>System register settings from the menu bar.
The "PLC Configuration " dialog box appears.

2. Select "Controller output setting (PLS/PWM)" from the left pane.

3. Confirm the functions to be used and change the settings as necessary.

4. Press the [OK] button.
The screen returns to the ladder edit screen. The settings will be downloaded to the PLC
together with programs.

● When the settings are saved in the Configurator PMX, the system registers corresponding
to the I/O used for the positioning function will be automatically set.

● Change the settings of the corresponding system registers when the home input is not
used or the PWM output is allocated to other channels.

Settings when using table setting mode

Parameter
name No. and setting item Settings

Controller
input settings
(HSC/PLS)

400
HSC operation mode
setting
(X0 to X2)

CH0

Not Set X0 as High Speed Counter
2 phase input (X0, X1)
2 phase input (X0, X1) Reset input (X2)
Addition input (X0)　　　

Addition input (X0) Reset input (X2)
Subtraction input (X0)　　

Subtraction input (X0) Reset input (X2)

4.3 System Register Settings
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Parameter
name No. and setting item Settings

Individual input (X0, X1)
Individual input (X0, X1) Reset input (X2)
Direction distinction (X0, X1)
Direction distinction (X0, X1) Reset input (X2)
J-point positioning start input of pulse output CH0 (X0)

CH1

Not Set X1 as High Speed Counter
Addition input (X1)　　　

Addition input (X1) Reset input (X2)
Subtraction input (X1)　　

Subtraction input (X1) Reset input (X2)
J-point positioning start input of pulse output CH1 (X1)

401
HSC operation mode
setting
(X3 to X5)

CH2

Not Set X3 as High Speed Counter
2 phase input (X3, X4)
2 phase input (X3, X4) Reset input (X5)
Addition input (X3)　　　

Addition input (X3) Reset input (X5)
Subtraction input (X3)　　

Subtraction input (X3) Reset input (X5)
Individual input (X3, X4)
Individual input (X3, X4) Reset input (X5)
Direction distinction (X3, X4)
Direction distinction (X3, X4) Reset input (X5)
J-point positioning start input of pulse output CH2 (X3)

CH3

Not Set X4 as High Speed Counter
Addition input (X4)　　　

Addition input (X4) Reset input (X5)
Subtraction input (X4)　　

Subtraction input (X4) Reset input (X5)
J-point positioning start input of pulse output CH3 (X4)

Controller
output
settings
(PLS/PWM)

407
Positioning control mode
setting

[FP0H mode] Table setting mode, FPsigma compatible
instruction mode
[FPsigma mode] FPsigma compatible instruction mode

402
Pulse/PWM output
setting
(Y0 to YC)

CH0 Select the output allocated to each channel.
Normal output, PWM output, Pulse output [Table setting
mode],
Pulse output [FPsigma compatible instruction mode]
This setting cannot be selected in the FPsigma mode.

CH1

CH2

CH3
 

(Note 1) Displayed items vary according to models.
(Note 2) Select "Normal input" and "Normal output" for the input and output that is not used for the pulse

output function or high-speed counter function.
(Note 3) "J-point positioning start input" for each channel can be selected only when "Table setting mode"

is set in the system register no. 407.
 

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

4.3 System Register Settings
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4.4 Reading Elapsed Values

4.4.1 Elapsed Value (Current Value) Area

● They are stored as 2-word 32-bit data in the axis information area of positioning memory.
● The elapsed value area will be reset when the power supply turns off. It will be held when

switching the mode from RUN to PROG.

■ Counting range of elapsed value (current value) area

Section Range

For single axis
control -1,073,741,824 to 1,073,741,823

For interpolation
axis control -8,388,608 to +8,388,607

4.4.2 Reading Elapsed Value (Current Value) Area

Use [F384 PTBLR] positioning parameter read instruction for reading elapsed values.

■ Instruction format

Operand Settings Specification for reading the elapsed value area

S1 Specification of channel numbers and
positioning memory area

H1 Specify the axis information area of CH0.

H101 Specify the axis information area of CH1.

H201 Specify the axis information area of CH2.

H301 Specify the axis information area of CH3.

S2 Starting address of positioning memory
(Offset address) K2 Specify the offset address.

n No. of read words K2 Specify two words.

D Operation memory storing read data Specify an arbitrary memory.

■ Sample program
The following sample shows the program when reading the elapsed value (current value) of
CH3 to the data registers DT300 to DT301. For details of instructions, refer to "7 Instruction
References".

4.4 Reading Elapsed Values
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5.1 Stop Operation

5.1.1 Type of Stop Operations

■ Type of stop operations

Name Time chart Occurrence condition and operation

System
stop

● Once the system stop contact (Y800) turns
on, an active operation will stop and the pulse
outputs of all channels will immediately stop.

● The similar operation is performed when the
operation mode of the control unit is switched
from RUN to PROG.

Emergenc
y stop

Emergency stop deceleration time
● Once an emergency stop contact (Y830 to

Y833) turns on, an active operation will stop
and the pulse outputs of corresponding
channels will stop.

● Performs a deceleration stop in the
deceleration time specified in the positioning
parameter setting menu of Configurator PMX.

Limit stop:

Limit stop deceleration time
● Once an over limit input (+) and over limit

input (-) (Y860 to Y867) turns on, an active
operation will stop and the pulse outputs of
corresponding channels will stop.

● Performs a deceleration stop in the "limit stop
deceleration time" specified in the positioning
parameter settings.

Decelerati
on stop

Deceleration time
● Once a deceleration stop contact (Y838 to

Y83B) turns on, an active operation will stop
and the pulse outputs of corresponding
channels will stop.

● Performs a deceleration stop in the
deceleration time specified for the active
positioning operation.

■ Execution of stop operations
Stop controls are executed when the following I/O signals turn on.

■ Allocation of I/O signals (Output)

Signal name

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

System stop Y800

5.1 Stop Operation
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Signal name

I/O number

Axis 1 Axis 2 Axis 3 Axis 4

CH0 CH1 CH2 CH3

Emergency stop Y830 Y831 Y832 Y833

Over limit input (+) (Note 1) (Y860) (Y862) (Y864) (Y866)

Over limit input (-) (Note 1) (Y861) (Y863) (Y865) (Y867)

Deceleration stop Y838 Y839 Y83A Y83B
 

(Note 1) The over limit input (+) and over limit input (-) will be valid when arbitrary inputs are allocated and the
output relays indicated in the above table turn ON.

 

5.1.2 Characteristics of Stop Operations

■ Priority of stop operations
When stop control requests are made simultaneously, the stop operations are executed
according to the following priority.
1. System stop > 2. Emergency stop > 3. Limit stop > 4. Deceleration stop

■ Dwell time setting
The dwell time setting is invalid in the stop operations regardless of patterns.

■ Flag processing
● In the case of system stop, the busy signal turns off and the operation done signal turns on.
● In the cases of emergency stop, limit stop and deceleration stop, the busy signal turns off

and the operation done signal turns on after the completion of the pulse output during
deceleration.

■ Elapsed value area (Current value coordinate)
● Even in a stop operation, the elapsed value area is always updated.
● After the emergency stop, limit stop or deceleration stop, deceleration is performed with each

specified deceleration time, and the value when the pulse output stops is stored.
● In the case of system stop, the value when the pulse output stops is stored.

● For details of the deceleration stop operations when repetitive control is executed, refer to
"5.5.3 Stop Operation During Repeat Operation".

5.1 Stop Operation
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5.2 JOG Operation

5.2.1 Settings and Operations of JOG Operation

The parameters for JOG operations are specified in the positioning parameter setting menus of
Configuration PMX.
Pulses are output while the JOG operation start instruction (F381 JOGST) is executed.

Table
Forward JOGReverse JOG

Ball screw

(-) side (+) side

■ Operation diagram

t [ms]

f [Hz]

100ms

20,000Hz

1,000Hz

Instruction start condition

Busy signal

Operation done signal

200ms

JOG operation target speed 20,000

■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when

the JOG operation starts, and they will turn off when the operation completes.
● The operation done flags (X810 to X813), which indicate the completion of operation, will

turn on when the current operation is completed, and they will be held until the next
positioning control, JOG operation or home return operation starts.

■ Programming cautions
● The startup contact and flag numbers vary depending on channel numbers (axis numbers).

5.2 JOG Operation
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■ Settings

Item Setting example

Axis setting area

Startup speed 1,000 Hz

JOG operation
acceleration time 100 ms

JOG operation
deceleration time 200 ms

JOG operation target
speed 20,000 Hz

■ Configurator PMX settings

■ Sample program
The execution condition is set to be always executed. For details of instructions, refer to
"7 Instruction References".

CH No.00
JOG reverse operation starts.

CH No.0
JOG forward operation starts.

R3
K0F381 JOGST K0

R4
K0F381 JOGST K1

R3

R4

■ Operation at limit input

Conditions Direction Limit status Operation

At startup

Forward
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Executable

Reverse
Over limit input (+): ON Executable

Over limit input (-): ON Not executable, Error occurs.

During
operation

Forward
Over limit input (+): ON Limit stops, Error occurs. (Note 1)

Over limit input (-): ON Limit stops, Error occurs. (Note 1)

Reverse Over limit input (+): ON Limit stops, Error occurs. (Note 1)

5.2 JOG Operation
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Conditions Direction Limit status Operation

Over limit input (-): ON Limit stops, Error occurs. (Note 1)

 

(Note 1) Create a program as below if you do not want to restart the instruction when the limit error occurs
during an operation when the execution condition has been set to be always executed.

R1
K0K0F381 JOGST

R0
（（ ））DF

R1

R1

R0

X808

CH No.0
JOG forward operation starts.

R0: JOG start
R1: JOG start instruction
X808: CH0 BUSY

 

5.2.2 Settings and Operations of JOG Operation (Speed Changes)

It is possible to change a target speed during the JOG operation. The target speed is changed
by rewriting the positioning memory using a user program.

■ Operation diagram

t [ms]

f [Hz]

20,000Hz

1,000Hz

100ms

10,000Hz

20,000 10,000

Rewriting the target speed

Approx.100ms Approx.100ms

Instruction start condition

Busy signal

Operation done signal

JOG operation target speed

■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when

the JOG operation starts, and they will turn off when the operation completes.
● The operation done flags (X810 to X813), which indicate the completion of operation, will

turn on when the current operation is completed, and they will be held until the next
positioning control, JOG operation or home return operation starts.

5.2 JOG Operation
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■ Characteristics of acceleration/deceleration zone when changing speeds
● In the case of the speed change in the JOG operation, the speed of acceleration zone and

deceleration zone changes whenever the instruction is executed. The speed variation is
obtained by the following formula.
Speed variation = (JOG operation target speed - Startup speed) / (JOG acceleration time or
JOG deceleration time)

■ Settings

Item Setting example

Axis setting area

Startup speed 1,000 Hz

JOG operation
acceleration time 100 ms

JOG operation
deceleration time 200 ms

JOG operation
target speed 20,000 Hz 10,000 Hz

■ Configurator PMX settings

■ Sample program
The execution condition is set to be always executed. For details of instructions, refer to
"7 Instruction References".

Target speed is
rewritten.

CH No.0
JOG forward operation starts.

R4
K0F381 JOGST K0

R5
K10000F1 DMV DT100（（ ））DF

DT100H2 K16F385 PTBLW K2

5.2 JOG Operation
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■ Programming cautions
● To change a speed during the JOG operation, rewrite the value of the positioning memory

(axis setting area) using a user program.
● The startup contact and flag numbers vary depending on channel numbers (axis numbers).

5.2.3 Speed Changes in JOG Operation

● The value of “JOG operation target speed” in the axis setting area is constantly monitored
while the operation is being executed. When the target speed is changed, it will be changed
with the same acceleration.

● The speed change is executed after the completion of acceleration/deceleration.
● The speed range in which the JOG operation can be set is 50Hz to 100kHz. When setting a

value smaller than 50 Hz, it is corrected to 50 Hz.

5.2 JOG Operation
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5.3 Home Return

5.3.1 Types of Home Return

The home return is specified in the positioning parameter setting dialog box for each axis.

Name Operation diagram Operation and application

DOG
method
1

Limit (-)

Home switch

Home return creep speed
Target speed

Home return
deceleration time

Limit (+)Near home

Home return direction

● The leading edge of the first home input
is set as a home position after the
detection of the leading edge of the near
home input.

● Even when the limit input turns on, the
motor rotation will be automatically
reversed and the home return operation
will continue.

● This method is used when the home
switch exists in the range that the near
home switch is enabled, such as a
system using a servo motor. This
method can also be used when no
home switch exists in the range that the
near home switch is enabled.

DOG
method
2

Limit (-)

Target speedHome return
deceleration time

Limit (+)Near home

Home return direction

● The leading edge of a near home input
is detected and it is set as a home
position.

● Even when the limit input turns on, the
motor rotation will be automatically
reversed and the home return operation
will continue.

● This method is used for performing the
home return with the near home switch
only.

DOG
method
3

Limit (-) Home switch

Home return creep speed
Target speed

Home return
deceleration time

Limit (+)Near home

Home return direction

● The leading edge of the first home input
in the home return direction set as a
home position after the detection of a
trailing edge (back end) of the near
home input.

● Even when the limit input turns on, the
motor rotation will be automatically
reversed and the home return operation
will continue.

● This method is used when no home
switch exists in the range that the near
home switch is enabled.

Home
position
method

Limit (-)
Home switch

Home return creep speed

Limit (+)

Home return direction

● Moves the current position to the home
return direction, and stops at the
position where the leading edge of the
home input is detected. This coordinate
is set as the starting point.

● When no home input exists in the home
return direction, the limit input turns on
and the operation stops.

● This method is used for performing the
home return with the home switch only.
This method is compatible with the F171
instruction of the existing model
FPsigma.

5.3 Home Return
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Name Operation diagram Operation and application

Data set
method

Home position (= Current value)

● Performs the home return based on the
home coordinate values in the axis
setting area of positioning memory.

● Performs the home return toward the
home coordinate on the software.

● When the starting point is within the limit
switch, it cannot be started.

5.3.2 Operation Patterns of Home Return

The operations vary according to selected home return methods and the difference in current
positions.

■ DOG method 1 (Edge detection of near home switch + Home switch, based on
front end)

The leading edge of the first home switch is set as a home position after the detection of the
leading edge of the near home switch.

The starting point is
between the near home
switch and limit (+) switch.

①

The starting point is
between the near home
switch and limit (-) switch.

③

The starting point is on the
near home switch.

Limit (-) switch

Home switch

Target speed

Home return creep speed

Home return creep speed

Home return creep speed

Target speed

Target speed

Target speed

Target speed Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Limit stop
deceleration time

Limit (+) switchNear home switch

Home return direction

②

The starting point is on the
limit (-) switch.

④

■ DOG method 2 (Edge detection of near home switch)
The leading edge of the near home switch is detected and it is set as a home position.

5.3 Home Return
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Target speed

Target speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return creep speed

Home return creep speed

Home return creep speed

Home return creep speed

Limit (-) switch Limit (+) switchNear home switch

Home return direction

The starting point is
between the near home
switch and limit (+) switch.

The starting point is
between the near home
switch and limit (-) switch.

The starting point is on the
near home switch.

The starting point is on the
limit (-) switch.

①

③

②

④

■ DOG method 3 (Edge detection of near home switch + Home switch, based on
back end)

The leading edge of the first home switch in the home return direction is set as a home position
after the detection of the trailing edge (back end) of the near home switch.

Limit (-) switch Limit (+) switchNear home switch

Home return direction

The starting point is
between the near home
switch and limit (+) switch.

The starting point is
between the near home
switch and limit (-) switch.

The starting point is on the
near home switch.

The starting point is on the
limit (-) switch.

Home switch

Home return creep speedHome return creep speed

Home return creep speedHome return creep speed

Home return creep speedHome return creep speed

Home return creep speedHome return creep speed

Target speed

Target speed

Target speed

Limit stop
deceleration time

Home return
deceleration time

Home return
deceleration time

Home return
deceleration time

5.3 Home Return
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■ Home position method (Edge detection of home switch)
Moves the current position to the home return direction, and stops at the position where the
leading edge of the first home switch is detected. This coordinate is set as a home position.

Home return directionHome switch

Home return creep speed

■ Data set method
Performs the home return based on the home coordinate values in the axis setting area of
positioning memory.

Home position (= Current value)

● For details of addresses and settings of positioning memory, refer to "12.3 Positioning
Memory".

5.3.3 Settings and Operations of Home Return

● The parameters for home return operations are specified in the positioning parameter setting
menus of Configuration PMX.

● When the home return start instruction (F382 ORGST) is executed, the pulse output will start
and the home return operation will be performed.

● In the following example, the DOG1 method is selected. After the start, it moves at a target
speed and reverses at the time of near home detection. After the redetection of near home
input, it moves at a creep speed until the home position is detected.

5.3 Home Return
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■ Operation diagram
Home return target speed

Home return creep speed

Home return start contact

Near home switch (DOG)

Home switch

Home return done flag

Deviation counter clear signal

BUSY flag

■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when

the home return operation starts, and they will turn off when the operation completes.
● The deviation counter clear signal will turn on after the completion of the home return

operation. The ON time is set in the axis setting area of the positioning memory.
● The home return done flags (X828 to X82B), which indicate the completion of home return

operation, will turn on when the current operation is completed, and they will be held until
any operation of the positioning control, JOG operation and home return operation starts.
The timing of turning on the flags is on the completion of the home return.

■ Settings

Item Setting example

Axis setting area

Home return setting code DOG method 1

Home return direction Limit (-) direction

Home return acceleration time
(ms) 100 ms

Home return deceleration time
(ms) 100 ms

Home return target speed 10000 pps

Home return creep speed 1000 pps

Deviation counter clear signal
ON time 1 ms

5.3 Home Return
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■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R0
（（ ））DF F382 ORGST K0

X808

CH0
BUSY

CH No.0
Home return starts.

■ Operation at limit input

Conditions Direction Limit status Operation

At startup

Forward
Over limit input (+): ON Executable (Note 2)(Note 3)

Over limit input (-): ON Executable (Note 3)

Reverse
Over limit input (+): ON Executable (Note 3)

Over limit input (-): ON Executable (Note 2)(Note 3)

During operation

Forward
Over limit input (+): ON

Automatic reverse operation
(Note 4)

Over limit input (-): ON edge (Note 1) Limit stops, Error occurs.

Reverse
Over limit input (+): ON edge (Note 1) Limit stops, Error occurs.

Over limit input (-): ON
Automatic reverse operation
(Note 4)

 

(Note 1) Only when an edge signal is detected, the limit stop is performed.
(Note 2) In the case of home position method, it cannot be executed.
(Note 3) In the case of data set method, it cannot be executed.

5.3 Home Return
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(Note 4) In accordance with situations, “Limit stops or Error occurs” (Example) When the limit input is enabled
during deceleration, the limit stop is performed without reverse operation.

 

5.3 Home Return
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5.4 Positioning Control

5.4.1 Types of Positioning Control

■ Operation pattern

Name Time chart Operation and application
Repea
t
 

Interpol
ation

E-
point
contro
l

● This is a method of control which is
initiated up to an end point, and is
referred to as “E-point control”.

● This method is used for a first
speed acceleration/deceleration.

● ●

P-
point
contro
l

● This refers to control which passes
through a “Pass Point”, and is
called “P-point control”.

● This method is used for a second
speed acceleration/deceleration.

● After the pulse output is performed
for a specified movement amount,
it shifts to the E-point control.

● ●

C-
point
contro
l

● This refers to control which passes
through a “Continuance Point”, and
is called “C-point control”.

● This method is used for performing
two successive first speed
positioning control with different
target speeds or acceleration/
deceleration times.

● The time taken for transmitting
from the C-point control to E-point
control is specified as a dwell time.

● ●

J-
point
contro
l

No speed change

● This refers to control which passes
through a speed point “JOG
Operation Point”, and is called “J-
point control”.

● After the start, it is controlled at
specified speeds.

● Once the J-point positioning
contact turns on, the positioning
control starts.

● When the J-point control speed
change flag is set, the speed
changes.

－ －
Speed changes

■ Selection of positioning operation modes
Positioning operation modes are selected on Configurator PMX.

5.4 Positioning Control
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● For the E-point control, enter settings in one row.
● For P-point, C-point and J-point controls, they should be combined with E-point control of the

next step as a pair and the setting should be input in two rows.

● When E: End point is not selected in the next row of P: Pass point, C: Continuance point or J:
Speed point, the self-diagnostic error (error code 44: positioning error) is detected.

■ Settings of J-point control
● For J-point control, only "Increment" can be selected as a control method.
● For changing speed during J-point control, set the target speed after the change in the

positioning parameter dialog box.

5.4.2 E-point Control (First Speed Positioning)

● The parameters for position control operations are specified in the positioning parameter
setting menus and data tables of Configuration PMX.

● When the positioning table start instruction (F380 POSST) or positioning simultaneous start
instruction (F383 MPOST) is executed, the pulse output will start and the positioning control
operation will be performed.

■ Operation diagram

t [ms]

f [Hz]

100ms 200ms

50ms

100,000 pulses

20,000Hz

1,000Hz

Instruction
start condition

Busy signal

Operation
done signal

Table 1

5.4 Positioning Control
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■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicates that the motor is running, will turn on when

the positioning control starts, and it will turn off when the operation completes.
● The operation done flags (X810 to X813), which indicate the completion of operation, will

turn on when the current operation is completed, and they will be held until the next
positioning control, JOG operation or home return operation starts.

■ Settings

Item Setting example

Axis setting area Startup speed 1,000 Hz

Table area

Table number Table 1

Control code Increment mode

Operation pattern E-point control (End point control)

Positioning
acceleration time 100 ms

Positioning
deceleration time 200 ms

Positioning target
speed 20,000 Hz

Positioning movement
amount 100,000 pulses

Dwell time 50 ms

■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

5.4.3 P-point Control (Second Speed Positioning)

● The parameters for position control operations are specified in the positioning parameter
setting menus and data tables of Configuration PMX.

5.4 Positioning Control

5-18 WUME-FP0HPOS-04



● When the positioning table start instruction (F380 POSST) or positioning simultaneous start
instruction (F383 MPOST) is executed, the pulse output will start and the positioning control
operation will be performed.

■ Operation diagram

t [ms]

f [Hz]

100ms

50ms

50,000 pulses

20,000Hz

1,000Hz

10,000Hz

250ms 250ms

100,000 pulses

Instruction
start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicates that the motor is running, will turn on when

the positioning control starts, and it will turn off when the operation completes.
● The operation done flags (X810 to X813), which indicate the completion of operation, will

turn on when the current operation is completed, and they will be held until the next
positioning control, JOG operation or home return operation starts.

■ Settings

Item Setting example

Axis setting area Startup speed 1,000 Hz

Table area

Table number Table 1 Table 2

Control code Increment mode Increment mode

Operation pattern P-point control (Pass point
control)

E-point control (End point
control)

Positioning
acceleration time 100 ms 150 ms

Positioning
deceleration time 200 ms 250 ms

Positioning target
speed 20,000 Hz 10,000 Hz

Positioning movement
amount 50,000 pulses 100,000 pulses

Dwell time － 50 ms

5.4 Positioning Control

WUME-FP0HPOS-04 5-19



■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

5.4.4 C-point Control

● The parameters for position control operations are specified in the positioning parameter
setting menus and data tables of Configuration PMX.

● When the positioning table start instruction (F380 POSST) or positioning simultaneous start
instruction (F383 MPOST) is executed, the pulse output will start and the positioning control
operation will be performed.

■ Operation diagram

t [ms]

f [Hz]

100ms

50ms

100,000
pulses

20,000Hz

1,000Hz

10,000Hz

200ms 250ms

50,000
pulses

150ms

30ms
Instruction

start condition

Busy signal

Operation
done signal

Table 1 Table 2

5.4 Positioning Control
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■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicates that the motor is running, will turn on when

the positioning control starts, and it will turn off when the operation completes.
● The operation done flags (X810 to X813), which indicate the completion of operation, will

turn on when the current operation is completed, and they will be held until the next
positioning control, JOG operation or home return operation starts.

■ Settings

Item Setting example

Axis setting area Startup speed 1,000 Hz

Table area

Table number Table 1 Table 2

Control code Increment mode Increment mode

Operation pattern C-point control (Continuance
point control)

E-point control (End point
control)

Positioning
acceleration time 100 ms 150 ms

Positioning
deceleration time 200 ms 250 ms

Positioning target
speed 20,000 Hz 10,000 Hz

Positioning movement
amount 100,000 pulses 50,000 pulses

Dwell time 30 ms 50 ms

■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

5.4 Positioning Control
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5.4.5 J-point Control (JOG Positioning Control)

● The parameters for position control operations are specified in the positioning parameter
setting menus and data tables of Configuration PMX.

● When the positioning table start instruction (F380 POSST) or positioning simultaneous start
instruction (F383 MPOST) is executed, the pulse output will start. In the J-point control, the
unit operates at a target speed after the startup, and will start the position control when the J-
point positioning start contacts (X0, X1, X3, X4) turn on.

● In the system registers no. 400 and 401, select "J-point positioning start input of pulse output
CH*" of the channel to perform the J-point control.

■ Operation diagram

T [ms]

f [Hz]

100ms
5ms

20,000Hz

1,000Hz

250ms

100000
pulses

15,000Hz

J-point positioning
start contact

Approx. 250ms

Instruction
start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X808 to X80B) will turn on when the operation starts and turn off when the

operation is completed.
● The operation done flags (X810 to X813) will turn on when the JOG operation is completed,

and it will be held until the next positioning control, JOG operation, or home return operation
starts.

● Positioning control will start when J-point positioning start contacts (X0, X1, X3, X4) turn on.

■ Settings

Item Setting example

Axis setting area
Startup speed 1,000 Hz

J-point change speed 10,000 Hz

Table area Table number Table 1 Table 2

5.4 Positioning Control
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Item Setting example

Control code Increment mode Increment mode

Operation pattern J-point control (Speed
control)

E-point control (End point
control)

Positioning
acceleration time 100 ms 150 ms

Positioning
deceleration time 200 ms 250 ms

Positioning target
speed 20,000 Hz 15,000 Hz

Positioning movement
amount － 100,000 pulses

Dwell time 30 ms 5 ms

■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

5.4.6 J-point Control (JOG Positioning: Speed Changes)

● In the J-point control, the speed can be changed while controlling the speed after the start.
● After starting the J-point control, the unit operates at the speed specified in the positioning

parameters of Configurator PMX.
● The speed changes when the J-point control speed change flag (Y840 to Y843) turns on.

● In the system registers no. 400 and 401, select "J-point positioning start input of pulse output
CH*" of the channel to perform the J-point control.

5.4 Positioning Control
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■ Operation diagram

t [ms]

f [Hz]

100ms

50ms

20,000Hz

1,000Hz

10,000Hz

Approx. 50 ms 250ms

100000
pulses

150 ms

15,000Hz

J-point speed
change

J-point speed
change contact

J-point positioning
start contact

Instruction
start condition

Busy signal

Operation
done signal

Table 1 Table 2

■ Operations of each contact
● The BUSY flags (X808 to X80B) will turn on when the operation starts and turn off when the

operation is completed.
● The operation done flags (X810 to X813) will turn on when the JOG operation is completed,

and it will be held until the next positioning control, JOG operation, or home return operation
starts.

● The target speed will be changed when the J-point speed change contacts (Y840 to Y843)
turn on. The change will be enabled at the edge where the contact turns on.

● Positioning control will start when J-point positioning start contacts (X0, X1, X3, X4) turn on.

■ Characteristics of acceleration/deceleration zone when changing speeds
● The speed of speed change zone changes for each scan when changing the speed in the J-

point control. The speed variation is obtained by the following formula.
(J-point table target speed - Startup speed) / (J-point table acceleration time or J-point table
deceleration time)

■ Settings

Item Setting example

Axis setting area
Startup speed 1,000 Hz

J-point change speed 10,000 Hz

Table area
Table number Table 1 Table 2

Control code Increment mode Increment mode

5.4 Positioning Control
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Item Setting example

Operation pattern J-point control (Speed
control)

E-point control (End point
control)

Positioning
acceleration time 100 ms 150 ms

Positioning
deceleration time 200 ms 250 ms

Positioning target
speed 20,000 Hz 15,000 Hz

Positioning movement
amount － 100,000 pulses

Dwell time 30 ms 50 ms
 

(Note 1) For the J-point control, the set acceleration time and deceleration time is converted as a time between
0 Hz to 100 kHz, and the speed tables in the acceleration and deceleration sections are calculated.
Therefore, when the target speed is below 100 kHz, the actual acceleration/deceleration time is
shorter than the set values.

 

■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

5.4 Positioning Control
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R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH no.0
Table no. 1
Position control starts.

R6
（（ ））DF

Y840
CH0 Speed change

■ Behaviors when the speed change contact turns ON while the positioning unit is
accelerating or decelerating the speed

● A speed change is possible during J-point control, but impossible during acceleration or
deceleration.

● A speed change will be made after the unit goes to constant speed when the speed change
signal turns ON during acceleration or deceleration.

● Specify parameters for the start of operation in the positioning data table. The parameters for
changing speeds are specified in “Channel setting” > “Parameter settings” menu.

● J-point control can be used for single-axis control only. It is not available for interpolation
control.

● Set the unit to increment mode to implement E-point control with positions specified after J-
point control is implemented.

● Speed control is performed while the positioning unit is in J-point control, in which case, be
sure to input the amount of movement for positioning with a value that can secure a target
constant-speed area.

5.4.7 Programming Cautions

■ Programming cautions
● The last table should be set to E: End point.
● If any value such as a movement amount, acceleration time, deceleration time or target

speed is out of the specified range, a positioning error will occur when the position control
starts.

● The startup contact and flag numbers vary depending on channel numbers (axis numbers).

■ Operation at limit input

Conditions Direction Limit status Operation

When each control starts Forward
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Not executable, Error occurs.

5.4 Positioning Control
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Conditions Direction Limit status Operation

Reverse
Over limit input (+): ON Not executable, Error occurs.

Over limit input (-): ON Not executable, Error occurs.

When each control is
performed

Forward
Over limit input (+): ON Limit stops, Error occurs.

Over limit input (-): ON Limit stops, Error occurs.

Reverse
Over limit input (+): ON Limit stops, Error occurs.

Over limit input (-): ON Limit stops, Error occurs.

5.4 Positioning Control
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5.5 Repeat Operation

5.5.1 Overview of Repeat Operation

● The repeat count is specified for executing the repeat control in Configurator PMX.
● When the position control start instruction F380 is executed, the unit repeats the operation

set in the positioning table.

■ Conditions of repeat control

Item Repeat control is available Repeat control is unavailable

Operation pattern
E-point control, P-point control + E-point
control
C-point control + E-point control

JOG operation, J-point control, Interpolation
control

Control method Increment mode Absolute mode

Dwell time setting Set the table of E-point control to 1 ms or
more. When setting 0 ms.

■ Operation diagram (Setting operation on the table)

■ Operation diagram (Repeat operation)

5.5 Repeat Operation

5-28 WUME-FP0HPOS-04



■ Configurator PMX setting items

Parameter name Unit Default Settings

Positioning repeat count times 0

0 or 1 Not repeat an operation.

2 to 254 Repeat an operation for a specified
number of times.

255 Repeat an operation infinitely.

■ Configurator PMX settings

● When selecting “255: Repeat infinitely” in the parameter of positioning repeat count, create a
program to stop the operation using the deceleration stop function.

5.5.2 Settings and Operations of Repeat Operation

● The parameter for the repeat count is specified in the positioning parameter setting menus of
Configuration PMX.

● When the positioning table start instruction (F380 POSST) or positioning simultaneous start
instruction (F383 MPOST) is executed, the pulse output will start.

● After starting the instruction, the unit executes the pulse output for a specified repeat count
and then stops the operation. For setting to execute the operation infinitely, use this function
in combination with the deceleration stop function.

5.5 Repeat Operation

WUME-FP0HPOS-04 5-29



■ Operation diagram

■ Operations of each contact
● The BUSY flags (X808 to X80B), which indicate that the motor is running, will turn on when

the position control starts, and they will turn off when the set repeat operation completes.
● The operation done flags (X810 to X813), which indicate the completion of operation, will

turn on when the current operation is completed, and they will be held until the next
positioning control, JOG operation or home return operation starts. Those flags do not turn
off in the middle of the repeat operation.

■ Settings

Item Setting example

Common area
Axis setting Turn on the single axis setting for an appropriate axis.

Positioning repeat
count 3

Axis setting area
Pulse output control
code Set in accordance with system configuration.

Startup speed 1,000 Hz

Table area

Table number Table 1 Table 2

Control code Increment mode Increment mode

Operation pattern P-point control (Pass point
control)

E-point control (End point
control)

Positioning
acceleration time 100 ms 150 ms

Positioning
deceleration time 200 ms 250 ms

Positioning target
speed 20,000 Hz 10,000 Hz

Positioning movement
amount 5,000 pulses 10,000 pulses

Dwell time － 50 ms

5.5 Repeat Operation
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■ Configurator PMX settings

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

5.5.3 Stop Operation During Repeat Operation

● When setting the repeat function, the operation at the time of deceleration stop varies as
follows.

■ Operation at the time of deceleration stop (Repeating E-point control)
When the unit detects a deceleration stop, the unit will come to a stop after repeating
positioning control N+2 times. However, the unit will stop the control when reaching the set
repeat count.

5.5 Repeat Operation
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■ Operation at the time of deceleration stop (Repeating P-point control, C-point
control)

When the unit detects a deceleration stop, it stops the operation after repeating the positioning
control N+1 times. However, the unit will stop the control when reaching the set repeat count.

● When a system stop is executed, the unit will stop the pulse output immediately without
repetitive operations.

● When an emergency stop is executed, the unit will stop the pulse output after a specified
emergency stop setting time without repetitive operations.

5.5 Repeat Operation
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5.6 Linear Interpolation Control

5.6.1 Overview

The interpolation control is available under the following conditions.

■ Combinations of interpolation control

Interpolation axis 1 Interpolation axis 2

X-axis Y-axis X-axis Y-axis

CH0 CH1 CH2 CH3

■ Conditions of interpolation control

Item
Condition under which interpolation control is executable

Available Not available

Operation pattern
E-point control
P-point control + E-point control
C-point control + E-point control

JOG operation

Home return (Note 1)

J-point control

Control method Increment mode, Absolute mode -

Dwell time setting Set the E-point control to 1 ms or more When set to 0 ms, the positioning error
occurs.

 

(Note 1) In the home return operation, the home return start instruction (F382 ORGST) is executed for each
channel corresponding to X and Y axes. The trajectory is not linear interpolation.

 

■ Setting method of speed

Item Composite speed Long axis

Operation

Setting method Specify the speed combining the speed
of X and Y axes.

Specify the speed for the axis whose
movement amount is large.

 

(Note 1) When specifying the same value, the major axis speed is faster than the composite speed.
 

5.6.2 Settings and Operations of Linear Interpolation

The example below is a case of E-point control with the unit installed in slot 1. The X axis is set
to the 1st axis and the Y axis is set to the 2nd axis. The movement amount setting is the
increment method, and the unit is set to pulse.

5.6 Linear Interpolation Control
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Y axis

X axis

10000 pulses

5000 pulses

■ Operation diagram

100 100

f [pps]

10000

t [ms]

Composite speed

Operation done flag of axis 1

Operation done flag of axis 2

BUSY flag of axis 1

BUSY flag of axis 2

Start Condition

■ Operations of each contact
● The BUSY flags (X808, X809), which indicates that the motor is running, will turn on when

the positioning control starts, and it will turn off when the operation completes.
● The operation done flags of axes 1 and 2 (X810, X811), which indicates the completion of

operation, will turn on when the current operation is completed, and it will be held until the
next positioning control, JOG operation or home return operation starts.

■ Settings

Item Setting example

Common area
Axis setting Turn on the single axis setting for an appropriate axis.

Positioning repeat
count 0

Axis setting area
Pulse output control
code Set in accordance with system configuration.

Startup speed 1,000Hz

Table Operation pattern E: End point

5.6 Linear Interpolation Control
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Item Setting example

area

Interpolation operation 0: Linear (composite speed)

Control method I: Increment

X-axis movement
amount 10000 pulses

Y-axis movement
amount 5000 pulses

Acceleration/
deceleration method L: Linear

Acceleration time (ms) 100 ms

Deceleration time (ms) 100 ms

Interpolation speed 10000 pps

Dwell time 0 ms

■ Sample program
The execution condition is differential execution. For details of instructions, refer to
"7 Instruction References".

R1
（（ ））DF K1K0F380 POSST K0

X808

CH0
BUSY

CH No.0
Table no. 1
Position control starts.

X809

CH1
BUSY

■ Programming cautions
● Specify a smaller channel number in the same group for starting the interpolation control.
● If any value such as a movement amount, acceleration time, deceleration time or target

speed is out of the specified range, a positioning error will occur when the position control
starts.

● The startup contact and flag numbers vary depending on channel numbers (axis numbers).

5.6 Linear Interpolation Control
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6.1 Operational Difference Between Parameters

6.1.1 Startup speed

● The startup speed is the parameter for setting the initial speed when starting each operation
and the speed when finishing each operation.

● The startup speed is common to each control of the JOG operation, home return, E-point
control, P-point control, C-point control and J-point control operations. It is set for each
channel number (axis number).

■ Setting method of startup speed
It is set in the “Parameter settings” dialog box of Configurator PMX.

■ Precautions when setting the startup speed
● The home return creep speed setting is not influenced by the startup speed in the home

return operation.
● The target speed of each operation is not influenced by the startup speed. Each operation is

performed at each specified target speed regardless of the setting of startup speed.

6.1.2 When Target Speed/Startup Speed is Less Than 50Hz

■ Operation

Operation
pattern Speed setting Operation

E-point control

When target speed is less than
50 Hz

Operation is performed with the set target speed. The
startup speed setting is invalid and the acceleration/
deceleration operation is not performed.

When startup speed is less
than 50 Hz

When the target speed is set to 50 Hz or more, the startup
speed is corrected to 50 Hz and the table operation is
performed.

P-point control
C-point control
J-point control
JOG operation

When target speed is less than
50 Hz

The target speed is corrected to 50 Hz and the table
operation is performed.

When startup speed is less
than 50 Hz

The startup speed is corrected to 50 Hz and the table
operation is performed.

6.1 Operational Difference Between Parameters
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6.1.3 Operation Patterns and Start Speed Settings

Operation
pattern

Startup speed setting

JOG
operation

(1) Startup speed

(2) Target speed

Home
return

(1) Startup speed

(2) Target speed

(3) Creep speed

E-point
control

(1) Startup speed

(2) Target speed

P-point
control

(1) Startup speed

(2) P-point target speed

(3) E-point target speed

C-point
control

(1) Startup speed

(2) C-point target speed

(3) E-point target speed

6.1 Operational Difference Between Parameters
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Operation
pattern

Startup speed setting

J-point
control

(1) Startup speed

(2) J-point target speed

(3) J-point change speed

(4) E-point target speed

6.1 Operational Difference Between Parameters
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6.2 Other Characteristics

6.2.1 Backup of Positioning Memory

● The positioning parameters and positioning table data set in the unit will be also held in the
memories of the control unit when the control unit is powered off. They will be also held when
the mode is switched from RUN to PROG.

● The elapsed value area (current value of position data) in the axis information area will be
reset to zero when the unit is powered off. However, when the RUN mode is switched to
PROG. mode, the latest value will be held.

6.2.2 Activation of Each Operation

● When any of the JOG operation, home return and position control is activated, it does not
transit to other operation even if an instruction to activate the other instruction turns on.
Create a program to confirm the busy signals (X808 to X80B) allocated to each axis and to
start instructions.

● Stop operations (system stop, emergency stop, limit stop, deceleration stop) have priority
even during other operations. Each operation is executed by turning on the stop signal
allocated to each axis.

6.2.3 Operation When PLC Mode Changes From RUN To PROG.

● When the mode of CPU Unit changes from RUN to PROG. after starting the JOG operation,
home return or position control (E-point control, P-point control, C-point control, J-point
control), each operation stops.

● As well as the execution of the system stop, the unit stops the pulse output immediately.

6.2 Other Characteristics
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7.1 Table Setting Mode Control Instruction

7.1.1 [F380 POSST] Positioning Table Start Instruction

Starts the positioning operation according to the data specified in the positioning memory
(positioning table area). This instruction is used to start the E point control, P point control, C
point control, J point control or linear interpolation control.

■ Instruction format

■ Operand

Operand Settings Setting range

S1 Channel number to start the positioning operation (Unsigned 16-
bit integer) 0 to 3

S2 Table number to start (Unsigned 16-bit integer) 1 to 20

S3 Output assignment 0 (Pulse output), 1
(Calculation only)

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S1 ● ● ● ● ● ● ● ● ● ● ● ●

S2 ● ● ● ● ● ● ● ● ● ● ● ●

S3 ● ● ● ● ● ● ● ● ● ● ● ●

■ Outline of operation
● Starts the positioning operation according to the data specified in the positioning memory

(positioning table area).
● When Calculation only is specified for [S3], only the table calculation is executed. When

starting the positioning operation for the same channel and the same table from the next
scan after executing the calculation, the startup time of the positioning control is reduced.

■ Precautions during programming
● If an operand is an out-of-range value, an operation error occurs.
● The stop operation has priority when the conditions of system stop, emergency stop, limit

stop and deceleration stop are satisfied.
● An operation error occurs when the system register of a specified channel is other than

“Pulse output [Table operation]”.

7.1 Table Setting Mode Control Instruction
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● A self-diagnostic error (positioning operation error) occurs when the set value or the value of
the positioning memory (axis setting area) is abnormal.

● When the channel to be started has been already operating, the positioning control does not
start and it terminates.

■ Flag operations

Name Explanation

R9007
R9008
(ER)

When the area is exceeded at the time of index modification

When the [S1] value is outside the set range

When the [S2] value is outside the set range

When the [S3] value is outside the set range

When the pulse output (table operation) has not been set in the system register

7.1.2 [F381 JOGST] JOG Operation Start Instruction

Starts the JOG operation according to the parameters specified in the positioning memory (axis
setting area).

■ Instruction format

■ Operand

Operand Settings Setting range

S1 Channel number to start the JOG operation (Unsigned 16-bit
integer) 0 to 3

S2 Operating direction (Unsigned 16-bit integer) 0 (Forward), 1 (Reverse)

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S1 ● ● ● ● ● ● ● ● ● ● ● ●

S2 ● ● ● ● ● ● ● ● ● ● ● ●

■ Outline of operation
● Executes the JOG operation according to the JOG operation parameters specified in the

positioning memory (axis setting area). While the execution condition is valid, the JOG
operation continues.

7.1 Table Setting Mode Control Instruction
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● The target speed can be changed by rewriting the positioning parameter area with a user
program. The change is executed after it becomes a constant speed.

■ Precautions during programming
● If an operand is an out-of-range value, an operation error occurs.
● The stop operation has priority when the conditions of system stop, emergency stop, limit

stop and deceleration stop are satisfied.
● An operation error occurs when the system register of a specified channel is other than

“Pulse output [Table operation]”.
● A self-diagnostic error (positioning operation error) occurs when the set value or the value of

the positioning memory (axis setting area) is abnormal.
● The JOG operation needs to be stopped for switching between the forward rotation and

reverse rotation.
● In case of changing a speed, when the target speed after the change is an out-of-range

value, the speed change is not executed and the operation continues.

■ Flag operations

Name Explanation

R9007
R9008
(ER)

When the area is exceeded at the time of index modification

When the [S1] value is outside the set range

When the [S2] value is outside the set range

When the pulse output (table operation) has not been set in the system register

7.1.3 [F382 ORGST] Home Return Start Instruction

Starts the home return operation according to the parameters specified in the positioning
memory (axis setting area).

■ Instruction format

■ Operand

Operand Settings Setting range

S Channel number to start the home return (Unsigned 16-bit integer) 0 to 3

7.1 Table Setting Mode Control Instruction
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■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S ● ● ● ● ● ● ● ● ● ● ● ●

■ Outline of operation
● Starts the home return operation according to the home return parameters specified in the

positioning memory (axis setting area).

■ Precautions during programming
● If an operand is an out-of-range value, an operation error occurs.
● The stop operation has priority when the conditions of system stop, emergency stop, limit

stop and deceleration stop are satisfied.
● An operation error occurs when the system register of a specified channel is other than

“Pulse output [Table operation]”.

■ Flag operations

Name Explanation

R9007
R9008
(ER)

When the area is exceeded at the time of index modification

When the value of [S] exceeds the set range

When the pulse output (table operation) has not been set in the system register

7.1.4 [F383 MPOST] Positioning Table Simultaneous Start Instruction

Starts the positioning tables for multiple axes specified on Configurator PMX. The tables of the
E point control, P point control and C point control can be started.

■ Instruction format

■ Operand

Operand Settings

S The starting area of the data register storing the data table numbers (unsigned 16-bit integer) to
be started simultaneously

7.1 Table Setting Mode Control Instruction
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■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S － － － － － － ● － － － － ●

■ Outline of operation
● Starts the positioning table numbers of the channels specified in the area starting with [S]

simultaneously.
● Positioning tables that can be specified are those for the single-axis control only.
● Table numbers are specified in the range of 0 to 20. In the case of 0, the table is not

executed simultaneously with other tables.

S Output specification (0: Pulse output, 1: Calculation only)

S+1 CH0 Positioning table number (0 to 20)

S+2 CH1 Positioning table number (0 to 20)

S+3 CH2 Positioning table number (0 to 20)

S+4 CH3 Positioning table number (0 to 20)

■ Precautions during programming
● If an operand is an out-of-range value, an operation error occurs.
● The stop operation has priority when the conditions of system stop, emergency stop, limit

stop and deceleration stop are satisfied.
● An operation error occurs when the system register of a specified channel is other than

“Pulse output [Table operation]”.
● Only when all the specified channels can be started, they are executed simultaneously.

When the BUSY flag of any channel is on, tables are not started simultaneously and the
process is terminated.

● Use F380 POSST instruction to start linear interpolation. When the table of the interpolation
axis control has been specified with F383 MPOST instruction, a self-diagnostic error
(positioning operation error) occurs.

■ Flag operations

Name Explanation

R9007
R9008
(ER)

When the area is exceeded at the time of index modification

When the [S] data table exceeds the area

When the value of [S] exceeds the set range

When the pulse output (table operation) has not been set in the system register

7.1.5 [F384 PTBLR] Positioning Parameter Read Instruction

Reads the positioning parameter data stored in the positioning memory of the unit to the
operation memory area.

7.1 Table Setting Mode Control Instruction
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■ Instruction format

■ Operand

Operand Settings

S1

Specification of channel numbers and positioning memory area

(Higher 8 bits) channel no.: H0 to H3

(Lower 8 bits) Area no.:
H00 (Common area), H01 (Axis information area), H02 (Axis
setting area),
H03 (Positioning table area)

S2
Starting address of the positioning memory storing read data (offset address)
or operation memory area storing the starting address

n No. of read words

D Operation memory storing read data
 

(Note 1) When reading the common area, the setting of channel numbers is invalid.
(Note 2) The operand S1 is specified using a combination of hexadecimal numbers. For the axis information

area of channel number 3, specify H301.
 

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S1 ● ● ● ● ● ● ● ● ● ● ● ●

S2 ● ● ● ● ● ● ● ● ● ● ● ●

n ● ● ● ● ● ● ● ● ● ● ● ●

D － ● ● ● ● ● ● ● ● － － ●

■ Outline of operation
● Reads [n] words of the data stored in the positioning memory starting with [S2], and stores it

in the operation memory area starting with [D].
● Channel numbers and the type of positioning memory is specified by [S1].

■ Precautions during programming
● If an operand is an out-of-range value, an operation error occurs.

■ Flag operations

Name Explanation

R9007
R9008

When the [S1] value is outside the set range

7.1 Table Setting Mode Control Instruction
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Name Explanation

(ER)

When the [S2] value exceeds the positioning area specified by [S1]

When the no. of read words is "0"

When the read data exceeds the area of [D]

7.1.6 [F385 PTBLW] Positioning Parameter Write Instruction

This instruction is used to write positioning parameters and positioning table data with user
programs.

■ Instruction format

■ Operand

Operand Settings

S1

Specification of channel numbers and positioning memory area

(Higher 8 bits) channel no.: H0 to H3 (Not save in FROM), H80 to H83 (Save in FROM)

(Lower 8 bits) Area no.:
H00 (Common area), H01 (Axis information area), H02 (Axis
setting area),
H03 (Positioning table area)

S2 Operation memory area storing written data

n No. of written data

D
Starting address of the positioning memory storing data (offset address)
or operation memory area storing the starting address

 

(Note 1) When writing data to the common area, the setting of channel numbers is invalid.
(Note 2) The operand S1 is specified using a combination of hexadecimal numbers. For the axis setting area of

channel number 3, specify H302.
 

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S1 ● ● ● ● ● ● ● ● ● ● ● ●

S2 ● ● ● ● ● ● ● ● ● - - ●

n ● ● ● ● ● ● ● ● ● ● ● ●

D ● ● ● ● ● ● ● ● ● ● ● ●

7.1 Table Setting Mode Control Instruction
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■ Outline of operation
● Reads [n] words of the data stored in the area starting with [S2], and stores it in the

positioning memory area starting with [D].
● Channel numbers and the type of positioning memory are specified by [S1].

■ Precautions during programming
● If an operand is an out-of-range value, an operation error occurs.
● When specifying [H80 to H83 (Save in FROM)] for the higher 8 bits of operand [S1] (the most

significant bit is1), specified data is written into the F-ROM of the control unit. Writing to F-
ROM can be performed up to 10000 times. We recommend using differential execution to
prevent the writing from being executed continuously.

● For details of positioning memory, refer to "12.3 Positioning Memory".

■ Flag operations

Name Explanation

R9007
R9008
(ER)

When the [S1] value is outside the set range

When the [D] value exceeds the positioning area specified by [S1]

When the range of the data written from [D] exceeds the positioning area specified by [S1]

When the no. of written data is "0"

When the written data exceeds the area of [S2]

7.1 Table Setting Mode Control Instruction
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7.2 FPsigma Compatible Instruction Mode Control Instruction

7.2.1 [F171(SPDH)] Pulse Output (Trapezoidal Control)

This instruction outputs pulses from a specified pulse output channel according to specified
parameters.

■ Instruction format

■ Operand

Operand Settings

S Starting number of the area in which data tables are registered

n Target channel for pulse output

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● Outputs pulses from a specified channel when a corresponding control active flag is OFF

and the execution condition is ON.
● The control code, initial speed, maximum speed, acceleration/deceleration time, and target

value are specified by creating data tables [S] to [S+11] described on the next page using a
user program.

● Switches the frequency from the initial speed to the maximum speed in the specified
acceleration/deceleration time. At the time of deceleration, switches the frequency with the
same inclination as that for acceleration.

● For setting the frequency to 50 kHz or more, specify the duty of 1/4 (25%).

■ Operation mode
Incremental <Relative value control>
Outputs the pulses set with the target value.

7.2 FPsigma Compatible Instruction Mode Control Instruction
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Selection

Target value CW/CCW
PLS+SIGN
Forward OFF
Reverse ON

PLS+SIGN
Forward ON
Reverse OFF

Elapsed value

When plus Pulse output from
CW

Pulse output when
direction output is
OFF

Pulse output when
direction output is
ON

Addition

When minus Pulse output from
CCW

Pulse output when
direction output is
ON

Pulse output when
direction output is
OFF

Subtraction

Absolute <Absolute value control>
Outputs the pulses of the difference between the set target value and current value.

Selection

Target value CW/CCW
PLS+SIGN
Forward OFF
Reverse ON

PLS+SIGN
Forward ON
Reverse OFF

Elapsed value

When target value
is larger than
current value

Pulse output from
CW

Pulse output when
direction output is
OFF

Pulse output when
direction output is
ON

Addition

When target value
is smaller than
current value

Pulse output from
CCW

Pulse output when
direction output is
ON

Pulse output when
direction output is
OFF

Subtraction

■ Data table settings

f

t

Fmax

Fmin

t t

No. of output pulses

Acceleration time Deceleration time

7.2 FPsigma Compatible Instruction Mode Control Instruction
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S
S+1

S+2
S+3

S+4
S+5

S+6
S+7

S+8
S+9

S+10
S+11

②

③

④

⑤

①Control code

Initial speed
Fmin(Hz)

Maximum speed
Fmax(Hz)

Acceleration/
deceleration time

t(ms)

Target value
(No. of pulses)

K0

Operand Settings Description

(1) S, S+1 Control code

Specify the control code by setting the H constant.

H

Operation mode and output method
0: Incremental CW/CCW

Acceleration/deceleration time setting

Frequency range
Not used

Duty (on width)
0: Duty 1/2 (50%)

0: Fixed

0: Normal
1: Acceleration/deceleration time priority

1: Duty 1/4 (25%)

2: Incremental PLS+SIGN (forward off/reverse on)
3: Incremental PLS+SIGN (forward on/reverse off)

10: Absolute CW/CCW
12: Absolute PLS+SIGN (forward off/reverse on)
13: Absolute PLS+SIGN (forward on/reverse off)

Output setting
0: Pulse output
1: Calculate only
Acceleration/deceleration steps
0: 30 steps
1: 60 steps

(2)

S+2, S+3
Initial speed
Fmin(Hz)

The setting range of the settable maximum speed varies according to
the setting of the initial speed as shown in the table below.

Range Initial speed Maximum speed

Low
speed

K1 to K49
(1 to 49 Hz)

Initial speed to K22000 (to 22
kHz)

High
speed

K50 to K100000
(50 Hz to 100 kHz)

Initial speed to K100000 (to
100 kHz)

S+4, S+5 Maximum speed
Fmax(Hz)

7.2 FPsigma Compatible Instruction Mode Control Instruction
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Operand Settings Description
When the initial speed is set to low speed, specifying a value
exceeding K22000 for the maximum speed occurs an operation error.

(3) S+6, S+7
Acceleration/
deceleration time
t(ms)

Acceleration/deceleration time (ms)

With 30 steps: K30 to K32760
(Specify in 30 ms increments.)

With 60 steps: K60 to K32760
(Specify in 60 ms increments.)

 

(Note 1) When the time is not specified in 30 ms nor 60 ms
increments,it will be automatically corrected to the multiple
value (larger value) of 30 ms or 60 ms.

 

(4) S+8, S+9 Target value
Target value
K-2147483648 to K2147483647 pulses

(5) S+10, S+11 K0 Set K0 to the last two words of the data table.

■ Example of program

7kHz

1kHz

300ms 300ms

⊿t

⊿f

No. of output pulses
100,000

7.2 FPsigma Compatible Instruction Mode Control Instruction
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● 30 段時

⊿f = (7000-1000)÷30 段=200(Hz)
⊿t = 300ms÷30 段=10ms

● 60 段時

⊿f = (7000-1000)÷60 段=100(Hz)
⊿t = 300ms÷60 段=5ms

■ Regarding the specification of acceleration/deceleration time
For specifying acceleration/deceleration time, No. of steps and initial speed, set the value to be
calculated by the formula below. Specify acceleration/deceleration time in 30 ms increments
with 30 steps, and in 60 ms increments with 60 steps. When the time is not specified in 30 ms
nor 60 ms increments, it will be automatically corrected to the multiple values (larger value) of
30 ms or 60 ms.
Acceleration/deceleration time t [ms] (No. of steps x 1000)/Initial speed f0 [Hz]
● When "Acceleration/deceleration time priority" is specified for the control code, the initial

speed is corrected according to the time.
The corrected speed is stored in the correction speed area of initial speed of special data
registers (from DT90400).
(Example): When the initial speed is 10 Hz, and acceleration/deceleration time is 1 msec, the
initial speed is corrected to 1000 Hz.

● When the corrected initial speed exceeds the maximum speed, the initial speed is corrected
to the maximum speed.
(Example): When the initial speed is 10 Hz, the maximum speed is 500 Hz, acceleration/
deceleration time is 1 msec, and acceleration/deceleration time priority is specified,
it takes 100 msec for outputting one pulse at the initial speed and it exceeds 1 msec of
acceleration/deceleration time.
Although the initial speed is corrected to 1000 Hz as "Acceleration/deceleration time priority"
is specified, it is corrected to 500 Hz because it exceeds the maximum speed.

■ Supplement to pulse output operation
When outputting pulses with the PLS+SIGN (direction output) method, pulses will be output
approx. 300µs later after the output of direction signal (SIGN). (The characteristics of a motor
driver are considered.)

■ Precautions during programming
● When describing the same channel in both the normal program and the interrupt program, be

sure to program not to execute them simultaneously.
● This instruction cannot be executed when a control flag corresponding to each channel is on.
● For the FP0H mode, select "Pulse output" for the channel setting corresponding to the

system register no. 402.
● For the FPsigma mode, select "Do not use high-speed counter" for the channel setting

corresponding to the system register nos. 400 and 401.
● By performing the rewriting during RUN while outputting pulses, more pulses than the setting

may be output.

7.2 FPsigma Compatible Instruction Mode Control Instruction
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● For details of the allocations of I/O and flags, refer to "12.2.2 When Using Pulse Output
Function (FPsigma Compatible Instruction Mode)".

● For details of the FP mode, refer to "11 FPsigma Mode".

7.2.2 [F171(SPDH)] Pulse Output (Home Return)

This instruction outputs pulses from a specified pulse output channel according to specified
parameters.

■ Instruction format

■ Operand

Operand Settings

S Starting number of the area in which data tables are registered

n Target channel for pulse output

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● Outputs pulses from a specified channel when a corresponding control active flag is OFF

and the execution condition is ON.
● The control code, initial speed, maximum speed, acceleration/deceleration time, and

deviation counter clear signal are specified by creating data table described on the next page
using a user program.

● Switches the frequency from the initial speed to the maximum speed in the specified
acceleration/deceleration time. At the time of deceleration, switches the frequency with the
same inclination as that for acceleration.

● For setting the frequency to 50 kHz or more, specify the duty of 1/4 (25%).

7.2 FPsigma Compatible Instruction Mode Control Instruction
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■ Explanation of operation mode
Home return

The pulses are continuously output until the home input (X2 or X5) is enabled. To shift to
deceleration operation when detecting the near home, turn the corresponding bit of special
data register DT90052 to OFF ON OFF by the near home input. The value in the elapsed
value area during the home return operation differs from the current value.

Home return mode I (Home return by near home input and home input)
When the near home input is enabled, deceleration will be performed, and the pulse output
will stop after the home input. The operation varies according to the setting of the control code
(low byte) described on the next page.

f

t

Fmax

Fmin

Near home input

Home input

Home return mode II (Home return by home input only)
When the home input is enabled, the pulse output will stop. Set the control code (low byte) on
the next page to H20 to H27.

f

t

Fmax

Fmin

Home input

■ Data table settings

S
S+1

S+2
S+3

S+4
S+5

S+6
S+7

S+8
S+9

①

②

③

④

Control code

Initial speed
Fmin(Hz)

Maximum speed
Fmax(Hz)

Acceleration/
deceleration time

t(ms)

Deviation counter clear
signal output time tr(ms)

Operand Settings Description

(1) S, S+1 Control code Specify the control code by setting the H constant.

7.2 FPsigma Compatible Instruction Mode Control Instruction
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Operand Settings Description

Operation mode and output method
20: Homing mode 1 CW

Acceleration/deceleration steps

Frequency range
Not used

Duty (on width)
0: Duty 1/2 (50%)

0: Fixed

0: 30 steps
1: 60 steps

1: Duty 1/4 (25%)

21: Homing mode 1 CCW
22: Homing mode 1 Directional output off
23: Homing mode 1 Directional output on
24: Homing mode 1 CW + deviation counter reset
25: Homing mode 1 CCW + deviation counter reset
26: Homing mode 1 Direction output off + deviation counter reset
27: Homing mode 1 Direction output on + deviation counter reset
30: Homing mode 2 CW
31: Homing mode 2 CCW
32: Homing mode 2 Directional output off
33: Homing mode 2 Direction output on
34: Homing mode 2 CW + deviation counter reset
35: Homing mode 2 CCW + deviation counter reset
36: Homing mode 2 Direction output off + deviation counter reset
37: Homing mode 2 Direction output on + deviation counter reset

H

Acceleration/deceleration time setting
0: Normal
1: Acceleration/deceleration time priority
Output setting
0: Pulse output
1: Calculate only

(2)

S+2, S+3
Initial speed
Fmin(Hz)

The setting range of the settable maximum speed varies
according to the setting of the initial speed as shown in the table
below.

Range Initial speed Maximum speed

Low
speed

K1 to K49
(1 to 49 Hz)

Initial speed to K22000 (to 22
kHz)

High
speed

K50 to K100000
(50 Hz to 100 kHz)

Initial speed to K100000 (to
100 kHz)

When the initial speed is set to low speed, specifying a value
exceeding K22000 for the maximum speed occurs an operation
error.

S+4, S+5
Maximum speed
Fmax(Hz)

(3) S+6, S+7
Acceleration/
deceleration time
t(ms)

Acceleration/deceleration time (ms)
With 30 steps: K30 to K32760
With 60 steps: K60 to K32760

(4) S+8, S+9

Deviation counter
clear
signal output time
tr(ms)

Set the output time of the deviation counter clear signal.
0.5 ms to 100 ms [K0 to K100] Setting value + error (0.5 ms or
less)
When this signal is not used or the time is set to less than 0.5 ms,
specify K0.
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■ Example of program

■ Regarding the specification of acceleration/deceleration time
For specifying acceleration/deceleration time, No. of steps and initial speed, set the value to be
calculated by the formula below. Specify acceleration/deceleration time in 30 ms increments
with 30 steps, and in 60 ms increments with 60 steps. When the time is not specified in 30 ms
nor 60 ms increments, it will be automatically corrected to the multiple values (larger value) of
30 ms or 60 ms.
Acceleration/deceleration time t[ms] (No. of steps x 1000)/Initial speed f0[Hz]
● When "Acceleration/deceleration time priority" is specified for the control code, the initial

speed is corrected according to the time.
The corrected speed is stored in the correction speed area of initial speed of special data
registers (from DT90400).
(Example): When the initial speed is 10 Hz, and acceleration/deceleration time is 1 msec, the
initial speed is corrected to 1000 Hz.

● When the corrected initial speed exceeds the maximum speed, the initial speed is corrected
to the maximum speed.
(Example): When the initial speed is 10 Hz, the maximum speed is 500 Hz, acceleration/
deceleration time is 1 msec, and acceleration/deceleration time priority is specified,
it takes 100 msec for outputting one pulse at the initial speed and it exceeds 1 msec of
acceleration/deceleration time.
Although the initial speed is corrected to 1000 Hz as "Acceleration/deceleration time priority"
is specified, it is corrected to 500 Hz because it exceeds the maximum speed.

■ Supplement to pulse output operation
When outputting pulses with the PLS+SIGN (direction output) method, pulses will be output
approx. 300µs later after the output of direction signal (SIGN). (The characteristics of a motor
driver are considered.)

7.2 FPsigma Compatible Instruction Mode Control Instruction
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■ Precautions during programming
● When the control code (low byte) is H20 to H27 (home return mode I), the home input is

enabled even after the near home input, the completion of deceleration, or in the middle of
deceleration.

● When the control code (low byte) is H30 to H37 (home return mode II), the home input is
enabled only after the near home input and the completion of deceleration up to the value of
initial speed.

● Even when the home input is enabled, the pulse output starts by the execution of this
instruction.

● When the near home input is enabled during acceleration, the deceleration operation will
start.

● When describing the same channel in both the normal program and the interrupt program, be
sure to program not to execute them simultaneously.

● This instruction cannot be executed when a control flag corresponding to each channel is on.
● For the FP0H mode, select "Pulse output" for the channel setting corresponding to the

system register no. 402.
● For the FPsigma mode, select "Do not use high-speed counter" for the channel setting

corresponding to the system register nos. 400 and 401.
● By performing the rewriting during RUN while outputting pulses, more pulses than the setting

may be output.
● For performing the software reset, disabling the counting, stopping the pulse output or near

home processing, refer to the F0(MV) instruction, pulse output control.

● For the details of the allocations of I/O and flags, refer to "12.2.2 When Using Pulse Output
Function (FPsigma Compatible Instruction Mode)".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

7.2.3 [F172(PSLH)] Pulse Output (JOG Operation)

Outputs the pulse of a specified parameter from a specified channel.

■ Instruction format

■ Operand

Operand Settings

S Starting number of the area in which data tables are registered

n Target channel for pulse output

7.2 FPsigma Compatible Instruction Mode Control Instruction
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■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● Outputs pulses from a specified channel when a corresponding control active flag is OFF

and the execution condition is ON. The output is performed when the trigger (execution
condition) is on.

● By specifying the addition counting or subtraction counting mode for the control code, it can
be used for the instruction for activating JOG operation.

● The frequency can be changed in each scan, or the target value can be changed
asynchronously. However, the control code cannot be changed during the execution of an
instruction.

● For setting the frequency to 50 kHz or more, specify the duty of 1/4 (25%).

■ Data table settings

S
S+1

S+2
S+3

S+4
S+5

S
S+1

S+2
S+3

①

②

③

①

②

Control code

Frequency

Target value

Control code

Frequency

Operand Settings Description

(1) S, S+1 Control code

Specify the control code by setting the H constant.

Output method
00: No counting CW

Acceleration/deceleration steps

Frequency range
Not used

Duty (on width)
0: Duty 1/2 (50%)

0: Fixed

0: Mode with no target value
1: Target value match stop mode

1: Duty 1/4 (25%)

01: No counting CCW
10: Addition counting CW
12: Addition counting Directional output off
13: Addition counting Directional output on
21: Subtraction counting CW
22: Subtraction counting Directional output off
23: Subtraction counting Directional output on

H

7.2 FPsigma Compatible Instruction Mode Control Instruction
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Operand Settings Description

(2) S+2, S+3 Frequency

The setting range of the settable change speed varies according to
the setting of the initial speed as shown in the table below.

Range Initial speed Change speed

Low
speed

K1 to K49
(1 to 49 Hz)

K1 to K22000
(1 Hz to 22 kHz)

High
speed

K50 to K100000
(50 Hz to 100 kHz)

K1 to K100000
(1 Hz to 100 kHz)

When the initial speed is set to low speed, it is corrected to 22 kHz
even when specifying a value exceeding K22000 for the change
speed.

(3) S+4, S+5 Target value

Target value (absolute value)
It is used when setting the target value match stop mode. (Absolute
only)
Specify the target value in the following range. If a value outside of
the range is specified, the number of pulses different from the
specified value is output. When specifying the no counting mode, the
target value setting is ignored.

Output
method Settable range of target value

Addition
counting

Values larger than the current value

Subtraction
counting

Values smaller than the current value

■ Supplement to pulse output operation
When outputting pulses with the PLS+SIGN (direction output) method, pulses will be output
approx. 300µs later after the output of direction signal (SIGN). (The characteristics of a motor
driver is considered.)

■ Precautions during programming
● This instruction cannot be executed when a control flag corresponding to each channel is on.
● When describing the same channel in both the normal program and the interrupt program, be

sure to program not to execute them simultaneously.
● For the FP0H mode, select "Pulse output" for the channel setting corresponding to the

system register no. 402.
● For the FPsigma mode, select "Do not use high-speed counter" for the channel setting

corresponding to the system register nos. 400 and 401.
● When rewriting during RUN is performed during the operation, the pulse output stops while a

program is being rewritten.
● Even if the control code is changed after starting the instruction, the change is invalid. It does

not affect on the operation.
● When the frequency is changed to a value outside of the settable range after executing the

instruction, the operation is performed with the minimum or maximum value in the
specification range without causing an operation error.

7.2 FPsigma Compatible Instruction Mode Control Instruction
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● For the details of the allocations of I/O and flags, refer to "12.2.2 When Using Pulse Output
Function (FPsigma Compatible Instruction Mode)".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

7.2.4 [F174(SP0H)] Pulse Output (Selectable Data Table Control Operation)

Outputs pulses from a specified pulse output channel according to a specified data table.

■ Instruction format

■ Operand

Operand Settings

S Starting number of the area in which data tables are registered

n Target channel for pulse output

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● Outputs pulses from a specified channel according to the settings specified in the data table

starting with the address specified by [S] when a corresponding control active flag is OFF
and the execution condition is ON.

● Switches the pulse frequency when the elapsed value of the high-speed counter reaches the
target value set in the data table. (It is performed by the interrupt processing.)

● Stops the pulse output when the elapsed value reaches the final target value.
● For setting the frequency to 50 kHz or more, specify the duty of 1/4 (25%).

7.2 FPsigma Compatible Instruction Mode Control Instruction
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■ Data table settings

S

S+2

S+4

S+6

S+8

K0

S+2n

S+2(n+1)

S+2(n+2)

①

②

③

④

Control code

Frequency 1

(Pulse number)

Frequency 2

Target value 1

(Pulse number)
Target value 2

Frequency n

(Pulse number)
Target value n

Operand Settings Description

(1) S Control code

Specify the control code by setting the H constant.

Output method
0: Addition counting CW

Operation mode

Frequency range
Not used

Duty (on width)
0: Duty 1/2 (50%)

0: Fixed

0: Specify Incremental movement amount (pulse no.).
1: Specify Absolute target value (absolute value).

1: Duty 1/4 (25%)

1: Subtraction counting CCW
2: Addition counting PLS+SIGN (forward off)
3: Subtraction counting PLS+SIGN (reverse on)
4: Addition counting PLS+SIGN (forward on)
5: Subtraction counting PLS+SIGN (reverse off)

H

(2)
S+2,
S+2n

Frequency n

The setting range of the settable maximum speed varies according to
the setting of the initial speed as shown in the table below.

Range Initial speed Maximum speed

Low
speed

K1 to K49
（1 to 49Hz）

Initial speed to K22000（to
22kHz）

7.2 FPsigma Compatible Instruction Mode Control Instruction
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Operand Settings Description

Range Initial speed Maximum speed

High
speed

K50 to K100000
（50Hz to 100kHz）

Initial speed to K100000（to
100kHz）

When the frequency 1 (initial speed) is the low speed range and the
frequency n is not in the range between 1 Hz to 22 kHz, the pulse
output stops.
When the frequency 1 (initial speed) is the high speed range and the
frequency n is not in the range between 50 Hz to 100 kHz, the pulse
output stops.

(3)
S+4,
S+2(n+1)

Target value n

Target value (K-2147483648 to K2147483647)
The values of 32-bit data specified as target values should be within
the range as shown in the table below.

Control code setting
Settable range of target value

Operation mode Output
method

Incremental

Addition
counting Positive values

Subtraction
counting Negative values

Absolute

Addition
counting

Values larger than the current
value

Subtraction
counting

Values smaller than the current
value

(4) S+2(n+2) K0 End of table (Pulse output stop setting)

■ Example of program
[Operation]
(1) Starts the pulse output at 1000 Hz from the specified channel ch0 when the execution
condition R10 of F174 (SP0H) instruction turns ON.
(2) Switches the frequency to 2500 Hz when 1000 pulses are counted at 1000 Hz.
(3) Switches the frequency to 5000 Hz when 3000 pulses are counted at 2500 Hz.
(4) Switches the frequency to 1000 Hz when 8000 pulses are counted at 5000 Hz.
(5) Stops the pulse output when 10000 pulses are counted.

5000

2500

1000

10000 3000 8000 10000

R10

Frequency (speed) [Hz]

Execution condition

HSC elapsed value
(Movement amount)

Control active flag

7.2 FPsigma Compatible Instruction Mode Control Instruction
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(Note 1) When the execution condition R10 of F174(SP0H) instruction turns ON, the control active flag will turn
ON. When the elapsed value reaches 10000 and the pulse output stops, the control active flag will
turn OFF. For details of the allocation of control active flags, refer to "12.2.2 When Using Pulse Output
Function (FPsigma Compatible Instruction Mode)".

 

[Settings and program]
Set the frequency range to 191 Hz to 100 kHz and duty 1/4 (25%), and the operation mode to
Incremental and the output method to CW.

■ Supplement to pulse output operation
When outputting pulses with the PLS+SIGN (direction output) method, pulses will be output
approx. 300µs later after the output of direction signal (SIGN). (The characteristics of a motor
driver is considered.)

■ Precautions during programming
● The control active flag turns ON until the pulse output stops after the execution condition of

F174(SP0H) instruction has turned ON.
● This instruction cannot be executed when a control flag corresponding to each channel is

ON.
● For the FP0H mode, select "Pulse output" for the channel setting corresponding to the

system register no. 402.
● For the FPsigma mode, select "Do not use high-speed counter" for the channel setting

corresponding to the system register nos. 400 and 401.
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● When the control code or frequency 1 is any value outside of the settable range, an
operation error occurs. (When the data of the frequency 1 is 0, nothing is executed and the
operation ends.)

● When the frequency after the second step is 0 or outside of the settable range, the pulse
output stops.

● When the table pointer exceeds the area of data registers DT during the pulse output, the
pulse output control will be canceled and the control active flag will turn OFF.

● The target values should be set in the range shown on the next page. If a value outside of
the range is specified, the number of pulses different from the specified value is output.

● For the details of the allocations of I/O and flags, refer to "12.2.2 When Using Pulse Output
Function (FPsigma Compatible Instruction Mode)".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

7.2.5 [F175(SPSH)] Pulse Output (Linear Interpolation)

Pulses are output from channel for 2 pulse output, in accordance with the parameters in the
designated data table, so that the path to the target position forms a straight line.

■ Instruction format

■ Operand

Operand Settings

S Starting number of the area in which data tables are registered

n FP0H mode: 0 or 2, FPsigma mode: 0 (Fixed)

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● Outputs pulses from a specified channel when a corresponding control active flag is OFF

and the execution condition is ON.

7.2 FPsigma Compatible Instruction Mode Control Instruction
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● The control code, initial speed, maximum speed, acceleration/deceleration time, and target
value are specified by creating data tables [S] to [S+11] described on the next page using a
user program.

● For setting the frequency to 40kHz or more, specify the duty of 1/4 (25%).

■ Data table settings

S

S+2

S+4

S+6

S+8

S+10

S+12

S+16

S+18

S+20

S+21

S+22

S+23

S+14

①

②

③

④

⑤

⑥

⑦

Control code

Composite speed

Setting area
Specify by user programs.

Y-axis
Target value (Movement amount)

Operation result storage area

Y-axis
Frequency range

Y-axis
Acceleration/deceleration steps

Initial speed Fmin(Hz)

Composite speed
Maximum speed Fmax(Hz)

Acceleration/deceleration time
T(ms)

X-axis
Component speed
Initial speed Fmin(Hz)

X-axis
Component speed

Maximum speed Fmax(Hz)
Y-axis

Component speed
Initial speed Fmin(Hz)

Y-axis
Component speed

Maximum speed Fmax(Hz)

X-axis
Frequency range

X-axis
Acceleration/deceleration steps

X-axis
Target value (Movement amount)

Parameters of each axis 
component calculated due to 
instruction execution are stored.

Setting area

Operand Settings Description

(1) S Control code Specify the control code by setting the H constant.
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Operand Settings Description

10: Absolute CW/CCW

Operation mode and output method

0: Fixed

Duty (on width)
0: Duty 1/2 (50%)

0: Fixed

00: Incremental CW/CCW

1: Duty 1/4 (25%)

02: Incremental PLS+SIGN (forward off/reverse on)
03: Incremental PLS+SIGN (forward on/reverse off)

12: Absolute PLS+SIGN (forward off/reverse on)
13: Absolute PLS+SIGN (forward on/reverse off)

S+1
H

S

(2)

S+2
Composite speed
Initial speed
Fmin(Hz)

Composite speed (Initial speed, maximum speed) (Hz) <K constant>
1.5 Hz to 100 kHz [k1 to K100000]
(However, for 1.5 Hz, the angle is 0 degree or 90 degrees only. Also,
for specifying 1.5 Hz, specify K1.)
● When the component speed becomes lower than the minimum

speed in each frequency range, it will be a corrected component
speed.

● Do not set 60 kHz or more when using any two of the high-speed
counter, periodical interrupt and PLC link are used simultaneously.

● When the initial speed is set to the maximum speed, the pulse
output is performed without acceleration and deceleration.

● Specify the composite speed to make the component speed of
each axis be 1.5Hz or more.

● Composite speed (Initial speed): 30 kHz or less
Notes on the specification of composite speed (initial speed)
When each initial component speed of CH0 and CH2 is not 1.5 Hz or
more by the following arithmetic expression, the path may not be
linear. (When the following formula is not satisfied)

⊿x: Channel whose distance of (target value - current value) is short
⊿y: Channel whose distance of (target value - current value) is long

S+4
Composite speed
Maximum speed
Fmax(Hz)

(3) S+6
Acceleration/
deceleration time
T(ms)

Acceleration/deceleration time (ms) <K constant>
K0 to K32767
In the case of 0, the pulse output is performed at the initial speed
(composite speed) without acceleration and deceleration.

(4)

S+8

X-axis
Target value
(Movement
amount)

K-8388608 to K8388607
When only one axis is activated;
1. For the incremental mode, set the target value of the axis that is

not activated to 0.
2. For the absolute mode, set the target value of the axis that is not

activated to the same as the current value.
(Note): In the case of linear interpolation, infinite rotation cannot be
performed.

S+10

Y-axis
Target value
(Movement
amount)

7.2 FPsigma Compatible Instruction Mode Control Instruction
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Operation result storage area

Operand Settin
gs Description

(5)

S+12

X-axis
Comp
onent
speed
Initial
speed
Fxmin

The component speed (initial speed and maximum speed of each axis) is
stored as 2 words in real type.

(Composite speed) ×  (X-axis movement amount)
X-axis component speed =

((X-axis movement amount)2 + (Y-axis movement amount)2)

(Composite speed) ×  (Y-axis movement amount)
Y-axis component speed =

((X-axis movement amount)2 + (Y-axis movement amount)2)

Example) Even when the initial speed is corrected, the calculated value is
stored as is in the operation result storage area.

S+14

X-axis
Comp
onent
speed
Maxim
um
speed
Fxmax

S+16

Y-axis
Comp
onent
speed
Initial
speed
Fymin

S+18

Y-axis
Comp
onent
speed
Maxim
um
speed
Fymax

(6)

S+20

X-axis
Frequ
ency
range

The frequency ranges are automatically selected by the system for the
components of each axis.
0: Low speed range (1 Hz to 22 kHz)
1: High speed range (50Hz to 100 kHz)
When the initial speed (X/Y axis) is the low speed range and the maximum
speed (X/Y axis) exceeds 22 kHz, the initial speed (X/Y axis) is corrected to
50 Hz.
When the initial speed (X/Y axis) is less than 1 and the maximum speed (X/Y
axis) exceeds 22 kHz or less, the initial speed (X/Y axis) is corrected to 1 Hz.

S+21

Y-axis
Frequ
ency
rangec

(7)

S+22

X-axis
Accele
ration/
decele
ration
steps

The acceleration/deceleration steps are automatically calculated by the
system in the range of 0 to 60 steps.
● When the operation result is 0, the pulse output is performed at the initial

speed (composite speed) without acceleration and deceleration.
● The acceleration/deceleration steps are calculated by the following

formula; Acceleration/deceleration time (ms) x Initial component speed
(Hz).

Example) When the settings are as follows; Incremental, Initial speed=5 kHz,
Acceleration/deceleration time=0.5 s, CH0 target value=1000, and CH2 target
value=50.

S+23

Y-axis
Accele
ration/
decele
ration
steps
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Operand Settin
gs Description

(10002+502)
= 299.626 Hz

300×1000

(10002+502)
= 14.981 Hz

300×50

CH0 Initial component speed =

CH2 Initial component speed =

CH0 Acceleration/deceleration steps = 500x10-3x299.626≈147.8 60 steps

CH2 Acceleration/deceleration steps = 500x10-3x14.981≈7.4 7 steps

■ Supplement to pulse output operation
When outputting pulses with the PLS+SIGN (direction output) method, pulses will be output
approx. 300µs later after the output of direction signal (SIGN). (The characteristics of a motor
driver is considered.)

■ Precautions during programming
● Set the target value and movement amount to be within the following range.

-8,388,608 to +8,388,607
When suing this instruction in combination with other positioning instructions such as F171,
also set the target values for those instructions to be within the above range.

● When using this instruction for a purpose for which high accuracy is required, confirm the
operation using a real machine.

● When describing the same channel in both the normal program and the interrupt program, be
sure to program not to execute them simultaneously.

● For the FP0H mode, select "Pulse output" for the channel setting corresponding to the
system register no. 402.

● For the FPsigma mode, select "Do not use high-speed counter" for the channel setting
corresponding to the system register nos. 400 and 401.

● By performing the rewriting during RUN while outputting pulses, more pulses than the setting
may be output.

● For the details of the allocations of I/O and flags, refer to "12.2.2 When Using Pulse Output
Function (FPsigma Compatible Instruction Mode)".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".
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8.1 Self-diagnostic Function

8.1.1 Operation Monitor LEDs of Control Unit

● The control unit has a self-diagnostic function which identifies errors and stops operation if
necessary.

● When an error occurs, the status of the status indicator LEDs on the control unit vary, as
shown in the table above.

■ LEDs related to self-diagnostic errors

LED display
Description Operation

statusRUN
(Green)

PROG
(Green)

ERR/ALM
(Red)

In
normal
conditio
n

ON OFF OFF Normal operation Operating

OFF ON OFF
Program mode
LED does not flash even if the forcing
output is performed in program mode.

Stop

Flashes
(Note 1)

Flashes
(Note 1) OFF

Forcing input/output in RUN mode
RUN and PROG. LEDs flash alternately.

Operating

Flashes
(Note 2)

Flashes
(Note 2) OFF During version upgrade Stop

In
abnorm
al
conditio
n

ON OFF Flashes Self-diagnostic error (During operation) Operating

OFF ON Flashes Self-diagnostic error (During stop) Stop

OFF ON ON System watchdog timer has been activated Stop

 

(Note 1) The flashing is repeated every 1 second. (ON for 0.5 seconds ⇔ OFF for 0.5 seconds)
(Note 2) The LEDs flash quickly while upgrading the version. The flashing changes to a slow flashing while

rewriting the version.
 

■ Operation Mode When an Error Occurs
● Normally, when an error occurs, the operation stops.
● For some errors, the user may select whether operation is to be continued or stopped by

setting the system registers.

8.1 Self-diagnostic Function
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■ "PLC Configuration" dialog box of FPWIN GR7
To specify the steps to be taken by the FPWIN GR7 if a PLC error occurs, select "System
register settings" under "Option" on the menu bar, and click on the "Action on Error" tab. The
screen shown below is displayed.

● When the checkbox of the system register no. 25 "Stop operation when positioning operation
error occurs" is unchecked, only the operation of the axis in which the positioning error occurs
stops and the operations of other axes continue.

8.1 Self-diagnostic Function
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8.2 What to Do If an Error Occurs

8.2.1 ERR/ALM LED Flashes

■ Situation
A syntax error or self-diagnostic error has occurred. The following shows the procedure when a
positioning error has occurred.

■ Solution

1. Check the error code using the programming tool.
If a PLC error occurs during programming or debugging, the "Status Display" dialog box will
appear automatically.

2. In the case of the positioning operation error, press the [Positioning errors] button.
The channel number where the positioning error has occurred and the error code occurred
when using the table setting mode appears.

3. Press the [Clear Error Log] button.
A confirmation message appears.

8.2 What to Do If an Error Occurs
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4. Press the [Yes] button.
The positioning error log will be cleared.

5. Press the [Close] button.
It returns to the "Status Display" dialog box.

6. Press the [Clear errors] button.
The display of the self-diagnostic error message will be cleared.

7. Correct the positioning parameters or positioning tables according to the positioning error
code confirmed in step 2.

8. Download the corrected positioning parameters or positioning table data.
Error Codes and How to Handle Them

Error code Situation Solution

1 to 9 Syntax error occurs.
● Change to PROG. mode and clear the error.
● Execute a total-check function using FPWIN GR7 to determine

the location of the syntax error and correct the program.

20 or more Self-diagnostic error
occurs.

● Refer to the list of error codes and correct the settings or
programs.

● Use the programming tool in PROG. mode to clear the error.

● In the case of an error code 43 or higher, the error can be cleared by pressing the [Clear
errors] button in the "Status Display" dialog box. In the PROG. mode, the power supply can
be turned off and then on again to clear the error, but all of the contents of the operation
memory except hold type data will be cleared.

● When the positioning error (error code 44) occurs, the detailed information on the error can
be confirmed. Press the [Positioning errors] button to check the error code.

● When an operation error (error code 45) occurs, the address at which the error occurred is
stored in special data registers DT90017 and DT90018. If this happens, click on the
“Operation errors” button in the “Status display dialog box” and confirm the address at
which the error occurred before canceling the error.

● The error can also be cleared using the self-diagnostic error set instruction F148 (ERR).

8.2.2 What to Do When Positioning Error Occurs

The following are the solutions when the self-diagnostic error (error code 44: positioning error)
occurs.

8.2 What to Do If an Error Occurs
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■ Positioning error code

Error
code

Error name Description
Operation when an error
occurs and
solution

10H Limit + signal detection
The input on the plus side of the limit
turned on. (Note 1)

The operation stops in the limit
stop time specified in the axis
setting area.
After the stop, execute the
home return or JOG operation
in the reverse direction.
Correct the setting of the
parameter.

11H Limit - signal detection
The input on the minus side of the limit
turned on. (Note 1)

12H Limit signal error Both inputs on the plus and minus sides of
the limit turned on.

20H Axis setting error The axis setting is incorrect.

Each control operation does
not start. Correct the setting of
the parameter.

21H Limit stop deceleration
time error

The set value of the limit stop deceleration
time is out of the range.

22H Emergency stop
deceleration time error

The set value of the emergency stop
deceleration time is out of the range.

23H Startup speed error The set value of the startup speed is out
of the range.

24H Home return setting code
error

The set value of the home return setting
code is out of the range.

25H Home return target
speed error

The set value of the home return target
speed is out of the range.

26H Home return acceleration
time error

The set value of the home return
acceleration time is out of the range.

27H Home return deceleration
time error

The set value of the home return
deceleration time is out of the range.

28H Home return creep
speed error

The set value of the home return creep
speed is out of the range.

29H Home return direction
error

The set value of the home return direction
is out of the range.

30H JOG operation target
speed error

The set value of the JOG operation target
speed is out of the range.

31H JOG operation
acceleration time error

The set value of the JOG operation
acceleration time is out of the range.

32H JOG operation
deceleration time error

The set value of the JOG operation
deceleration time is out of the range.

41H Table setting error The combination of tables is incorrect.

42H Operation pattern error The set value of the operation pattern is
incorrect.

43H Positioning acceleration
time error

The set value of the positioning
acceleration time is out of the range.

44H Positioning deceleration
time error

The set value of the positioning
deceleration time is out of the range.

45H Positioning target speed
error

The set value of the positioning target
speed is out of the range.

46H Positioning movement
amount error

The set value of the positioning movement
amount is out of the range.

8.2 What to Do If an Error Occurs
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Error
code

Error name Description
Operation when an error
occurs and
solution

47H Dwell time error The set value of the dwell time is out of
the range.

48H J point control setting
error

The J-point control is set on the
interpolation axis table.

60H Repeat operation dwell
time setting error

The dwell time of the E table which
performs repetitive operations is 0 ms.

 

(Note 1) The error occurs only when the condition of the limit stop is satisfied.
 

■ Error code 41: Occurrence condition of table setting error
● The last table of the positioning setting tables is not the E point. (e.g. The P point, C point

and J point are set continuously.)
● The control method of the J-point control table is absolute.
● The tables whose control method is absolute are set repeatedly.
● The opposite pulse output directions (forward/reverse) are set on the consecutive tables of P

+E points.
● Axes to which the interpolation operation setting is made are selected for the F383

simultaneous start instruction.

8.2.3 Motor Does Not Rotate/Move (Output LED Flashes or is ON)

■ Solution 1: For servo motor

Check to make sure the servo on input is set to “ON”.

■ Solution 2

Check to make sure the power supplies for the servo amplifier and motor driver are ON.

■ Solution 3

Check to make sure the servo amplifier and motor driver are connected to the unit correctly.

■ Solution 4

Check to make sure the settings for the pulse output method (CW/CCW method or Pulse/Sign
method) are appropriate.

8.2.4 Motor Does Not Rotate/Move (Output LED is OFF)

■ Solution

Review the program.

8.2 What to Do If an Error Occurs
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Point to check
● Check to make sure the I/O numbers are appropriate.
● Check non-rewriting of the start flag in the program.
● Check the input valid logic of the over limit switch. In this case, the error LED flashes.

8.2.5 Rotation/Movement Direction is Reversed

■

(Reverse direction) (Intended direction)

■ Solution 1

Check to make sure the servo amplifier and motor driver are connected to the unit correctly.

Point to check
Check to make sure the CW/CCW output or the Pulse/Sign output is connected to the pertinent
input of the servo amplifier and motor driver.

■ Solution 2

Change the pulse output rotation direction of the parameters for each axis, and set it to the
reverse direction.

8.2 What to Do If an Error Occurs
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9.1 PWM Output Function

9.1.1 Overview of PWM Output Function

The pulse output of an arbitrary duty ratio can be performed.

■ Comparison of functions and performances

FP0H mode

Channel no. Output no. Control flag

CH0 Y0 R911C

CH1 Y3 R911D

CH2 Y8 R911E

CH3 YB R911F

FPsigma mode

Channel no. Output no. Control flag

CH0 Y0 R903A

CH2 Y3 R903C
 

(Note 1) Functions, channel numbers and I/O numbers used are set in the tool software.
(Note 2) I/O numbers used for each function should be allocated so that they do not overlap.
 

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

9.1.2 System Register Settings

Functions to be used are allocated in the system register settings dialog box. The following
procedure is explained on the condition that the FPWIN GR7 has already started.

1. Select Option>System register settings from the menu bar.

9.1 PWM Output Function
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The "PLC Configuration " dialog box appears.

2. Select "Controller output setting (PLS/PWM)" from the left pane.
The menu for setting "System register no. 402" appears.

3. Change the settings for the channels used for the PWM output.

4. Press the [OK] button.
The screen returns to the ladder edit screen. The settings will be downloaded to the PLC
together with programs and comments.

System register relating to PWM output

Classification No. and setting item Settings

Controller output
settings
(PLS/PWM)

402
Pulse PWM output
setting
(Y0 to YC)

CH0 Set the PWM output (Y0) and normal output
(Y1).

CH1 Set the PWM output (Y3) and normal output
(Y4).

CH2 Set the PWM output (Y8) and normal output
(Y9).

CH3 Set the PWM output (YB) and normal output
(YC).

 

(Note 1) Select "Normal output" for the output that is not used for the pulse output function or PWM output
function.

(Note 2) For the FPsigma mode, the output settings by the system register is not available.
 

9.1.3 [F173 PWMH] PWM Output Instruction (Frequency Specification)

Performs the PWM output according to the set parameters.

9.1 PWM Output Function
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■ Instruction format

■ Operand

Operand Settings

S

Starting address the memory area storing the parameters of the PWM output.

S Specify the control code HFF.

S+1 Specify the output frequency in 2-word 32-bit data.
Setting range: K1 to K100000 (1 Hz to 100 kHz: in 1 Hz increments)S+2

S+3

Duty ratio (Resolution of 1000 or 100)
For the output frequencies 1 to K70000, Setting range: K0 to K1000 (0.0% to 100.0%)
For the output frequencies K70001 to K100000, Setting range: K0 to K1000 (0% to
100%)

n
Channel nos. used for PWM output:
FP0H mode: 0 (CH0: Y0), 1 (CH1: Y3), 2 (CH2: Y8), 3 (CH3: YB)
FPsigma mode: 0 (CH0: Y0), 2 (CH2: Y3)

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● The PWM output is performed form a specified output. The output is performed when the

trigger (execution condition) is on.
● The output frequency and duty ratio is specified in the operands [S1+1] to [S1+3].

■ Precautions during programming
● This instruction cannot be executed when a control flag corresponding to each channel is on.
● The duty may be different from the set ratio according to the load voltage and load current

especially in the vicinity of minimum and maximum values. The duty can be changed for
each scan. However, the control code cannot be changed during the execution of an
instruction.

● When rewriting during RUN is performed during the operation, the PWM output stops while a
program is being rewritten.

9.1 PWM Output Function
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■ Example of program
The following sample shows the program for performing the PWM output with 10 kHz and the
duty ratio of 50% from CH0 (Y0).

● For details of the allocations of I/O and flags, refer to "12.2.3 When Using PWM Output
Function".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

9.1.4 [F173 PWMH] PWM Output Instruction (Control Code Specification)

The PWM output is performed according to the set parameters.

■ Instruction format

■ Operand

Operand Settings

S

Starting address the memory area storing the parameters of the PWM output.

S Specify the control code. K0 to K30

S+1
Duty ratio (Resolution of 1000 or 100)
For the control codes K0 to K27, Setting range: K0 to K1000 (0.0% to 100.0%)
For the control codes K28 to K30, Setting range: K0 to K1000 (0% to 100%)

n Channel nos. used for PWM output:

9.1 PWM Output Function
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Operand Settings
FP0H mode: 0 (CH0: Y0), 1 (CH1: Y3), 2 (CH2: Y8), 3 (CH3: YB)
FPsigma mode: 0 (CH0: Y0), 2 (CH2: Y3)

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

n - - - - - - - - - ● ● -

■ Outline of operation
● The PWM output is performed form a specified output. The output is performed when the

trigger (execution condition) is on.
● The output frequency and cycle are determined by a specified control code. The duty ratio is

specified in the operand [S1+1].

■ Precautions during programming
● This instruction cannot be executed when a control flag corresponding to each channel is on.
● The duty may be different from the set ratio according to the load voltage and load current

especially in the vicinity of minimum and maximum values. The duty can be changed for
each scan. However, the control code cannot be changed during the execution of an
instruction.

● When rewriting during RUN is performed during the operation, the PWM output stops while a
program is being rewritten.

■ Control code

S Frequency
(Hz) Cycle (ms) Resolution S Frequency

(Hz) Cycle (ms) Resolutio
n

K0 1.5 666.67

1000

K16 2000.0 0.50

1000

K1 2.0 500.00 K17 3000.0 0.33

K2 4.0 250.00 K18 6000.0 0.17

K3 6.0 166.67 K19 12500.0 0.08

K4 8.0 125.00 K20 15000.0 0.067

K5 10.0 100.00 K21 20000.0 0.050

K6 20.0 50.00 K22 25000.0 0.040

K7 50.0 20.00 K23 30000.0 0.033

K8 100.0 10.00 K24 40000.0 0.025

K9 200.0 5.00 K25 50000.0 0.020

K10 400.0 2.50 K26 60000.0 0.017

K11 500.0 2.00 K27 70000.0 0.0143

K12 700.0 1.48 K28 80000.0 0.0125
100

K13 1000.0 1.00 K29 90000.0 0.0111

9.1 PWM Output Function
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S Frequency
(Hz) Cycle (ms) Resolution S Frequency

(Hz) Cycle (ms) Resolutio
n

K14 1300.0 0.77 K30 100000.0 0.010

K15 1600.0 0.625 -

■ Example of program
The following sample shows the program for performing the PWM output with 1kHz and the
duty ratio of 50% from CH0 (Y0).

● For details of the allocations of I/O and flags, refer to "12.2.3 When Using PWM Output
Function".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

9.1 PWM Output Function
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10.1 Overview of High-speed Counter Function

10.1.1 Overview of High-speed Counter Function

● This function allows the counting of input signals from external devices at high speed such
as a sensor and encoder.

● Exclusive instructions (F166 and F167) are provided for turning on or off arbitrary outputs (Y0
to Y1F) in the interrupt processing when the elapsed value matches the target value. The
output turned ON/OFF by an instruction is used by presetting with an instruction such as the
SET/RET instructions. The instruction (F165) which enables the cam output up to 32 points
to be acquired according to the elapsed value.

● Channels and inputs to be used are specified by system registers. The output when the
values match is specified by the operand of the instruction.

10.1.2 Counting Range and Elapsed Value (Current Value) Area

● The elapsed value of the high-speed counter is stored in a special data register as 2-word
32-bit data.

● The elapsed value area will be reset when the power supply turns off. It will be held when
switching the mode from RUN to PROG.

● The high-speed counter is a ring counter. When the counted value exceeds the maximum
value, it returns to the minimum value. When the counted value exceeds the minimum value,
it returns to the maximum value.

10.1 Overview of High-speed Counter Function
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■ Counting range of elapsed value (current value) area

Section Range

High-speed counter
control K–2,147,483,648 to K2,147,483,647

10.1.3 Areas Used For High-speed Counter Function

The usable combinations vary according to the unit type.

■ List of used areas

FP0H mode

Channel
no.

Input no.
Control flag Elapsed value area Target value areaSingle-

phase
2-phase

CH0 X0 X0, X1 R9110
DT90300
DT90301

DT90302
DT90303

CH1 X1 - R9111
DT90302
DT90303

DT90306
DT90307

CH2 X3 X3, X4 R9112
DT90308
DT90309

DT90310
DT90311

CH3 X4 - R9113
DT90312
DT90313

DT90314
DT90315

FPsigma mode

Channel
no.

Input no.
Control flag Elapsed value area Target value areaSingle-

phase
2-phase

CH0 X0 X0, X1 R903A
DT90044
DT90045

DT90046
DT90047

10.1 Overview of High-speed Counter Function
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Channel
no.

Input no.
Control flag Elapsed value area Target value areaSingle-

phase
2-phase

CH1 X1 - R903B
DT90048
DT90049

DT90050
DT90051

CH2 X3 X3, X4 R903C
DT90200
DT90201

DT90202
DT90203

CH3 X4 - R903D
DT90204
DT90205

DT90206
DT90207

 

(Note 1) Functions, channel numbers and I/O numbers used are set in the tool software.
(Note 2) I/O numbers used for each function should be allocated so that they do not overlap. Refer to

"1.2 Restrictions on Combinations and Functions".
 

● For details of the FP mode, refer to "11 FPsigma Mode".

10.1.4 Input Mode Type

■ Input Modes and Count Operations

Mode Range

Addition input

Subtraction input

10.1 Overview of High-speed Counter Function
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Mode Range

2-phase input

Individual input

Direction distinction
input

10.1.5 Minimum Input Pulse Width

For the period T, the following minimum input pulse width is required.

10.1 Overview of High-speed Counter Function
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■ Min. input pulse width

Single-phase input 2-phase input

10.1 Overview of High-speed Counter Function
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10.2 System Register Settings

10.2.1 System Register Settings

Functions to be used are allocated in the system register settings dialog box. The following
procedure is explained on the condition that the FPWIN GR7 has already started.

1. Select Options>System register settings from the menu bar.
The "PLC Configuration " dialog box appears.

2. Select "Controller input setting (HSC/PLS)" from the left pane.
The menu for setting "System register no. 400 or 401" appears.

3. Change the settings for the channels used for the high-speed counter.
The following figure shows the case when 2-phase input (X0, X1) is allocated to CH0.

4. Press the [OK] button.
The screen returns to the ladder edit screen. The settings will be downloaded to the PLC
together with programs and comments.

System register relating to high-speed counter output

Classification No. and setting item Settings

Controller input settings
(HSC/PLS)

400
HSC
operation mode
setting
(X0 to X2)

CH0

Not set X0 as High-speed counter
2-phase input (X0, X1)
2-phase input (X0, X1) Reset input (X2)
Addition input (X0)
Addition input (X0) Reset input (X2)

10.2 System Register Settings
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Classification No. and setting item Settings
Subtraction input (X0)
Subtraction input (X0) Reset input (X2)
Individual input (X0, X1)
Individual input (X0, X1) Reset input (X2)
Direction distinction (X0, X1)
Direction distinction (X0, X1) Reset input (X2)
J-point positioning start input of pulse output CH0
(X0)

CH1

Not set X1 as High-speed counter
Addition input (X1)
Addition input (X1) Reset input (X2)
Subtraction input (X1)
Subtraction input (X1) Reset input (X2
J-point positioning start input of pulse output CH1
(X1)

401
HSC
operation mode
setting
(X3 to X5)

CH2

Not set X3 as High-speed counter
2-phase input (X3, X4)
2-phase input (X3, X4) Reset input (X5)
Addition input (X3)
Addition input (X3) Reset input (X5)
Subtraction input (X3)
Subtraction input (X3) Reset input (X5)
Individual input (X3, X4)
Individual input (X3, X4) Reset input (X5)
Direction distinction (X3, X4)
Direction distinction (X3, X4) Reset input (X5)
J-point positioning start input of pulse output CH2
(X3)

CH3

Not set X4 as High-speed counter
Addition input (X4)
Addition input (X4) Reset input (X5)
Subtraction input (X4)
Subtraction input (X4) Reset input (X5)
J-point positioning start input of pulse output CH3
(X4)

 

(Note 1) Displayed item names and ranges vary according to the types of control unit.
(Note 2) Select "Not set XX as High Speed Counter" for the input that is not used for the high-speed

counter function.
 

10.2 System Register Settings
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10.3 High-speed Counter Instruction

10.3.1 [F0 MV] High-speed Counter Control Instruction

Performs the controls such as the software reset, disabling the count and clearing the high-
speed counter instruction.

■ Instruction format

■ Operand

Operand Settings

S Area storing the control code of the high-speed counter or constant data

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S ● ● ● ● ● ● ● ● ● ● ● ●

■ Outline of operation
● Performs the high-speed counter control according to the control code specified by [S].
● This instruction is used when performing the following operations with the high-speed

counter.
1. When performing the software reset
2. When disabling the count
3. When disabling the reset input by an external input temporarily
4. When canceling the control executed by the high-speed counter instruction F165

(CAM0) / F166 (HC1S) / F167 (HC1R), when clearing the target value match interrupt
● The control codes once written are held until the next writing.
● The control code written by the F0 (MV) instruction is written to the special data register

DT90052. At the same time, it is written to the control code monitor area. The written data is
the data for lower 8 bits only.

■ Precautions during programming
● The setting of disabling the rest input is valid only when allocating the reset input in the

system register.
● In the external reset input setting, the reset input (X2 or X5) allocated to the internal input is

switched between enable and disable.

10.3 High-speed Counter Instruction
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■ Allocation of control codes
● The following bits are allocated according to the specified channel and functions.

FP0H mode FPsigma mode

● When controlling the above functions using external inputs, arbitrary inputs can be allocated.

■ Example of program
The following example shows the program for performing the software reset of the high-speed
counter CH0 using the input X7.

● For details of the allocations of I/O and flags, refer to "12.2.4 When Using High-speed Counter
Function".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

10.3.2 [F1 DMV] Elapsed Value Write / Read Instruction

Writes and reads the elapsed value of the high-speed counter.

10.3 High-speed Counter Instruction
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■ Instruction format

■ Operand

Operand Settings

S
When setting: Area storing the elapsed value (32-bit) set in the high-speed counter or constant
data
K−2,147,483,648 to K2,147,483,647

D When reading: Area reading the elapsed value of the high-speed counter

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S ● ● ● ● ● ● ● ● ● ● ● ●

D - ● ● ● ● ● ● ● ● - - ●

■ Outline of operation (Reading elapsed value)
● Reads the content of the special data register storing the elapsed value of the high-speed

counter and writes to the area specified by [D].

■ Outline of operation (Setting elapsed value)
● At the same time as writing the value to the elapsed value area of the high-speed counter

which uses 32-bit data specified by [S], sets it in the elapsed value area of the high-speed
counter used within the system.

■ Precautions during programming
● Only F1 (DMV) instruction can perform the writing. The writing cannot be performed by other

high-level instructions such as transfer instruction F0 (MV) and arithmetic instructions.
● Specify the memory area of [S] or [D] with the memory area number for the lower 16 bits.

● For details of the allocations of I/O and flags, refer to "12.2.4 When Using High-speed Counter
Function".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

10.3 High-speed Counter Instruction
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10.3.3 [F166 HC1S] High-speed Counter Target Value Match ON Instruction
[F167 HC1R] High-speed Counter Target Value Match OFF Instruction

Turns on or off the specified output when the elapsed value of the high-speed counter matches
the target value set by the operand.

■ Instruction format

■ Operand

Operand Settings

n Target channel number of the high-speed counter for the match output

S Target value data of the high-speed counter or the starting number of the area storing data

D Output coil which turns on or off when the values match (Y0 to Y1F)

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

n - - - - - - - - - ● ● -

S ● ● ● ● ● ● ● ● ● ● ● ●

D - - - - - - - - - - - -

■ Outline of operation
● Sets the value specified by [S] as the target value of the high-speed counter, and controls the

specified output [Yn] when the elapsed value matches the target value. This operation is
executed as an interrupt processing.

● In the case of [F166 HC1S] instruction, the output turns on from off. In the case of [F167
HC1R] instruction, the output turns off from on.

● Stores the value of [S] in the target value area when the instruction is executed.
● Clears the setting of the target value and the control of the target value match output when

the value matches the target value.
● For resetting the output turned ON/OFF when the values match, use the RST instruction or

F0 (MV) instruction, or use the F166 (HC1R) instruction and F167 (HC1R) instruction in a
pair.

■ Example of program
The following example shows the program for setting the output Y0 when the elapsed value of
the high-speed counter CH0 matches K10000.

10.3 High-speed Counter Instruction
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■ Precautions during programming
● The high-speed counter control flag turns on until the value matches the target value after

the execution condition of the instruction has turned on. During this processing, the high-
speed counter instruction F165 (CAM0)/F166 (HC1S)/F167 (HC1R) cannot be executed for
the high-speed counter of the same channel.

● When the hardware reset is performed before the elapsed value matches the target value,
the elapsed value will be reset. However, the settings of the target value and the target value
match output will not be cleared.

● For the output Y specified for the target value match output, it is not checked whether the
output is overlapped with the OT, KP and other high-level instructions.

● When describing the same channel in both the normal program and the interrupt program, be
sure to program not to execute them simultaneously.

● For details of the allocations of I/O and flags, refer to "12.2.4 When Using High-speed Counter
Function".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

10.3.4 Sample Program (Positioning Operation With Inverter: First Speed)

Counts the feedback signals from the encoder with the high-speed counter. The operation of
the inverter stops when the count value reaches 5000.

10.3 High-speed Counter Instruction
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■ Wiring example

■ Operation chart

■ I/O allocation table

I/O no. Description I/O no. Description

X0 Encoder input R100 Positioning operation is running.

X5 Operation start signal R101 Positioning operation start.

Y0 Inverter operation signal R102 Positioning done pulse

- R9110 High-speed counter CH0 control flag

10.3 High-speed Counter Instruction
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■ Sample program

For FP0H mode

(1) Positioning operation is running.

(2) Positioning operation starts.

(3) Resets the elapsed value of the high-speed counter CH0.

(4) Target value match OFF instruction: Y0 turns off when the elapsed value of the high-speed counter
reaches 5000 pulses.

(5) Sets the inverter operation signal Y0.

(6) Positioning done pulse (0.5 sec)

(7) Sets 0.5 sec with 0.1-second timer.
 

(Note 1) The allocations of control active flags and elapsed value areas for the FPsigma mode are different.
For details of the allocation of flags, refer to "12.2.4 When Using High-speed Counter Function".

 

10.3.5 Sample Program (Positioning Operation With Inverter: Second Speed)

Counts the feedback signals from the encoder with the high-speed counter. Switches the
inverter operation to low speed operation when the count value reaches 4500. The operation of
the inverter stops when the count value reaches 5000.

10.3 High-speed Counter Instruction
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■ Wiring example

■ Operation chart

■ I/O allocation table

I/O no. Description I/O no. Description

X0 Encoder input R100 Positioning operation is running.

X5 Operation start signal R101 Arrival at deceleration point

Y0 Inverter operation signal R102 Positioning operation starts.

Y1 Inverter high-speed signal R103 Positioning done pulse

- R900C Comparison instruction < Flag

10.3 High-speed Counter Instruction
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■ Sample program

For FP0H mode

(1) Positioning operation is running.

(2) Positioning operation starts.

(3) Resets the elapsed value of the high-speed counter CH0.

(4) Target value match OFF instruction: Y0 turns off when the elapsed value of the high-speed counter
CH0 reaches 5000 pulses.

(5) Sets Y0 (inverter operation signal).

(6) Sets Y1 (inverter high-speed signal).

(7) 32-bit data comparison instruction: R900C turns on when the elapsed value of the high-speed counter
CH0 is larger than 4500 pulses.

(8) Arrival at deceleration point

(9) Resets Y1 (inverter high-speed signal).

(10) Positioning done pulse (0.5 sec)

(11) 0.1-second timer: Sets K5. It is used as 0.5-second timer.
 

(Note 1) The allocations of control active flags and elapsed value areas for the FPsigma mode are different.
For details of the allocation of flags, refer to "12.2.4 When Using High-speed Counter Function".
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10.4 High-speed Counter Cam Control Instruction

10.4.1 [F165 CAM0] High-speed Counter Cam Control Instruction

Performs the cam output up to a maximum of 32 points (ON/OFF) according to the elapsed
value of the high-speed counter.

■ Instruction format

■ Operand

Operand Settings

S Starting number of data table

■ Memory area type that can be specified

Operand WX WY WR WL SV EV DT LD I
Constant Index

modifierK H

S - - - - - - ● - - - - ●

■ Outline of operation
● Performs the cam output up to a maximum of 32 points (ON/OFF) according to the elapsed

value of the high-speed counter in the pattern specified for the data table starting with [S].
The output device can be selected from internal relay, output relay and link relay.

● The ON set value and OFF set value can be arbitrarily specified as a paired target values for
a single cam output regardless of the magnitude of target values or the order for one cam
output. The pattern of ON/OFF varies according to the setting.

10.4 High-speed Counter Cam Control Instruction
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Elapsed
value

12000 0

1000 to 4999
R100:ON

7000 to 8999
R101:ON

Target value 1
ON set value
1000

Target value 2
OFF set value

9000

Target value 2
ON set value

7000

Target value 1
OFF set value
5000

■ Upper limit control
With the F165 (CAM0) instruction, the control with a specified upper limit can be performed.
The settings for enabling/disabling the upper limit control and the upper limit are specified in the
data table.

Upper limit control: Enable Upper limit control: Disable

Counting range 0 to Upper limit Negative min. value to Positive max.
value

Operation
when
exceeding the
counting range

When
added

When the elapsed value exceeds the
upper limit, it returns to 0.

When the elapsed value exceeds the
positive maximum value, it returns to the
negative minimum value.

When
subtracte
d

When the elapsed value falls below 0, it
returns to the upper limit.

When the elapsed value falls below the
negative minimum value, it returns to the
positive maximum value.

■ Data table settings

Operand Settings Description

S, S+1

High-speed counter
channel
Upper and lower limit
control

Specify the high-speed counter channel where the cam control is
performed and whether or not to execute the upper and lower limit
control as a hexadecimal constant.

H

Channel specification

0 0 0 0 0 0

H0 to H3: CH0 to CH3

H00: Fixed

Upper limit control 0: Disable , 1: Enable

H0000: Fixed

S+2, S+3
Output device type
(Note 1)

Specify the device type set for the cam output.
H0: Link relay (L), H1: Internal relay (R), H2: Output relay (Y)

10.4 High-speed Counter Cam Control Instruction
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Operand Settings Description

S+4, S+5
Starting word no. of
output device

Specify the starting word number of the device set for the cam
output. (Note 2)

S+6, S+7 No. of target values Settable range: K1 to K32 (Note 2)

S+8, S+9 Target value 1: ON set
value

Set the ON set value and OFF set value according to the number of
target values.
(Note 3)

Settable range:
K-2147483647 to K2147483646 (H80000001 to H7FFFFFFE)
The cam output described in the next page is acquired according to
the magnitude of the ON set values and elapsed value.

S+10, S+11 Target value 1: OFF set
value

S+12, S+13 Target value 2: ON set
value

S+14, S+15 Target value 2: OFF set
value

------ ------

S+(m-1)x4+8
S+(m-1)x4+9

Target value m: ON set
value

S+(m-1)x4+10
S+(m-1)x4+11

Target value m: OFF
set value

S+(m-1)x4+12
S+(m-1)x4+13 Upper limit (Note 4) Settable range:

K1 to K2147483646 (H1 to H7FFFFFFE)
 

(Note 1) When specifying the output relay (Y), values are also output to the CPU output as well as operation
memories.

(Note 2) When the number of target values [S+6, S+7] is set to 1-16, the cam output is allocated to one word of
output device. When set to 17-32, it is allocated to two words of output device. Refer to the next page
for details.

(Note 3) The number of target values specified after [S+8, S+9] varies according to the number of target values
specified in [S+6, S+7].

(Note 4) The upper limit of the data table end is valid only when the upper limit control is set to "Yes" in [S, S
+1]. This setting can be omitted when the upper limit control is set to "No".

(Note 5) The data table varies in the range of 12 to 138 words according to the number of target values and the
specified upper limit setting.

 

■ Specification of output device: [S+2] to [S+5]
● When the number of target values is set to 1-16, one word is used. When the number of

target values is set to 17-32, two words are used.
● One device is allocated to a paired target values (ON set value and OFF set value).

(Example): When the output device type is set to "Internal relay", the starting word number
of output device is set to "0", and the number of target values is set to "32", R0 to R1F are
allocated as the device for the cam output.

10.4 High-speed Counter Cam Control Instruction
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(1) When the elapsed value reaches the target value 1, R0 turns on or off.

(2) When the elapsed value reaches the target value 16, RF turns on or off.

(3) When the elapsed value reaches the target value 18, R11 turns on or off.

■ Specification of target values: From [S+8]
The acquired output varies according to the ON set value and OFF set value.

ON set value < OFF set value ON set value > OFF set value ON set value = OFF set value

W
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When the elapsed value is larger
than or equal to the ON set value
and smaller than the OFF set
value, the corresponding output
bit turns on. When the elapsed
value is out of the range, the
corresponding bit turns off.

When the elapsed value is
smaller than the ON set value
and larger than or equal to the
OFF set value, the corresponding
output bit turns off. When the
elapsed value is out of the range,
the corresponding bit turns on.

When the elapsed value is out of
the range, the corresponding bit
turns off.

■ Precautions during programming
● This instruction cannot be used when the high-speed counter function is not used. Allocate

arbitrary channels and contacts in the system register "high-speed counter setting".
● The high-speed counter control flag corresponding to the specified channel turns on until the

execution of the high-speed counter control instruction F0 (MV) is cleared after the execution
condition of the F165 (CAM0) instruction has turned on. When the high-speed counter
control flag is on, the high-speed counter control instruction F165 (CAM0)/F166 (HC1S)/
F167 (HC1R) for which the same channel is specified cannot be executed.

● This instruction can be activated for up to two channels simultaneously.
● To stop the control of this instruction, execute "Clear high-speed counter instruction" by the

high-speed counter control instruction F0 (MV). Even when executing "Clear high-speed
counter instruction", the output allocated to the cam output is held. Also, the counting of the
high-speed counter continues and the upper limit control becomes disabled.

● Reset or preset the high-speed counter elapsed value before activating the instruction.
● Do not rewrite the elapsed value for the control using the F1 (DMV) instruction after the

execution of the instruction. After the execution of the instruction, the setting of the active
target values do not change even if the operation memory of the specified target values (ON
set value/OFF set value) is changed.

10.4 High-speed Counter Cam Control Instruction
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● When controlling the output device using the main program, set each target value so that
"minimum moving time between each target value" is larger than "1 scan time".

● When controlling the output device using an interrupt program, set each target value so that
"minimum moving time between each target value" is larger than "maximum execution time
of interrupt program".

● When the maximum value control and the hardware/software reset is used at the same time,
do not operate them intensively in a short time.

● When hardware/software reset is used, set the minimum target value to an integer value that
is 1 or more.

● When the hardware reset or software reset is executed during the high-speed counter
control, the high-speed counter elapsed value is reset to 0. The output allocated to the cam
output will be the output according to the elapsed value 0.

● It is also possible to start the interrupt program INTn every time the elapsed value reaches
each target value. For this operation, the activation of the interrupt program should be
permitted by the interrupt control instruction ICTL.

● For details of the allocations of I/O and flags, refer to "12.2.4 When Using High-speed Counter
Function".

● For details of the FPsigma mode, refer to "11 FPsigma Mode".

10.4.2 Sample Program (Upper Limit Control, Reset, Addition)

The following shows the program for performing two cam outputs (R100, R101) according to
the elapsed value of the high-speed counter CH0. When the elapsed value reaches the target
value (ON set value), the cam output turns on, and when it reaches the target value (OFF set
value), it turns off. When it reaches the target value (ON set value), the interrupt program is
started. When the elapsed value exceeds the upper limit, it returns to 0.

Code Value Description

(a) Upper limit When the elapsed value exceeds the upper limit, it returns to 0.

10.4 High-speed Counter Cam Control Instruction
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Code Value Description

(b) Target value 2: OFF
set value The cam output is performed according to the target values.

In this example, the ON set value is smaller than the OFF set value for each
target value.
Therefore, When added: When the elapsed value reaches the ON set value,
the cam output turns ON, and when it reaches the OFF set value, it turns
OFF.
When subtracted: When the elapsed value falls below the OFF set value, the
cam output turns ON, and when it falls below the ON set value, it turns OFF.

(c) Target value 2: ON set
value

(d) Target value 1: OFF
set value

(e) Target value 1: ON set
value

(1) Execution condition When the execution condition turns ON from OFF, the instruction is executed
and the cam control starts.

(2)
High-speed counter
instruction active flag

The high-speed counter instruction active flag turns ON during the execution
of the instruction. Even when the reset signal exists, the execution of the
instruction continues.

(3) Cam output The output turns ON/OFF according the set values.

(4) Interrupt When the elapsed value reaches the ON set value, the interrupt program
starts.

(5) Reset signal
When the hardware reset (X2) or software reset DT90052 (bit 0) turns ON,
the elapsed value of the high-speed counter is rest to 0. The outputs
corresponding to the elapsed value 0 whitch both R100 and R101 become
OFF in the above example.

 

(Note 1) It shows the hardware reset input (X2) for the high-speed counter CH0.
 

■ Sample program
For FP0H mode

Code Description

(1) High-speed counter channel H10: Performs the upper limit control. CH0

(2) Cam output device type K1: Internal relay (R)

(3) Word number of cam output device K10

10.4 High-speed Counter Cam Control Instruction
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Code Description

(4) Specification of the number of target values K2

(5) Target value 1: ON set value K1000

(6) Target value 1: OFF set value K5000

(7) Target value 2: ON set value K7000

(8) Target value 2: OFF set value K9000

(9) Upper limit value K11000

(10) Presets 0 as the elapsed value.

(11) Executes the F165 (CAM0) instruction and starts the cam control.
 

(Note 1) The allocations of control active flags and elapsed value areas for the FPsigma mode are different.
For details of the allocation of flags, refer to "12.2.4 When Using High-speed Counter Function".

 

10.4.3 Sample Program (Upper Limit Control, Instruction Clear, Addition)

The following shows the program for performing two cam outputs (R100, R101) according to
the elapsed value of the high-speed counter CH0. In the case of addition, when the elapsed
value reaches the target value (ON set value), the cam output turns on, and when it reaches the
target value (OFF set value), it turns off. When it reaches the target value (ON set value), the
interrupt program is started. When the elapsed value exceeds the upper limit, it returns to 0.
The instruction is cleared by the high-speed counter control instruction F0 (MV).

Code Value Description

(a) Positive maximum
value

When the instruction clear is executed, the upper limit control is canceled and
the counting continues up to the positive maximum value.

(b) Upper limit When the elapsed value exceeds the upper limit, it returns to 0.

(c) Target value 2: OFF
set value

The cam output is performed according to the target values.
In this example, the ON set value is smaller than the OFF set value for each
target value. Therefore,

10.4 High-speed Counter Cam Control Instruction
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Code Value Description

(d)
When added: When the elapsed value reaches the ON set value, the cam
output turns ON, and when it reaches the OFF set value, it turns OFF.
When subtracted: When the elapsed value falls below the OFF set value, the
cam output turns ON, and when it falls below the ON set value, it turns OFF.

Target value 2: ON set
value

(e) Target value 1: OFF
set value

(f) Target value 1: ON set
value

(1) Execution condition When the execution condition turns ON from OFF, the instruction is executed
and the cam control starts.

(2)
High-speed counter
instruction
active flag

The high-speed counter instruction active flag turns ON during the execution
of the instruction. When the high-speed counter control instruction F0 (MV) is
executed, it turns OFF.

(3) Cam output The output turns ON/OFF according the set values.

(4) Interrupt In the case of addition, when the elapsed value reaches the ON set value,
the interrupt program is started.

(5)
Clear high-speed
counter instruction

By the high-speed counter control instruction F0 (MV), when the bit 3 of the
special data register DT90052 turns ON from OFF, the executed F165
(CAM0) instruction is cleared.

■ Sample program
For FP0H mode

Code Description

(1) High-speed counter channel H10: Performs the upper limit control. CH0

(2) Cam output device type K1: Internal relay (R)

(3) Word number of cam output device K10

10.4 High-speed Counter Cam Control Instruction
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Code Description

(4) Specification of the number of target values K2

(5) Target value 1: ON set value K1000

(6) Target value 1: OFF set value K5000

(7) Target value 2: ON set value K7000

(8) Target value 2: OFF set value K9000

(9) Upper limit value K11000

(10) Presets 0 as the elapsed value.

(11) Executes the F165 (CAM0) instruction and starts the cam control.

(12) Clears the executed F165 (CAM0) instruction by turning the DT90052 (bit 3) off -> on -> off.
 

(Note 1) The allocations of control active flags and elapsed value areas for the FPsigma mode are different.
For details of the allocation of flags, refer to "12.2.4 When Using High-speed Counter Function".

 

10.4.4 Sample Program (Upper Limit Control, Subtraction)

The following shows the program for performing three cam outputs (R100-R102) according to
the elapsed value of the high-speed counter CH0. In the case of subtraction, when the elapsed
value falls below the target value (OFF set value), the cam output turns off, and when it falls
below the target value (ON set value) the cam output turns on. When it falls below the target
value (OFF set value), the interrupt program is started. When the elapsed value falls below 0, it
returns to the upper limit.

Code Value Description

(a) Upper limit When the elapsed value falls below 0, it returns to the upper limit.

(b) Elapsed value The control is started from the elapsed value when executed. In this example,
the elapsed value 13000 is preset.

10.4 High-speed Counter Cam Control Instruction
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Code Value Description

(c) Target value 3: OFF
set value

The cam output is performed according to the target values.
In this example, the ON set value is smaller than the OFF set value for each
target value. Therefore,
When subtracted: When the elapsed value falls below the OFF set value, the
cam output turns ON, and when it falls below the ON set value, it turns OFF.
When added: When the elapsed value reaches the ON set value, the cam
output turns ON, and when it reaches the OFF set value, it turns OFF.

(d) Target value 2: OFF
set value

(e) Target value 1: OFF
set value

(f) Target value 3: ON set
value

(g) Target value 2: ON set
value

(h) Target value 1: ON set
value

(1) Execution condition When the execution condition turns ON from OFF, the instruction is executed
and the cam control starts.

(2)
High-speed counter
instruction
active flag

The high-speed counter instruction active flag turns ON during the execution
of the instruction.

(3) Cam output The output turns ON/OFF according the set values.

(4) Interrupt program
activation

In the case of subtraction, when the elapsed value falls below the OFF set
value, the interrupt program is started.

■ Sample program
For FP0H mode

Code Description

(1) High-speed counter channel H10: Performs the upper limit control. CH0

10.4 High-speed Counter Cam Control Instruction
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Code Description

(2) Cam output device type K1: Internal relay (R)

(3) Word number of cam output device K10

(4) Specification of the number of target values K3

(5) Target value 1: ON set value K1000

(6) Target value 1: OFF set value K7000

(7) Target value 2: ON set value K3000

(8) Target value 2: OFF set value K9000

(9) Target value 3: ON set value K5000

(10) Target value 3: OFF set value K11000

(11) Upper limit value K15000

(12) Presets 13000 as the elapsed value.

(13) Executes the F165 (CAM0) instruction and starts the cam control.
 

(Note 1) The allocations of control active flags and elapsed value areas for the FPsigma mode are different.
For details of the allocation of flags, refer to "12.2.4 When Using High-speed Counter Function".
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10.5 Interrupt Program Activation

10.5.1 Overview of Function

When the elapsed value reaches the target value while the high-speed counter instruction F165
(CAM0)/F166 (HC1S)/F167 (HC1R) is being executed, the interrupt program can be activated.

■ Execution method
● Make the setting for the high-speed counter by system registers. There is no need to make

the setting of interrupt input.
● Describe the interrupt program as a sub program.
● Allow the execution of a corresponding interrupt program number by the ICTL instruction in

the main program.
● Execute the F165 (CAM0)/F166 (HC1S)/F167 (HC1R) instruction. When the elapsed value

of the high-speed counter reaches the target value, the interrupt program is activated.
For FP0H mode

(   ED   )
( INT   0 )

(  I RET  )
INT0 Program

F166 HC1S instruction
Target value match ON
R9110: CH0 control flag
K0: CH0 specified
K10000: Target value
Y2: Match output set

ICTL instruction
INT0 program
execution enabled

R0
H0ICTL H1

R1
K10000K0F166 HC1S Y2（（ ））DF

R9110

■ Corresponding channel numbers and interrupt program numbers

Channel No. INT number

CH0 INT0

CH1 INT1

CH2 INT3

CH3 INT4
 

(Note 1) The allocations of control active flags and elapsed value areas for the FPsigma mode are different.
For details of the allocation of flags, refer to "12.2.4 When Using High-speed Counter Function".

 

10.5.2 Interrupt Activation When F165 (CAM0) is Executed

For the cam control instruction F165 (CAM0), the start condition varies according to the
magnitude of the ON set value and OFF set value. Also, the interrupt program is activated with
each target value of up to 32 points.

10.5 Interrupt Program Activation
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■ Activation of interrupt program

ON set value < OFF set value ON set value > OFF set value ON set value = OFF set value
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n When the elapsed value is larger

than or equal to the ON set value
and smaller than the OFF set
value, the interrupt program is
activated.

When the elapsed value is smaller
than the ON set value and larger
than or equal to the OFF set value,
the interrupt program is activated.

When the elapsed value
reaches the ON set value (=
OFF set value), the interrupt
program is activated.
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11.1 Overview of FPsigma Mode

FPsigma mode is a mode for using projects for the existing model FPsigma series in FP0H.
Although some functions of FP0H are limited, compatibility with FPsigma is maintained.

■ Comparison of specifications

Item

Specifications

Conventional model
FPsigma series

FP0H series

FPsigma mode
FP0H mode
Values in [ ] are for C32E
only.

Program capacity(Note 1) 32K steps 24K / 32K steps 24K / 32K / [40K / 64K] steps

Data register capacity(Note 1) 32765 words 65533 /32765 words 65533 / 32765 / [24573 /
12285］ words

Automatic backup
in case of power
outage
(Note 2)

Internal
relay

R2480 to R255F
(Fixed)

R2480 to R255F
(Fixed)

R5040 to R511F [R2480 to
R255F]

Data
register

DT32710 to DT32764
(Fixed)

DT32710 to DT32764
(Fixed)

[DT11970 to DT12284
DT24258 to DT24572]
DT32450 to DT32764
DT65218 to DT65532

Pulse/PWM output setting
(System register no. 402) No setting Cannot be set. Can be set.

Positioning control mode
(System register no. 407) Cannot be set.

FPsigma compatible
instruction mode
(Fixed)

Select from table setting
mode or FPsigma compatible
instruction mode.

Value when
system registers
are initialized

No.7 248 (Fixed) 248 (Fixed)
[C32] Initialize according to
system register no. 1.
[C32E] 504 (Fixed)

No.8 32710 (Fixed) 32710 (Fixed) Initialize according to system
register no. 0.

No.407 Cannot be set. FPsigma compatible
instruction mode Table setting mode

No.430
to
No.433

Cannot be set. No setting 1 ms

 

(Note 1) The program capacity and data register capacity can be changed according to the setting of system
register no. 0.

(Note 2) In the FP0H mode, the automatic backup areas for internal relays and data registers vary according to
the settings of system register nos. 0 and 1.

 

Item

Specifications

Conventional model
FPsigma series

FP0H series

FPsigma mode
FP0H mode
Values in [ ] are for C32E
only.

Potentiometer input
(DT90040/90041) K0 to K1000 K0 to K1000 (C32

only) K0 to K4000 (C32 only)

11.1 Overview of FPsigma Mode
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Item

Specifications

Conventional model
FPsigma series

FP0H series

FPsigma mode
FP0H mode
Values in [ ] are for C32E
only.

High-speed counter/Pulse
output(Note 1)

4 ch / 2 ch
High-speed counter
and pulse output share
the same memory area

4 ch / 2 ch
High-speed counter
and pulse output share
the same memory area

4 ch / 4 ch
High-speed counter and
pulse output use independent
memory areas

 

(Note 1) for the details of the high-speed counter/pulse output functions, refer to FP0H User's Manual
(Positioning/PWM Output/High-speed Counter).
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11.2 Converting Projects for FPsigma to Projects for FP0H (FPsigma
Mode)

Projects for the conventional model FPsigma can be converted to projects for FP0H (FPsigma
mode) by the "Convert PLC Type" function. The following procedure is explained on the
condition that a project for FPsigma has been already started on FPWIN GR7.

1. Select Tools>Convert PLC Type in the menu bar.

2. Select "FP0H" from the list on the left.

3. Select "FP0H C32T/P" or "FP0H C32ET/EP" and press the [OK] button.

4. The "Convert PLC Type" function will be executed and the project for FPsigma will be
converted to the project for FP0H.

● Whether the project file is in FP0H mode or FPsigma mode can be confirmed by using
system register no. 3 "Compatible mode setting".

● For details of how to confirm this, refer to "11.3 Converting Projects for FP0H (FPsigma
Mode) to Projects for FP0H (FP0H Mode)".

11.2 Converting Projects for FPsigma to Projects for FP0H (FPsigma Mode)
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11.3 Converting Projects for FP0H (FPsigma Mode) to Projects for
FP0H (FP0H Mode)

Projects for FP0H (FPsigma mode) can be converted to projects for FP0H (FP0H mode) by
setting the system register number 3. The following procedure is explained on the condition that
a project for FP0H (FPsigma mode) has been already started on FPWIN GR7.

● Please change the system registers number 3 offline.

1. Select Options>System register settings from the menu bar.

2. Select "Compatible mode" from the list on the left.

3. Change "No.3 Compatible mode setting" to "FP0H mode" and press the [OK] button.

4. Select Online>Download to PLC (Entire Project) from the menu bar.

11.3 Converting Projects for FP0H (FPsigma Mode) to Projects for FP0H
(FP0H Mode)
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11.4 Differences in Positioning Instructions with FPsigma

11.4.1 High-speed Counter/Pulse Output Control Instruction F0(MV)

For the FPsigma mode, the following contents are common to FPsigma.
- Control code monitor area
- Allocation of control codes

■ Control code monitor area

Channel no.
Conventional model
FPsigma series

FP0H series

FPsigma mode FP0H mode

CH0 DT90190 DT90190 DT90380

CH1 DT90191 DT90191 DT90381

CH2 DT90192 DT90192 DT90382

CH3 DT90193 DT90193 DT90383

■ Allocation of control codes

Conventional model FPsigma and FP0H series (FPsigma mode)

High-speed counter control Pulse output control

FP0H series (FP0H mode)

High-speed counter control Pulse output control

11.4 Differences in Positioning Instructions with FPsigma
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11.4.2 High-speed Counter Instructions F165 (CAM0), F166 (HC1S), F167
(HC1R)

For the FPsigma mode, the following contents are common to FPsigma.
- Operations when instructions are executed
- Allocation of memory areas

■ Operations when instructions are executed
In the FP0H mode, operations vary according to the system register no. 402 "Pulse/PWM
output settings".

Instruction
Conventional model
FPsigma series

FP0H series

FPsigma mode FP0H mode

F165(CAM0) No instruction No system register
setting

When the destination Y* when the
target value matches is other than the
normal output setting, an operation error
occurs.

F166(HC1S)
F167(HC1R)

No system register
setting

No system register
setting

When the destination Y* when the
target value matches is other than the
normal output setting, an operation error
occurs.

■ Allocation of memory areas

Conventional model FPsigma series and FP0H series (FPsigma mode)

Channel no. Input Reset input Elapsed value Target value Control flag

CH0 X0 X2
DT90044
DT90045

DT90046
DT90047

R903A

CH1 X1 X2
DT90048
DT90049

DT90050
DT90051

R903B

CH2 X3 X5
DT90200
DT90201

DT90202
DT90203

R903C

CH3 X4 X5
DT90204
DT90205

DT90206
DT90207

R903D

FP0H series (FP0H mode)

Channel no. Input Reset input Elapsed value Target value Control flag

CH0 X0 X2
DT90300
DT90301

DT90302
DT90303

R9110

CH1 X1 X2
DT90304
DT90305

DT90306
DT90307

R9111

CH2 X3 X5
DT90308
DT90309

DT90310
DT90311

R9112

CH3 X4 X5
DT90312
DT90313

DT90314
DT90315

R9113

11.4 Differences in Positioning Instructions with FPsigma
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11.4.3 Pulse/PWM Output Control Instructions

For the FPsigma mode, the following contents are common to FPsigma. However, the
designation of PWM control codes is different.
- Operations when instructions are executed
- Allocation of memory areas

■ Operations when instructions are executed

Item
Conventional model
FPsigma series

FP0H series
Instruction

FPsigma Mode FP0H mode

Channel
specification

CH0/CH2 CH0/CH2 CH0 to CH3 F171(SPDH)
F172(PLSH)
F174(SP0H)
F173(PWMH)

CH0 CH0 CH0/CH2 F175(SPSH)

System register no.
402 "Pulse/PWM
output settings"

No setting No setting When the specified
channel is other than
"Pulse output (Y*, Y*)",
an operation error
occurs.

F171(SPDH)
F172(PLSH)
F174(SP0H)
F175(SPSH)

No setting No setting When the specified
channel is "Normal
output (Y*)", an
operation error occurs.

F173(PWMH)

PLC system
register nos. 400
and 401
"HSC operation
mode settings"

When the specified
channel is other than
"Not Set X* as High
Speed Counter", pulse
output is not
performed.

When the specified
channel is other than
"Not Set X* as High
Speed Counter", pulse
output is not
performed.

Not check F171(SPDH)
F172(PLSH)
F174(SP0H)
F175(SPSH)

Specification of
acceleration/
deceleration time
by initial speed
correction

No setting The initial speed is set
in the initial speed
area (special DT).

The initial speed is set
in the initial speed
area (special DT).

F171(SPDH)

Specification of
calculation only
(internal table
creation only)

Not available Available by the
specification of control
code

Available by the
specification of control
code

F171(SPDH)

Quick start Not available
Calculation (internal
table creation) is
performed every time.

Available
When the setting is the
same as the previous
setting, calculation
(internal table
creation) is not
performed.

Available
When the setting is the
same as the previous
setting, calculation
(internal table
creation) is not
performed.

F171(SPDH)

11.4 Differences in Positioning Instructions with FPsigma
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■ Allocation of memory areas

Conventional model FPsigma series and FP0H series (FPsigma mode)

Channel no.
CW

or pulse
output

CCW
or sign
output

Deviation
counter

clear
output

Home
input

Elapsed
value
area

Target
value
area

Control
flag

Correctio
n speed
area of
initial
speed

CH0 Y0 Y1 Y2 X2
DT90044
DT90045

DT90046
DT90047

R903A
DT90400
DT90401

CH2 Y3 Y4 Y5 X5
DT90200
DT90201

DT90202
DT90203

R903C
DT90404
DT90405

FP0H series (FP0H mode)

Channel no.
CW

or pulse
output

CCW
or sign
output

Deviation
counter

clear
output

Home
input

Elapsed
value
area

Target
value
area

Control
flag

Correctio
n speed
area of
initial
speed

CH0 Y0 Y1 Y2 X2
DT90348
DT90349

DT90350
DT90351

R911C
DT90400
DT90401

CH1 Y3 Y4 Y5 X5
DT90352
DT90353

DT90354
DT90355

R911D
DT90402
DT90403

CH2 Y8 Y9 YA X6
DT90356
DT90357

DT90358
DT90359

R911E
DT90404
DT90405

CH3 YB YC YD X7
DT90360
DT90361

DT90362
DT90363

R911F
DT90406
DT90407

■ Operation of PWM output instruction (F173 PWMH)

Item
Conventional mode
FPsigma series

FP0H series
(FP0H mode/FPsigma mode)

Frequency 1.5 Hz to 41.7 kHz 1 Hz to 100 kHz

Duty ratio 0 to 99.9% 0 to 100%

Frequency setting Specify by integers.

Not available Specify the output frequency in 2-word 32-
bit data.
Setting range: K1 to K100000
(1 Hz to 100 kHz: in 1 Hz increments)

Specify by control codes.

It can be set to any of 25 levels in the table
below by control codes.

It can be set to any of 31 levels in the table
below by control codes.

Setting Frequency
(Hz) Resolution Setting Frequency

(Hz) Resolution

K0 1.5 1000 K0 1.5 1000

K1 2.0 1000 K1 2.0 1000

11.4 Differences in Positioning Instructions with FPsigma
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Item
Conventional mode
FPsigma series

FP0H series
(FP0H mode/FPsigma mode)

K2 4.1 1000 K2 4.0 1000

K3 6.1 1000 K3 6.0 1000

K4 8.1 1000 K4 8.0 1000

K5 9.8 1000 K5 10.0 1000

K6 19.5 1000 K6 20.0 1000

K7 48.8 1000 K7 50.0 1000

K8 97.7 1000 K8 100.0 1000

K9 201.6 1000 K9 200.0 1000

K10 403.2 1000 K10 400.0 1000

K11 500.0 1000 K11 500.0 1000

K12 694.4 1000 K12 700.0 1000

K13 1.0k 1000 K13 1.0k 1000

K14 1.3k 1000 K14 1.3k 1000

K15 1.6k 1000 K15 1.6k 1000

K16 2.1k 1000 K16 2.0k 1000

K17 3.1k 1000 K17 3.0k 1000

K18 6.3k 1000 K18 6.0k 1000

K19 12.5k 1000 K19 12.5k 1000

K20 15.6k 100 K20 15.0k 1000

K21 20.8k 100 K21 20.0k 1000

K22 25.0k 100 K22 25.0k 1000

K23 31.3k 100 K23 30.0k 1000

K24 41.7k 100 K24 40.0k 1000

- K25 50.0k 1000

- K26 60.0k 1000

- K27 70.0k 1000

- K28 80.0k 100

- K29 90.0k 100

- K30 100.0k 100
 

(Note 1) For details of the operation of PWM output instructions, refer to "9.1.3 [F173 PWMH] PWM Output
Instruction (Frequency Specification)" and "9.1.4 [F173 PWMH] PWM Output Instruction (Control Code
Specification)".
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12.1 Specifications

12.1.1 General Specifications

For details of the general specifications, refer to FP0H User’s Manual (Basic).

12.1.2 Performance Specifications

■ High-speed counter/Pulse output/PWM output specifications

Item
Specifications

FP0H mode FPsigma mode

High-speed
counter

Single-
phase

Max. 4 channels (CH0 to CH3)
Max. 100 kHz x 4

Max. 4 channels (CH0 to CH3)
Max. 100 kHz x 4

2-phase
Max. 2 channels (CH0, CH2)
Max. 50 kHz x 2

Max. 2 channels (CH0, CH2)
Max. 50 kHz x 2

Pulse output

Single-
phase

Max. 4 channels (CH0 to 3)
Max. 100 kHz

Max. 2 channels (CH0, CH2)
Max. 100 kHz

Interpolat
ion

Max. 2 channels (CH0, CH2)
Max. 100 kHz (Composite speed)

Max. 1 channel (CH0)
Max. 100 kHz (Composite speed)

PWM output
Max. 4 points (CH0 to CH3) Max. 2 points (CH0, CH2)

Output frequency: Max. 100 kHz
Duty ratio (0 to 100%, Resolution of 1000 or 100)

 

(Note 1) For details of combinations, refer to "1.2 Restrictions on Combinations and Functions".
 

■ Pulse output function specifications

Item
Specifications

Table setting mode FPsigma compatible instruction
mode

Compatible mode FP0H mode FP0H mode FPsigma mode

Number of axes controlled Max. 4 axes Max. 4 axes Max. 2 axes

C
om

m
on

 s
pe

ci
fic

at
io

ns

Position setting mode Increment, Absolute

Output interface Transistor open collector output

Pulse output method Pulse ＋ Sign, CW+CCW

Max. output frequency 100,000Hz

Output pulse duty ratio 25% (Fixed) 25% / 50% (Select by instruction)

Control unit Pulse

Position setting range
-1,073,741,824 to 1,073,741,823 pulses
For the interpolation control, -8,388,608 to +8,388,607 pulses

Speed reference range Pulse: 1 to 100,000 pulse/s

12.1 Specifications
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Item
Specifications

Table setting mode FPsigma compatible instruction
mode

Acceleration/deceleration
method Linear acceleration/deceleration

Acceleration time/
Deceleration time

0 to 10,000 ms (Settable by 1 ms.
Acceleration time and deceleration
time can be set separately.)

30 to 32760 ms (Specify by
instruction. Acceleration time and
deceleration time cannot be set
separately.)

Po
si

tio
n 

co
nt

ro
l

No. of positioning tables 20 tables for each axis Arbitrary (Set by user program)

Control
method

Single axis

PTP control (E-point control, C-point
control), CP control (P-point control),
JOG positioning control
(J-point control)
(Note 1)

PTP control (E-point control: F171
instruction), Multistep acceleration/
deceleration control (F174
instruction)

2-axis linear
interpolation

E-, P-, C-point control; composite
speed or major axis speed
specification

E-point control, composite speed
specification (175 instruction)

Dwell time 0 to 32,767 ms (Settable by 1 ms) No setting

JOG operation Acceleration/deceleration can be
specified.

Acceleration/deceleration cannot be
specified. (F172 instruction)

Home return Return method DOG methods (3 types), Home
position method, Data set method

DOG method x 1, Home return
method x 1 (Select by F171
instruction)

St
op

 fu
nc

tio
n

Deceleration stop Each axis stops in the deceleration
time of a running operation.

Each axis stops in the deceleration
time of a running operation.
(Execute by F0 instruction)

Emergency stop
Each axis stops in the deceleration
time specified in the positioning
parameter.

Limit stop Each axis stops in the deceleration
time specified for the limit input.

System stop All axes stop.

Memory backup

Positioning parameters and
positioning table data are stored in
F-ROM
(without battery).

Data is stored in arbitrary data
registers by user programs.

 

(Note 1) When performing the J-point control or JOG operation, the speed can be changed after the startup.
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12.2 Allocation of Memory Areas

12.2.1 When Using Pulse Output Table Setting Mode

■ Control unit

Channel no.

Input/output contact number used Memory area
used

CW or
Pulse
output

CCW
or Sign
output

Deviati
on

counte
r clear
output

Home
input

(Note 1)

Near
home
input

(Note 2)

Over
limit
input

(Note 3)

J-point
position
ing start

input

Busy
flag

Elapse
d value

area

Indepen
dent

CH0 Y0 Y1 Y2 X2 (Y850)
(Y860)
(Y861)

X0 (Y808)

(Note 4)

CH1 Y3 Y4 Y5 X5 (Y851)
(Y862)
(Y863)

X1 (Y809)

CH2 Y8 Y9 YA X6 (Y852)
(Y864)
(Y865)

X3 (Y80A)

CH3 YB YC YD X7 (Y853)
(Y866)
(Y867)

X4 (Y80B)

Linear
interpol
ation

(Note 1)

CH0

X-
axis Y0 Y1 Y2 X2 (Y850)

(Y860)
(Y861)

－

(Y808)

(Note 4)

Y-
axis Y3 Y4 Y5 X5 (Y851)

(Y862)
(Y863)

(Y809)

CH2

X-
axis Y8 Y9 YA X6 (Y852)

(Y864)
(Y865)

(Y80A)

Y-
axis YB YC YD X7 (Y853)

(Y866)
(Y867)

(Y80B)

 

(Note 1) Even when setting the linear interpolation, the interpolation operation is not performed for the home
return. Execute the operation for X axes and Y axes separately.

(Note 2) The near home input will be valid when arbitrary inputs are allocated and the output relays indicated in
the above table turn ON.

(Note 3) The over limit input (+) and over limit input (-) will be valid when arbitrary inputs are allocated and the
output relays indicated in the above table turn ON. The I/O numbers in the upper rows (Y860 to Y866)
in the above table are over limit input (+), the I/O numbers in the lower rows (Y861 to Y867) are over
limit input (-).

(Note 4) The elapsed values are stored in the axis information area of the positioning memory. They can be
read by user programs using the F384 instruction.

 

12.2 Allocation of Memory Areas
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12.2.2 When Using Pulse Output Function (FPsigma Compatible Instruction
Mode)

■ Related instructions
F0 (MV), F1 (DMV), F171 (SPDH), F172 (PLSH), F174 (SP0H), F175 (SPSH)

■ Control unit

FP0H mode

Channel no.

Input/output contact number used Memory area used Max.
outpu

t
frequ
ency
(Note

4)

CW or
Pulse
outpu

t

CCW
or

Sign
outpu

t

Devia
tion

count
er

clear
outpu

t

Hom
e

inpu
t

(Note
1)

Near
home
input

(Note 2)

Contr
ol flag

Elapsed
value
area

(Note 3)

Target
value
area

Correcti
on

speed
area of
initial
speed

In
de

pe
nd

en
t

CH0 Y0 Y1 Y2 X2

DT
90052
bit 4

R911
C

DT9034
8

DT9034
9

DT9035
0

DT9035
1

DT9040
0

DT9040
1

100kH
z

CH1 Y3 Y4 Y5 X5 R911
D

DT9035
2

DT9035
3

DT9035
4

DT9035
5

DT9040
2

DT9040
3

100kH
z

CH2 Y8 Y9 YA X6 R911
E

DT9035
6

DT9035
7

DT9035
8

DT9035
9

DT9040
4

DT9040
5

100kH
z

CH3 YB YC YD X7 R911F

DT9036
0

DT9036
1

DT9036
2

DT9036
3

DT9040
6

DT9040
7

100kH
z

Li
ne

ar
 in

te
rp

ol
at

io
n

CH0

X-
axis Y0 Y1 Y2 X2

-

R911
C

DT9034
8

DT9034
9

DT9035
0

DT9035
1

DT9040
0

DT9040
1

Comp
osite

speed
100kH

z

Y-
axis Y3 Y4 Y5 X5 R911

D

DT9035
2

DT9035
3

DT9035
4

DT9035
5

DT9040
2

DT9040
3

CH2

X-
axis Y8 Y9 YA X6 R911

E

DT9035
6

DT9035
7

DT9035
8

DT9035
9

DT9040
4

DT9040
5

Y-
axis YB YC YD X7 R911F

DT9036
0

DT9036
1

DT9036
2

DT9036
3

DT9040
6

DT9040
7

12.2 Allocation of Memory Areas
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FPsigma mode

Channel no.

Input/output contact number used Memory area used Max.
outpu

t
frequ
ency
(Note

4)

CW or
Pulse
outpu

t

CCW
or

Sign
outpu

t

Devia
tion

count
er

clear
outpu

t

Hom
e

inpu
t

(Note
1)

Near
home
input

(Note 2)

Contr
ol flag

Elapsed
value
area

(Note 3)

Target
value
area

Correcti
on

speed
area of
initial
speed

In
de

pe
nd

en
t CH0 Y0 Y1 Y2 X2

DT
90052

bit4

R903
A

DT9004
4

DT9004
5

DT9004
6

DT9004
7

DT9040
0

DT9040
1

100kH
z

CH2 Y3 Y4 Y5 X5 R903
C

DT9020
0

DT9020
1

DT9020
2

DT9020
3

DT9040
4

DT9040
5

100kH
z

Li
ne

ar
 in

te
rp

ol
at

io
n

CH0

X-
axis Y0 Y1 - -

-

R903
A

DT9004
4

DT9004
5

DT9004
6

DT9004
7

DT9040
0

DT9040
1

Comp
osite

speed
100kH

zY-
axis Y3 Y4 - - R903

C

DT9020
0

DT9020
1

DT9020
2

DT9020
3

DT9040
4

DT9040
5

 

(Note 1) Even when setting the linear interpolation, the interpolation operation is not performed for the home
return. Execute the operation for X axes and Y axes separately.

(Note 2) The near home input will be valid when an arbitrary input is allocated and the bit 4 of the special data
register DT90052 turns on.

(Note 3) Only F1 (DMV) instruction can perform the reading and writing of elapsed value area.
(Note 4) These values are available only when the conditions of each item (such as output method or No. of

channels) are executed.
These values are not available if executing the HSC match ON/OFF instruction, other pulse I/O
process simultaneously or executing the interrupt program.

 

12.2.3 When Using PWM Output Function

■ Related instructions
F171 (PWMH)

■ Control unit

FP0H mode

Channel no. Output no. Control flag Output frequency (Duty)

CH0 Y0 R911C
1.0 Hz to 70 kHz: Resolution of 1000 (0.0% to 100.0%)
70001 Hz to 100 kHz: Resolution of 100 (0% to 100%)

CH1 Y3 R911D

CH2 Y8 R911E

12.2 Allocation of Memory Areas
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Channel no. Output no. Control flag Output frequency (Duty)

CH3 YB R911F

FPsigma mode

Channel no. Output no. Control flag Output frequency (Duty)

CH0 Y0 R903A 1.0 Hz to 70 kHz: Resolution of 1000 (0.0% to 100.0%)
70001 Hz to 100 kHz: Resolution of 100 (0% to 100%)CH2 Y3 R903C

■ Maximum output frequency of pulse output/PWM output
These values are available only when the conditions of each item (such as output method or
channels) are executed. These values are available when the operations such as the high-
speed counter, pulse output function or other interrupt controls are not performed.

12.2.4 When Using High-speed Counter Function

■ Related instructions
F0 (MV), F1 (DMV), F165 (CAM0), F166 (HC1S), F167 (HC1R)

■ Memory allocation

FP0H mode

Channel no.
Count
input

Hardware
reset
input

Memory area used Performance
Specifications

Control
flag

Elapsed
value
area

Target
value
area

Min. input
pulse width

Max.
counting

speed

[Single-phase]
Addition input
Subtraction
input

CH0 X0 X2 R9110
DT90300
DT90301

DT90302
DT90303

High-speed
input
5 μs

100kHz
CH1 X1 X2 R9111

DT90304
DT90305

DT90306
DT90307

CH2 X3 X5 R9112
DT90308
DT90309

DT90310
DT90311

CH3 X4 X5 R9113
DT90312
DT90313

DT90314
DT90315

[2-phase
input]
Phase
difference
input
Individual
input
Direction
distinction

CH0
X0
X1

X2 R9110
DT90300
DT90301

DT90302
DT90303

High-speed
input
10 μs

50 kHz
CH2

X3
X4

X5 R9112
DT90308
DT90309

DT90310
DT90311

12.2 Allocation of Memory Areas
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FPsigma mode

Channel no.
Count
input

Hardware
reset
input

Memory area used Performance
Specifications

Control
flag

Elapsed
value
area

Target
value
area

Min. input
pulse width

Max.
counting

speed

[Single-phase]
Addition input
Subtraction
input

CH0 X0 X2 R903A
DT90044
DT90045

DT90046
DT90047

High-speed
input
5 μs

100kHz
CH1 X1 X2 R903B

DT90048
DT90049

DT90050
DT90051

CH2 X3 X5 R903C
DT90200
DT90201

DT90202
DT90203

CH3 X4 X5 R903D
DT90204
DT90205

DT90206
DT90207

[2-phase
input]
Phase
difference
input
Individual
input
Direction
distinction

CH0
X0
X1

X2 R903A
DT90044
DT90045

DT90046
DT90047

High-speed
input
10 μs

50 kHz
CH2

X3
X4

X5 R903C
DT90200
DT90201

DT90202
DT90203

 

(Note 1) When the reset input settings of reset input for the single-phase input overlap at CH0 and CH1 or CH2
and CH3, the setting of CH0 or CH2 has priority.

(Note 2) Only F1 (DMV) instruction can perform the reading and writing of elapsed value area.
 

■ Maximum counting speed
These values are available only when the conditions of each item (such as counting method or
channels) are executed. These values are available when the high-speed counter match ON
(F166) instruction, high-speed counter match OFF (F167) instruction, pulse output function or
other interrupt controls are not performed.

12.2 Allocation of Memory Areas
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12.3 Positioning Memory

12.3.1 Configuration of Memory Map

The positioning memory consists of four areas.

■ Whole memory map

Area Absolute
(Decimal)

No. of words and configuration
No. Name

0
Common
area

0000-0029 30 words

1

Axis
informatio
n
area

0030-0039 For CH0

10 words for each channel
0040-0049 For CH1

0050-0059 For CH2

0060-0069 For CH3

0070-0099 Reserved for system

2
Axis
setting
area

0100-0129 For CH0

30 words for each channel
0130-0159 For CH1

0160-0189 For CH2

0190-0219 For CH3

0220-0299 Reserved for system

3

Positionin
g
Table
area

0300-0549

For CH0 250 words for each channel

0300-0309 Table 1

10 words for each table｜ ｜

0490-0499 Table 20

0500-0549 Reserved area for the system

0550-0799 For CH1

250 words for each channel
0800-1049 For CH2

1050-1299 For CH3

1300-1799 Reserved for
system

 

(Note 1) The addresses in the table are the addresses which indicate the configurations in the positioning
memory. For reading/writing data using user programs, use an area number and offset address in
combination for specification.

 

■ Reading from positioning memory
● It is possible to read the areas which are shown with "Available" in the "R" column in the

following table using the F384 (PTBLR) instruction in user programs during RUN. The
operand of the instruction is specified using the combination of an area number and offset
address.

12.3 Positioning Memory
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■ Writing to positioning memory
● When the mode changes from PROG. to RUN, the contents set by the tool software

Configurator PMX will be stored.
● It is possible to rewrite the areas which are shown with "Available" in the "W" column in the

following table using the F385 (PTBLW) instruction in user programs during RUN. The
operand of the instruction is specified using the combination of an area number and offset
address.

● Be sure not to execute writing in the reserved areas for the system.

12.3.2 Common area (Memory Area No. 0)

●: Available, -: Not available

Address Name Defaul
t Description R W

0000 Axis setting H0

Stores used channels (axes) and usage methods.
Monitor using binary display.

bit no. Settings

0 Not use CH0 (0) / Use CH0 (1)

1 Not use CH1 (0) / Use CH1 (1)

2 Not use CH2 (0) / Use CH2 (1)

3 Not use CH3 (0) / Use CH3 (1)

4-7 Disable the setting

8
As interpolation axis,
Not use CH0/CH1 (0) / Use CH0/CH1
(1)

9
As interpolation axis,
Not use CH2/CH3 (0) / Use CH2/CH3

10-11 Disable the setting

12(Note

1)

Use the interpolation control of CH0
and CH1 based on the axis setting of
CH0:
Use (0) / Not use (1)

13(Note

1)

Use the interpolation control of CH2
and CH3 based on the axis setting of
CH2:
Use (0) / Not use (1)

14-15 Disable the setting

● ●

0001
Positioning repeat
count
(CH0)

K0
Stores the repeat count in decimal when using the
repeat control in the position control.

Set value Operation

0 or 1 Not repeat an operation.

2-254 Repeat an operation for a
specified number of times.

● ●

0002
Positioning repeat
count
(CH1)

K0 ● ●

12.3 Positioning Memory
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Address Name Defaul
t Description R W

0003
Set value Operation

255 or more Repeat an operation infinitely.

Positioning repeat
count
(CH2)

K0 ● ●

0004
Positioning repeat
count
(CH3)

K0 ● ●

0005
-0006

Reserved for system - - - -

0007 Error code H0

Stores a generated positioning error code in Hex
format (hexadecimal) when using the pulse output
function (table setting mode).
The higher 8 bits indicate channel number.
The lower 8 bits indicate error code.

● -

0008
-0029

Reserved for system - - - -

 

(Note 1) The bit nos. 12 and 13 can be with the unit firmware Ver. 1.7 or later.
If "Use (0)" is selected, the Y axis (CH1 / CH3) uses the axis settings set for the X axis (CH0 / CH2).
The target axis settings are the following parameters under Axis Setting Area (Memory Area No. 2).
Pulse output method, Pulse output rotation direction, Limit (+) switch logic, Limit (-) switch logic,
Startup speed, Emergency stop deceleration time, and Limit stop deceleration time

 

12.3.3 Axis Information Area (Memory Area No. 1)

●: Available, -: Not available

Offset
address Name Default Description R W

0000 Active or execution
done table K0

Stores the monitor values of the positioning
table numbers during the execution or on the
completion of each channel.
Stored value: 0-20

● -

0001 Repeat count current
value K0

Stores the repeat count during the operation of
each channel. The execution start time is
counted as “1”. When the repeat count exceeds
the upper limit, it returns to “0”. When the repeat
operation is not enabled, “0” is stored at the
positioning control start time.
Stored value: 0-65535

● -

0002
-0003

Elapsed value (Current
value coordinate) K0

Stores the elapsed values (current value
coordinate) of each channel.
Range: -1,073,741,824 to 1,073,741,823
For the interpolation control, the setting range is
as follows.
-8,388,608 to +8,388,607

● ●

0004
-0009

Reserved for system - - - -

12.3 Positioning Memory
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12.3.4 Axis Setting Area (Memory Area No. 2)

●: Available, -: Not available

Offset
address Name Default Description R W

0000
Pulse output
control code

H0

Stores the settings of pulse output, home position, near
home position, and limit signal of each channel. Monitor in
binary format.

bitno. Item Settings

0 Pulse output
method

0：Pulse/Sign
1：CW/CCW

1 Pulse output
rotation direction

0: Elapsed value + Direction
is CW
(Forward OFF/Reverse ON)
1: Elapsed value + Direction
is CCW
(Forward ON/Reverse OFF)

2 Home position
logic

0: Normal Open (A contact)
1: Normal Close (B contact)

3 Home position
proximity logic

4 Limit (+) switch
logic

5 Limit (-) switch
logic

6-15 Disable the
setting

● ●

0001
-0002

Startup
speed K100

Stores the settings of the startup speed for each operation
of each channel in decimal.
Setting range: 1 to 100,000

● ●

0003 Home return
method HFF

Stores the settings of home return patterns of each channel.
H0: DOG method 1
H1: DOG method 2
H2: DOG method 3
H3: Setting error
H4: Setting error
H5: Home position method (Z phase method)
H6: Data set method
HFF: Not use

● ●

0004 Home return
direction K0

Stores the settings of home return operation direction in
decimal.
0: Elapsed value decreasing direction (Limit - direction)
1: Elapsed value increasing direction (Limit + direction)

● ●

0005
Home return
acceleration
time

K100

Stores the settings of the acceleration time for the home
return of each channel in decimal. It indicates the time from
the startup speed to the home return target speed.
Setting range: 1-10,000 (ms)

● ●

12.3 Positioning Memory

12-12 WUME-FP0HPOS-04



Offset
address Name Default Description R W

0006
Home return
deceleration
time

K100

Stores the settings of the deceleration time for the home
return of each channel in decimal. It indicates the time from
the home return target speed to the startup speed.
Setting range: 1-10,000 (ms)

● ●

0007
-0008

Home return
target speed

K1000
Stores the settings of the target speed for the home return
of each channel in decimal.
Setting range: 1 to 100,000

● ●

0009
-0010

Home return
creep speed

K100
Stores the settings of the creep speed for the home return
of each channel in decimal.
Setting range: 1 to 100,000

● ●

0011
Deviation
counter
clear time

K1

Stores the settings of the deviation counter clear signal ON
time after the completion of home return of each channel in
decimal.
Setting range: 1 to 100 (ms)
In the case of 0, no deviation counter clear signal is output.
In the case of 100 or more, the ON time is set to 100 ms.

● ●

0012
-0013

Coordinate
origin K0

Stores the elapsed values (current value) after the home
return.
Range: -1,073,741,824 to 1,073,741,823
For the interpolation control, the setting range is as follows.
-8,388,608 to +8,388,607

● ●

0014
JOG
acceleration
time

K0

Stores the settings of the acceleration time for the JOG
operation of each channel in decimal. It indicates the
acceleration time from startup speed to JOG operation
target speed.
Setting range: 0 to 10,000 (ms)

● ●

0015
JOG
deceleration
time

K0

Stores the settings of the deceleration time for the JOG
operation of each channel in decimal. It indicates the
deceleration time from JOG operation target speed to
startup speed.
Setting range: 0 to 10,000 (ms)

● ●

0016
-0017

JOG
target speed

K1000
Stores the settings of the target speed for the JOG
operation of each channel in decimal.
Setting range: 1 to 100,000

● ●

0018
-0019

J point
change
target speed

K1000
Stores the settings of the target speed for changing the J-
point control speed for each channel in decimal.
Setting range: 1 to 100,000

● ●

0020

Emergency
stop
deceleration
time

K100

Stores the settings of the deceleration time for the
emergency stop operation of each channel in decimal. It
indicates the deceleration time from 100 kHz to 0 Hz.
Setting range: 0 to 10,000 (ms)

● ●

0021
Limit stop
deceleration
time

K100

Stores the settings of the deceleration time for the limit stop
operation of each channel in decimal. It indicates the
deceleration time from 100 kHz to 0 Hz.
Setting range: 0 to 10,000 (ms)

● ●

0022
-0029

Reserved
for system - - - -

12.3 Positioning Memory
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(Note 1) The emergency stop deceleration time and limit stop deceleration time indicates the deceleration time
in the section from 100 kHz to 0 Hz. When the speed during the operation is less than 100 kHz, the
actual deceleration time is shorter than the set time.

 

12.3.5 Positioning Table Area (Memory Area No. 3)

●: Available, -: Not available

Offset
address Name Default Description R W

0000 Control code H0

Stores the settings of the position specification method for
the positioning operation.

bit no. Item Settings

0 Control
method

0：Increment mode
1：Absolute mode

1-15 Disable the
setting

● ●

0001 Control
pattern H0

Stores the settings of single axis and interpolation operation
pattern of positioning operation. In the interpolation
operation, the setting for the axis with the smallest number
in an axis group is effective.

bit no.15 0
0 0 0 0 0 0 0

8 7

Channel specification
H00: Linear interpolation

(composite speed)
H01: Linear interpolation

(major axis speed)
Control pattern
H00: E-point control (End point control)
H01: P-point control (Pass point control)
H02: C-point control (Continuance point control)
H03: J-point control (Speed point control)

● ●

0002
Positioning
acceleration
time

K100

Stores the settings of the acceleration time for the
positioning operation. It indicates the acceleration time from
the startup speed to the target speed.
Setting range: 1 to 10,000 (ms)

● ●

0003
Positioning
deceleration
time

K100

Stores the settings of the deceleration time for the
positioning operation. It indicates the deceleration time from
the target speed to the startup speed.
Setting range: 1 to 10,000 (ms)

● ●

0004
-0005

Positioning
target speed

K1000

Stores the settings of the target speed for the positioning
operation. In the interpolation operation, the setting for the
axis with the smallest number in an axis group is effective.
Setting range: 1 to 100,000

● ●

0006
-0007

Positioning
movement
amount

K0

Stores the settings of the movement amount for the
positioning operation.
Setting range: -1,073,741,824 to 1,073,741,823
For the interpolation control, the setting range is as follows.

● ●

12.3 Positioning Memory
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Offset
address Name Default Description R W

-8,388,608 to +8,388,607

0008
Dwell
time

K0
Stores the setting of dwell time.
Setting range: 0 to 32,767ms

● ●

0009 Reserved for
system - - - -

 

(Note 1) The offset addresses in the above table are for the table no. 0. They vary according to the table
numbers as described on the next page.

 

■ Offset addresses

Table no.
Control

code
Control
pattern

Positioning
acceleration

time

Positioning
deceleration

time
Positioning
target speed

Positioning
movement

amount

Dwell
time

1 0 1 2 3 4-5 6-7 8

2 10 11 12 13 14-15 16-17 18

3 20 21 22 23 24-25 26-27 28

4 30 31 32 33 34-35 36-37 38

5 40 41 42 43 44-45 46-47 48

6 50 51 52 53 54-55 56-57 58

7 60 61 62 63 64-65 66-67 68

8 70 71 72 73 74-75 76-77 78

9 80 81 82 83 84-85 86-87 88

10 90 91 92 93 94-95 96-97 98

11 100 101 102 103 104-105 106-107 108

12 110 111 112 113 114-115 116-117 118

13 120 121 122 123 124-125 126-127 128

14 130 131 132 133 134-135 136-137 138

15 140 141 142 143 144-145 146-147 148

16 150 151 152 153 154-155 156-157 158

17 160 161 162 163 164-165 166-167 168

18 170 171 172 173 174-175 176-177 178

19 180 181 182 183 184-185 186-187 188

20 190 191 192 193 194-195 196-197 198
 

(Note 1) For the positioning target speed and positioning movement amount, specify the lower address number
of 2-word area.
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Record of changes

Manual numbers can be found at the bottom of the manual cover.

Date Manual No. Record of Changes

Oct. 2017 WUME-FP0HPOS-01 1st Edition

Feb. 2018 WUME-FP0HPOS-02

2nd Edition
Version upgrade of the unit firmware (Ver.1.1)
Added the descriptions of supported functions.
● FPsigma mode
Added the specifications of FPsigma compatible
instruction.
● F171(SPDH) / F171(SPDH) / F172(PLSH) /

F174(SP0H)
Error correction

Mar. 2020 WUME-FP0HPOS-03
3rd Edition
Changed manual format
Error correction

Feb. 2021 WUME-FP0HPOS-04

4th Edition
Version upgrade of the unit firmware (Ver. 1.7)
● Added optional settings to the positioning memory

(Memory Area No. 0 "Axis setting").
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Order Placement Recommendations and Considerations 
The Products and Specifications listed in this document are subject to change (including  

specifications, manufacturing facility and discontinuing the Products) as occasioned by the 
improvements of Products. Consequently, when you place orders for these Products, Panasonic 
Industrial Devices SUNX asks you to contact one of our customer service representatives and 
check that the details listed in the document are commensurate with the most up-to-date  
information. 

[Safety precautions] 
Panasonic Industrial Devices SUNX is consistently striving to improve quality and reliability. 

However, the fact remains that electrical components and devices generally cause failures  
at a given statistical probability. Furthermore, their durability varies with use environments  
or use conditions. In this respect, check for actual electrical components and devices under  
actual conditions before use. Continued usage in a state of degraded condition may cause the  
deteriorated insulation. Thus, it may result in abnormal heat, smoke or fire. Carry out safety  
design and periodic maintenance including redundancy design, design for fire spread prevention, 
and design for malfunction prevention so that no accidents resulting in injury or death, fire  
accidents, or social damage will be caused as a result of failure of the Products or ending  
life of the Products. 

The Products are designed and manufactured for the industrial indoor environment use. Make
sure standards, laws and regulations in case the Products are incorporated to machinery, system,
apparatus, and so forth. With regard to the mentioned above, confirm the conformity of the
Products by yourself.

Do not use the Products for the application which breakdown or malfunction of Products may 
cause damage to the body or property.
i) usage intended to protect the body and ensure security of life
ii)application which the performance degradation or quality problems, such as breakdown,
of the Products may directly result in damage to the body or property
It is not allowed the use of Products by incorporating into machinery and systems indicated

below because the conformity, performance, and quality of Products are not guaranteed under
such usage.
i) transport machinery (cars, trains, boats and ships, etc.)
ii) control equipment for transportation
iii) disaster-prevention equipment / security equipment
iv) control equipment for electric power generation
v) nuclear control system
vi) aircraft equipment, aerospace equipment, and submarine repeater
vii) burning appliances
viii) military devices
ix) medical devices except for general controls
x) machinery and systems which especially require the high level of reliability and safety

[Acceptance inspection] 
 In connection with the Products you have purchased from us or with the Products delivered  
to your premises, please perform an acceptance inspection with all due speed and, in connection 
with the handling of our Products both before and during the acceptance inspection, please  
give full consideration to the control and preservation of our Products. 

[Warranty period] 
 Unless otherwise stipulated by both parties, the warranty period of our Products is 3 years
after the purchase by you or after their delivery to the location specified by you. 
The consumable items such as battery, relay, filter and other supplemental materials are excluded 
from the warranty. 

[Scope of warranty] 
 In the event that Panasonic Industrial Devices SUNX confirms any failures or defects of  
the Products by reasons solely attributable to Panasonic Industrial Devices SUNX during the  
warranty period, Panasonic Industrial Devices SUNX shall supply the replacements of the Products, 
parts or replace and/or repair the defective portion by free of charge at the location where  
the Products were purchased or delivered to your premises as soon as possible. 
 However, the following failures and defects are not covered by warranty and we are not responsible 
for such failures and defects.  
(1) When the failure or defect was caused by a specification, standard, handling method,

etc. which was specified by you. 
(2) When the failure or defect was caused after purchase or delivery to your premises by

an alteration in construction, performance, specification, etc. which did not involve
us.

(3) When the failure or defect was caused by a phenomenon that could not be predicted by
the technology at purchasing or contracted time.

(4) When the use of our Products deviated from the scope of the conditions and environment
set forth in the instruction manual and specifications.

(5) When, after our Products were incorporated into your products or equipment for use, damage
resulted which could have been avoided if your products or equipment had been equipped
with the functions, construction, etc. the provision of which is accepted practice in
the industry.

(6) When the failure or defect was caused by a natural disaster or other force majeure.
(7) When the equipment is damaged due to corrosion caused by corrosive gases etc. in the

surroundings.

The above terms and conditions shall not cover any induced damages by the failure or defects 
of the Products, and not cover your production items which are produced or fabricated by using
the Products. In any case, our responsibility for compensation is limited to the amount paid 
for the Products. 

[Scope of service] 
The cost of delivered Products does not include the cost of dispatching an engineer, etc. 
In case any such service is needed, contact our sales representative. 
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